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1.2

1.2.1

Introduction

Introduction

Scope of Manual

This User Manual includes the following information about Beam-
View.NET, beam diagnostic software from Coherent, Inc.:

° Introduction

° Install the Software

. Set Up Hardware

° Software Interface

d Capture a Beam Image
. Analyze Calculations

. Troubleshooting

Signal Words and Symbols in this Manual

This documentation may contain sections in which particular hazards are
defined or special attention is drawn to particular conditions. These sec-
tions are indicated with signal words in accordance with ANSI Z-535.6 and
safety symbols (pictorial hazard alerts) in accordance with ANSI Z-535.3
and ISO 7010.

Signal Words

Four signal words are used in this documentation: DANGER, WARNING,
CAUTION and NOTICE.
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The signal words DANGER, WARNING and CAUTION designate the de-
gree or level of hazard when there is the risk of injury:

Indicates a hazardous situation that, if not avoided, will result in
death or serious injury. This signal word is to be limited to the most
extreme situations.

WARNING!
Indicates a hazardous situation that, if not avoided, could result in

death or serious injury.

CAUTION!
Indicates a hazardous situation that, if not avoided, could result in

minor or moderate injury.

The signal word “NOTICE” is used when there is the risk of property dam-
age:

NOTIC

Indicates information considered important, but not hazard- related.

Messages relating to hazards that could result in both personal injury and
property damage are considered safety messages and not property dam-
age messages.

Symbols

The signal words DANGER, WARNING, and CAUTION are always em-
phasized with a safety symbol that indicates a special hazard, regardless
of the hazard level:

This symbol is intended to alert the operator to the presence of addi-
tional information.
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Introduction

This symbol is intended to alert the operator to the presence of
important operating and maintenance instructions.

This symbol is intended to alert the operator to the danger of expo-
sure to hazardous visible and invisible laser radiation.

This symbol is intended to alert the operator to the presence of
dangerous voltages within the product enclosure that may be of
sufficient magnitude to constitute a risk of electric shock.

This symbol is intended to alert the operator to the danger of
Electro-Static Discharge (ESD) susceptibility.

This symbol is intended to alert the operator to the danger of
crushing injury.

This symbol is intended to alert the operator to the danger of a lifting
hazard.

Preface

This manual contains user information for the BeamView.net.
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1.5

NOTIC

Read this manual carefully before operating the laser for the first
time. Failure to follow the instructions and safety precautions in this
manual can result in serious injury or death. Special attention must
be given to the material in 'Safety and Compliance’ (p. 217), that
describes the safety features built into the use of a laser with the
software.

Use of controls or adjustments or performance of procedures other
than those specified herein may result in hazardous radiation expo-
sure.

Export Control Laws

It is the policy of Coherent, Inc. to comply strictly with export control laws
of the United States of America (USA).

Export and re-export of lasers manufactured by Coherent are subject to
U.S. Export Administration Regulations, which are administered by the
Commerce Department. In addition, shipments of certain components are
regulated by the State Department under the International Traffic in Arms
Regulations (ITAR).

The applicable restrictions vary depending on the specific product in-
volved and its destination. In some cases, U.S. law requires that U.S.
Government approval be obtained prior to resale, export or re-export of
certain articles. When there is uncertainty about the obligations imposed
by laws in the USA, clarification must be obtained from Coherent or an ap-
propriate agency of the U.S. Government.

For products manufactured in the European Union, Singapore, Malaysia,
Thailand: These commodities, technology, or software are subject to local
export regulations and local laws. Diversion contrary to local law is prohib-
ited. The use, sale, re-export, or re-transfer directly or indirectly in any pro-
hibited activities are strictly prohibited.

The Operator’s Manual

This Operator Manual is designed to familiarize the user with the Beam-
View.net system and its designated use. It contains important information
on how to install, operate the software.
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Introduction

This Manual:

° describes the physical hazards related to use of the software with the
laser system, the means of protection against these hazards, and the
safety features incorporated in the design of the software

° briefly describes the purpose and operation as well as the primary
features, system elements, subsystems, and fundamental laser
control routines of the software

° describes the fundamental operation of the software

The screenshots in this manual are only examples and may show
configurations or parameter settings which do not apply. Changing
parameter settings to correspond with screenshots may reduce laser
performance or even damage the laser system!

Numbering of Sections, Pages and Instructions

The sections are numbered continuously. The name of the section ap-
pears in the upper outside corner of every odd page. Each section ends
with an even page number. Consequently, certain even pages at the ends
of sections will be intentionally left blank.

The pages of this manual are numbered continuously by section. The
page number appears in the bottom center of every page.

Each step within a procedure is sequentially numbered. Each procedure
starts with the step number one.
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2.2

2.3

Description of BeamView.NET

Description of BeamView.NET

What is BeamView.NET?

BeamView.NET is Coherent's software that extends the analytic capabili-
ties of the LaserCam laser beam diagnostic systems. The software has
been designed to provide flexibility, speed, and ease of use to monitor, an-
alyze, and archive laser beam images.

Products Supported

BeamView.NET supports the following cameras:
i LaserCam-HR-II-1/2-in. 12-bit

i LaserCam-HR-11-2/3-in. 14-bit

* LaserCam-HR-II-2/3-in.-UV 14-bit

d LaserCam-HR-InGaAs 14-bit

In addition, the BeamView.NET software is currently backwards compati-
ble, to directly import images (.bin, .img, or .png), configuration files (.atc),
and test files (.ats) generated by old BeamView software into the Beam-
View.NET software.

To prepare to import selected images, the command to import images
clears the current buffer in the software. Selected images replace any pre-
vious images in the buffer.

Features

The BeamView.NET software extends the analytic capabilities of the La-
serCam-HR laser beam diagnostic systems, with multiple numerical anal-
ysis functions, configurable set-ups, and features to support maximum
measurement accuracy.
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2.3.2

2.3.3

Flat-Top Beam Analysis

Six additional calculations are available with BeamView.NET software for
flat-top beam analysis. These calculations are based on the
ISO 13694:2000 standards, and allow greater flexibility for the analysis of
applications involving flat-top beam shapes. They also can assist in the
analysis of beam uniformity of excimer and Nd:YAG lasers in the near
field. The six new calculations are:

. Plateau Uniformity

° Flatness Factor

. Edge Steepness

. Beam Uniformity

* Effective Irradiation Area

° Effective Average Power/Energy Density

Adjustable Trigger Delay

The adjustable Trigger Delay feature lets users add default trigger delay to
the LaserCam cameras. This assists by providing additional flexibility
when the camera is activated from an external trigger source, such as the
SYNC Output of a laser. Adjustable trigger delay assures a valid laser
pulse is captured.

Real-Time Laser Monitoring and Alignment

The Live Video mode provides a continuously updated image of the laser
beam. This mode is ideal for monitoring the laser and observing change
sin the form and structure of the beam as it is adjusted. Live Mode allows
for real-time tuning to achieve optimum beam profile quality and laser-cav-
ity alignment. While operating in this mode, no beam or statistical data are
displayed; however, if Start mode is activated, the image is stored and can
later be analyzed.
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2.3.5

2.3.6

2.3.7

Description of BeamView.NET

Pass/Fail Analysis

Pass/Fail analysis allows simultaneous real-time monitoring of all (or any
one) of the analysis results against user-specified minimum and maximum
limits. Any combination of (or all) fault actions can be activated to signal a
test failure, initiate a visual or audio alarm, stop data capture, reject or
save a failed sample, and generate a TTL trigger pulse output signal.

Adjustable Exposure Time

The camera exposure time is adjustable through the camera settings
menu for all LaserCam-HR camera models.

Report Generation

BeamView.NET includes a single-page report that can be sent directly to a
printer, saved to a file (.txt), or converted to an Adobe .pdf file by using
a .pdf file converter. A simple screen print option is available from the
same dialog box used to generate a report.

Additional Features

BeamView.NET software offers these additional features:
° Automatic background noise subtraction

° Remote Mode interface and commands

° Both 2D and 3D intensity plots

° Remote Mode interface and new commands

° Support for multiple cameras, each with a separate background
image

d ‘Plug-and-play’ feature to automatically recognize cameras
° Set variable aspect ratios for each camera

° Increase in the number of samples that can be captured; save images
using industry-standard file formats
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d Camera information embedded into image files.Software is currently
backwards compatible, to directly import images (.bin, .img, or .png),
configuration files (.atc), and test files (.ats) generated by old Beam-
View software into the BeamView.NET.

Theory of Operation

The BeamView.NET software uses USB 2.0 cameras to image, capture,
store, and perform 2-dimensional intensity distribution analysis on beams
from almost any laser or light source.

The digitized beam images are then stored in memory. The beam images
can be captured with several different triggering methods and stored in a
variety of resolution modes.

Once in memory, a variety of analysis functions can be performed on the
stored beam images. Images are then combined with user-selected
graphics and calculated analysis results, and displayed on the computer
monitor.

A wide variety of other system functions provide the ability to print infor-
mation, control beam image capture, trigger functions for pulsed laser
capture, and control various video and calibration functions.

In Start mode, these cameras can capture video beam images at 10-bit
resolution.

A faster Live mode runs at 8 bits per pixel, but at 10 to 15 frames per sec-
ond. BeamView.NET scales the resolution to 16-bit by up-shifting; all cal-
culations using pixel intensity as an output—for example, Max, Mean, and
Min— have a maximum value of 65,535.

For cameras with a 12-bit the max value is 2*12=4096. BeamView con-
verts the 12-bit to a 16-bit making the new max intensity value
2M6=65526. The intensity is shifted up by a factor of 16. For cameras
with a 14-bit, the max value is 2"14=16384. Beamview converts the 14-bit
to a 16-bit, making the new max intensity value 2*16=65526. The intensity
is shifted up by a factor of 4.

10
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Install Software

Install Software

This section describes the process to install the BeamView.NET software.

NOTIC

Complete installation of the software before any hardware is
connected.

In this User Manual, the term ‘computer’ is used to refer to the device in
which the software is installed. That may be commonly referred to as a
PC, laptop, workstation, CPU, desktop tower, or other name.

Before Work is Started

To make both installation and operation of the BeamView.NET software
easier, first check the following before work is begun.

IT Procedures and Policies

In today’s world, it is often a challenge for organizations to find a balance
between implementing security requirements and managing the user ex-
perience.

Security processes and controls required to comply with industry-accept-
ed standards, regulations, and certifications may impose constraints on
user authentication and access. Such controls may block a software in-
stallation, making it appear as incomplete or non functional.

Should there be difficulties installing the BeamView.NET software, before
Coherent Technical Support is called, check with your IT group first to de-
termine if:

° The administrative privileges required for installation are granted.
° There are any internal security policies or controls in place that may

render installation of a new software package incomplete.

Another option is to right-click in Windows. For any executable (.exe) files,
Coherent recommends that to use this method for installation.

After those issues are resolved, then see ’Service and Support’ (p. 225)
for details about how to contact Coherent for assistance.
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3.1.2

3.2

Software System Requirement

This section describes system requirements:

Windows 10 (32- or 64-bit)

2.5 GHz processor or faster

2 GB of RAM or higher

5 GB of available hard disk space

USB 2.0 or RS-232 port

Install the Software

Go to the Coherent website and download the BeamView.NETsoftware
onto the computer.

https://www.coherent.com/measurement-control/measurement/laser-measure-
ment-and-control-help-center

The download files contains the software and drivers necessary to install
and operate the BeamView.NET software.

CAUTION!

To avoid application instability, it is strongly recommended to first
disable computer hibernation or suspend mode before installing the
software.

Close all other programs on the computer or laptop.

Double-click to run this file for the BeamView.NET software, where ‘x’
is the latest version:

BeamView_5.0.3.x.exe

If AutoRun is enabled on the laptop or computer system, installation
starts automatically.

Follow the on-screen instructions to complete installation, described
in the steps that follow.

12
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3.2.1

3.2.2

Install Software

Reminder: Close All Programs

As the installation process begins, the first message that is displayed re-
minds users to first close all other applications. Click OK to dismiss the
message.

Setup x

o Before installing BeamView.NET, close all other applications.

Figure 3-1. Reminder to Close Other Programs

If other programs are running, stop the installation process now and close
the other active programs.

If an earlier version of BeamView.NET is installed on the system, the fol-
lowing message is displayed:

Setup

An older version of BeamView.NET was detected in the
system. Do you want to uninstall it?

Yes No

Figure 3-2. Message about Earlier Version

Click Yes to proceed to uninstall the older version, or No to continue with-
out removing it.

Accept License Agreement

The License Agreement for BeamView.NET is displayed. Select the radio
button to Accept the agreement, then click Next to proceed with the soft-
ware installation.

Otherwise, click Cancel to stop installation of the software.

13
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@ Setup - BeamView. NET
License Agreement

Please read the following important information before continuing.

Please read the following License Agreement. You must accept the terms of this
agreement before continuing with the installation.

NOTICE TO LICENSEE: BY CLICEING ON THE “ACCEPT BUTTON, ~
DOWNLOADING, OF. INSTALLING THE COHEEENT SOFTWARE,
YOU ARE CONSENTING TO BE BOUND BY AND ARE BECOMING A
PARTY TO THIS LICENSE. IF YOU DO NOT AGREE TO ALL OF THE
TEEMS OF THIS LICENSE, DO NOT DOWNLOAD OR INSTALL THE

COHERENT SOFTWARE. OR CLICK THE “DO NOT ACCEPT”
BUTTON.

THIS SOFTWARE LICENSE AGREEMENT (the “License™) iz made

@i i e

()1 do not accept the agreement

Copyright (C) 1992-2020 Coherent, Inc.

Cancel
www.coherent.com

Figure 3-3. Accept License Agreement

3.2.3 Select Destination Location

Review the directory listed in the “Browse” line. If acceptable, click Next, or
browse to select a different location, then click Next.

€ Setup - BeamView.NET

Select Destination Location
Where should BeamView be installed?

Setup will install BeamView into the following folder.

To continue, dick Mext. If you would like to select a different folder, dick Browse.

:\Program Files (x86)\C

Browse...
At least 126.1 MB of free disk space is required.
Copyright (C) 1992-2020 Coherent, Inc. < Back cancel
www coherent.com = =

Figure 3-4. Selection Destination Folder

3.2.4 Select Start Menu Folder

Review the directory that is displayed. If acceptable, click Next, or browse
to select a different location, then click Next.

14
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@ Setup - BeamView.NET -

Select Start Menu Folder
Where should Setup place the program's shortcuts?

—
f'_| Setup will create the program's shortouts in the following Start Menu folder,
To continue, dick Next. If you would like to select a different folder, dick Browse.

Coherent'BeamView Browse...

Copyright (C) 1992-2020 Coherent, Inc.

www,coherent.com

Figure 3-5. Select Start Menu Folder

3.2.5 Set Desktop Shortcut

This option allows users to create a desktop shortcut. Click Next when do-
ne.

@ Setup - BeamView.NET -

Select Additional Tasks
Which additional tasks should be performed?

Select the additional tasks you would like Setup to perform while installing
BeamView MET, then didk Mext.

Additional shortcuts:
Create a desktop shortout

t

Copyright (C) 1952-2020 Coherent, Inc.

wwnw coherent. com

Figure 3-6. Select Desktop Shortcut

3.2.6 Preview Set-Up

This screen shows the selections that were made. To change any setting,
click Back. Otherwise, click Install.

A progress bar is displayed as installation proceeds.

Because the software installation includes device drivers, another screen
is displayed for explicit permission. Click Install to proceed.

Be aware that the USB drivers may take several seconds to install the first
time the camera is connected to the computer.

15
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€ Setup - BeamView.NET -
Ready to Install
Setup is now ready to begin installing BeamView.NET on your computer.

Click Install to continue with the installation, or dick Back if you want to review or
change any settings.

Destination location:
C:'Program Files (x86)\Coherent\BeamView

Start Menu folder:
Coherent\Beamview

Additional tasks:
Additional shortouts:
Create a desktop shortcut

Copyright (C) 1992-2020 Coherent, Inc. < Back T Install cancel
www coherent.com = - 3

Figure 3-7. Review Set-Up

€ Setup - BeamView.NET -
Installing
Please wait while Setup installs BeamView.NET on your computer,

Extracting files...
C:\Program Files (x86)\Coherent\BeamView'\BeamView _help.pdf

Copyright (C) 1992-2020 Coherent, Inc.
wwnw coherent. com : :

Figure 3-8. Progress Bar

E=] Windows Security >

Would you like to install this device software?

. MName: Coherent Imaging devices
4-3[‘:— Publisher. Coherent, Inc.

Always trust software from "Coherent, Inc.". Install . Don't Install

T You should only install driver software from publishers you trust. How can |
decide which device software is safe to install?

Figure 3-9. Install Drivers

Note that, when the checkbox is clicked to ‘Always trust software from Co-
herent, Inc.’, any subsequent installations of Coherent software begins
without prompting. For example, if a later revision of BeamView.NET soft-
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3.2.7

Install Software

ware is installed at any time, the software for device drivers installs auto-
matically with the BeamView.NET software, and this dialog box is not
displayed.

Select Computer Restart

When installation is complete, the final set-up screen is displayed. Select
the radio button for Yes or No to restart the computer, then click Finish.

@ Setup - BeamView. NET

Completing the BeamView.NET
Setup Wizard

To complete the installation of BeamView.MET, Setup must
restart your computer. Would you like to restart now?

@ Yes, restart the computer now
("I No, I will restart the computer later

G ight (C) 1992-2020 Coh t, Inc. E 3
opyright (C) oherent, Inc

wwnw coherent. com

Figure 3-10. Select Computer Restart

NOTIC

If there are difficulties with the software installation, check first to
make sure that the workstation has the administrative privileges
required for installation.

Before Coherent is called for technical support, also check whether your
organization’s IT department has security policies or controls in place that
may render the software installation incomplete.

. See 'IT Procedures and Policies’ (p. 11) for more information.

° Also see ’'Service and Support’ (p. 225) for details about how to
contact Coherent for assistance.
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3.3 Uninstall Software

When a later version of the software is installed, Coherent strongly recom-
mends that to first uninstall the old version. Otherwise, the new installa-
tion may run over the top of the existing installation, introducing conflicts
that can lead to serous system errors.

To uninstall the old versions of software:

1.  In Windows, go to Settings > Apps > and, from the list of programs,
select the BeamView.NET software, as shown in Figure 3-11:

= Settings

% Apps & features

—.— Coherent BeamView.NET version 5.0.1.8 193 MB
Coherent, Inc. 10/20/2020

5.0.1.8

Modify Uninstall
Figure 3-11. Select Software to Uninstall

2. Click Uninstall. A warning message shown in Figure 3-12 is displayed
that the application and all of its related files (including drivers) are
removed:

This app and its related info will be
uninstalled.

Figure 3-12. Select Software to Uninstall

3. Click Uninstall to process. A confirmation message is displayed, as
shown in Figure 3-13:

4.  Click Yes to proceed. A progress bar is displayed as the application
and its related files are removed from the computer. A confirmation
message is then displayed, as shown in Figure 3-14:

A new version of the software can now be installed (go to p. 12).

18
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BeamView.NET Uninstall

Are you sure you want to completely remove BeamView MET and all of
its components?

Yes Mo

Figure 3-13. Select Software to Uninstall

BeamWiew Uninstall *

o Beam\View was successTully remawed from your computer.

Figure 3-14. Select Software to Uninstall

Next Steps

Go to 'Set Up Hardware’ (p. 21) to connect one or more cameras, make a
connection to a PC, and launch the software.

Go to 'Software Interface’ (p. 35) to learn about the features and functions
of the BeamView.NET application.

Go to 'Capture Beam Image’ (p. 71) to create a Background Map (recom-
mended) and capture a beam image and set Trigger options.
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4.1

Set Up Hardware

Set Up Hardware

This section describes how to set up software to work with the Beam-
View.NET software.

NOTIC

Complete installation of the software before users connect any hard-
ware. After a camera is connected, BeamView.NET automatically
recognizes the camera. See ’Software Settings for Cameras’ (p. 27)
for details.

This section describes how to:

° Physically connect cameras

d Define software settings for cameras
. Setting up optics

° Aligning the laser and camera

d Setting up for Remote Mode

Each of these are described in the sections that follow.

Connect Camera Hardware

To view images from a camera on the computer, connect the camera to
the PC. There are two methods and different cables required for this.

d Connect a single camera to a PC
° Connect multiple cameras

. Connect a camera when an external trigger is to be used

Each of these are described in the sections that follow.

NOTIC

Take a new Background Map after each time a camera is set up to
make sure that the images and calculations being collected are accu-
rate. See ‘Background Map’ (p. 74) for more information.
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4.1.1

Connect Camera to PC

The LaserCam cameras require only a standard 2-meter USB cable
(shipped with each camera) and a computer with a USB 2.0- compliant
port. Power is provided to the Coherent LaserCam cameras directly over
an standard USB cable.

On the USB cable, an ‘A’ style (flat) connector plugs into the computer or
on the side of an LCD monitor. The opposite end—a 'B’ style connector—
plugs into the camera, as shown in Figure 4-1:

Figure 4-1. Connect USB Cable to Camera

To establish a connection with a PC:

1. Plug one end of the USB cable into the camera.
2. Plug the other end into the USB port on the PC.

NOTIC

For port replicators, such as a USB connection on the side of a
monitor, make sure that the device is a USB v2.0 electronic and
provides a good connection and current for reliable and uninter-
rupted processing. Port replicators can and have been found to
reduce the reliability of connection.

The ‘plug-and-play’ feature of the BeamView.NET software automatically
detects that a camera is connected, and displays the camera model at the
top of the right panel of the main window (see p. 35).
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Set Up Hardware

CAUTION!

The 2-meter cable supplied with the LaserCam camera systems has
been certified for reliable and low emission operation. At a high data
rate, cables longer than 4 meters can cause issues.

When using a USB cable, an error message may be displayed, as shown
in Figure 4-2:

&) Power Surge On Hub Port x|

£ LUSE device has excesded the power limits of its hub port.
For assistance in solving this problem, click this message,

Figure 4-2. USB Error Message

This type of error can happen when a computer is unable to supply the
400 mA required by a LaserCam camera, typically a laptop running on a
low battery. Also, self-powered USB ports are incapable of supplying this
current. Be sure that the laptop is fully charged or the USB port is fully
powered.

NOTIC

Connect ALL power cables to a surge-protected power source!

Connect Multiple Cameras

To connect multiple cameras, USB ports must be available that are fully
powered.

Some desktop computers have multiple USB ports built in that allow us-
ers to connect multiple cameras, as shown in Figure 4-3.

Most laptop computers, however, have a limited number of USB ports. To
be able to connect multiple cameras, install a device commonly referred to
as a USB hub, dock, or Port Expander. When purchasing such a device,
verify that the device has its own power supply (with sufficient power) as
well as the correct type of connectors.
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4.1.3

Figure 4-3. Connect Multiple Cameras

With multiple cameras, multiple instances of BeamView.NET cam be
opened that display properties specific to that camera.

NOTIC

Multiple cameras may result in speed/performance degradation.
Make sure the PC has plenty of computing power and RAM if users
want to run multiple cameras. The computing power suggested
earlier was intended for single camera operation.

Connect a Camera Using an External Trigger

When the camera is to be used with an external trigger, a trigger cable,
must be used, shown in Figure 4-5, instead of a standard USB cable. This
cable is shipped with a LaserCam camera.

To connect the trigger cable:
1. Rotate the cable until the orientation at the end of the connector
matches the mating connector on the camera, then push the

connector securely onto the mating connector. The cable connector is
a keyed connector and has a lock type slide.

2.  Connect the other end of the trigger cable to a trigger source, such as
from the laser or a frequency generator.

This connects a TTL-level Pass/Fail output signal generated by
BeamView.NET from user-configured calculation settings. See
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Figure 4-4. Trigger Cable

'Capture > Capture/Trigger (p. 78) for information about configuring
software for an external trigger.

3.  Atfter the camera is plugged in, wait a few seconds for the computer
to recognize the hardware.

The trigger cable allows connection of an external trigger source through a
BNC receptacle (plug-style connector), as shown here:

Trigger Input
Camera i

Pass/Fail Output

Figure 4-5. Connect Cable for External Trigger

After the software installation is complete, launch BeamView.NET by dou-
ble-clicking the BeamView.NET desktop icon.

p

(B S5 TV [EWRS

Figure 4-6. BeamView.NET Desktop Icon
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4.1.3.1

4.1.3.2

Trigger Options

A hardware trigger polarity selection is available with the BeamView.NET
software. This trigger option selects External Triggering for Pulsed cap-
ture.

NOTIC

Trigger selection is ONLY active for Pulsed mode operation.

Table 4-1 lists trigger specifications:

Table 4-1. Trigger Specifications (External/Pulsed)

Parameter Value
Maximum Voltage 5.5V
High > 2.0V
Low <0.8V
Minimum Voltage —0.7v

A TRIG IN signal (TTL pulse) must be provided to the camera in Pulsed
mode to capture pulsed image data. This signal normally comes from the
laser electronics external sync output.

When Pulsed mode is selected (Capture > Trigger > Pulsed), choose ei-
ther the Rising Edge or the Falling Edge. See 'Capture > Capture/Trigger’
(p. 78) for details about setting up parameters for a trigger in Pulsed
mode.

Auto Trigger | Internal Trigger

The Auto Trigger (also referred to as Internal Triggering) mode does not
require any trigger signals; therefore, it is often used for set-up and align-
ment.

. Auto Trigger is suggested for first time set-up if the repetition rate is
greater than approximately 10 Hz. After some images are captured,
using more advanced triggering methods can improve capture perfor-
mance.

° It is not recommended to use the Auto Trigger mode of capture for
Pulsed laser sources below 10 to 20 Hz.
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See 'Auto Trigger Mode’ (p. 85) for more information about this feature.

Software Settings for Cameras

The “plug-and-play” feature of the BeamView.NET software automatically
recognizes a camera after it is connected.

In the software, go to the Setup tab and select Camera.

& w | | BeamView.NET

Home Edit View Capture Analysis Setup Help

' Remote Maode

| Camera Password

Figure 4-7. Setup Tab

When Camera is selected, the following dialog box is displayed:

0 Camera Setup X
Select active camera

LaserCam-HR-1I-2/3 0907A15R v

Figure 4-8. Setup — Camera

From the drop-down menu, select the desired Camera for which to config-
ure settings and capture images. Notice that the name and serial number
of the camera are listed. Click Select.

A second dialog box is displayed. Notice that the serial number is listed.

NOTIC

Coherent recommends leaving this user-defined number as the
serial number of the camera in use in the event that the camera is
returned to the factory for any reason.

Click OK to continue.
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4.2.1

4.2.2

ﬂ Camera Setup -
Settings

< 0907A15R
User Defined 1D Mumber:

Ok

Figure 4-9. Setup — Camera — User-Defined ID

Setup > Settings

The Settings area of the Setup tab includes the following options:
° Calibrate Power

* Scale Factor

. Focal Length

d Remote Mode

For a description of each, go to 'Setup Tab’ (p. 63).

Setup > Configuration Protection (Password)

Password protection is used to prevent accidental change to the Beam-
View.NET configuration settings.

When users click the icon for Password, the dialog box shown in Figure 4-
10 is displayed:

Enter a new password, which can be up to fifteen characters long, and
may contain only alphabetic characters and numerical digits (no punctua-
tion marks or spaces). Entering an invalid character or exceeding the
maximum length will cause the computer to beep.

When OK is clicked, a confirmation message is displayed. Click OK to dis-
miss the message:

After the desired configuration settings are established, select the Pass-
word command from the Setup menu. After the password is entered, con-
figuration settings cannot be changed unless the password is entered
again.
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Configuration Protection is: OFF

To protect the current test configuration from accidental changes, enter
a new password (up to 15 characters). You will need to confirm the
password before it will be accepted.

Enter Mew Password:

‘ OK || Cancel H Help

Figure 4-10. Setup — Password Protection

Locked X

! \ The test configuration information is now locked!

Figure 4-11. Setup — Password Locked Message

All configuration settings and windows can still be viewed as normal, but
making a change and pressing the OK button displays a pop-up box re-
questing that the user enter the correct password before saving the
changes.

Optics Set-Up

As with any sensitive diagnostic tests, accuracy is dependent upon the
quality of the optics used in the measurement.

In beam diagnostics testing, it is especially important to deliver the beam
to the camera with almost zero distortion. Therefore, only high quality, low
distortion optics should be used in the test set up.

Table 4-2 shows the possible causes and effects of issues when using op-
tics:

If using an energy/power meter with the BeamView.NET software, the en-
ergy that is seen by the meter is also affected by any front-end optics. Al-
though distortion is not a major concern with most detector types,
scattering can affect energy readings (if it causes part of the beam to miss
the sensor).
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43.1

Table 4-2. Issues When Using Optics

Effect Cause
Interference Caused by parallel optical surfaces. Always set optical
effects surfaces at small angles.
Scatter Caused by dirty or damaged optics, or poor quality
optical coatings.
Aberrations Caused by poor quality optical surfaces or materials.
Distortions Often caused by non-uniform optical materials or coat-

ings, and by short focal length optics.

Background noise | Caused by room light, scattered light, or laser flashlamp
light.

Note that the energy and power levels that a particular meter can dissi-
pate, and then compensate the optics for the sensor accordingly. For addi-
tional information, refer to the owner's manual that came with the meter.

If using an energy/power meter, remember that the displayed energy (and
the energy used in calculations) is just the reading from the meter. If there
is improper compensation by the front-end optics, all calculations will be
inaccurate. Be sure that the meter to be used is able to compensate cor-
rectly for the front-end optics that chosen.

Recommended optical set-ups for maintaining minimal beam distortion in-
clude:
° Attenuation

° Background Light

d Focus Optics

Each of these are described in the sections that follow.

Attenuation

The most critical set-up operation necessary to avoid saturation or dam-
age of the camera is the attenuation of the laser.

Camera saturation occurs at different levels and can vary dramatically be-
tween wavelength, mode of operation (CW or pulsed), and type of sensor.
Check the User Manual for estimated saturation levels for the specific La-
serCam-HR camera being used.
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It is recommended that the laser source is attenuated well below the satu-
ration level of the camera before performing any measurements with the
beam profiling system. Using this precaution ensures that damage to the
sensor does not occur.

It is important to attenuate the beam without introducing distortions. Do
not use absorption-type attenuation optics where distortion and lensing ef-
fects can occur. It is best to perform the majority of the attenuation with
front surface attenuation schemes—such as laser mirrors—that allow high
levels of attenuation with low distortion. Make sure these attenuators are
of high quality.

The best method of attenuation is to reduce the beam power with a contin-
uously variable attenuator to provide maximum diagnostics test flexibility.
This can be performed with crossed polarizers, variable-step Neutral Den-
sity (ND) filters, or continuous variable-wedge devices. Ensure that:

. The ND filters have laser grade surfaces and high quality coatings.

° The variable beam attenuators have the lowest possible distortion.

Coherent offers a selection of variable attenuation modules—C-VARM
(continuously variable) and VARM (fixed-level attenuation)—that meet
these specifications. For more information about these and other system
accessories, visit the Coherent website:

https://www.coherent.com/measurement-control/measurement/beam-diag-
nostic-accessories

An example of attenuation scheme is shown in Figure 4-12. Any combina-
tion of this set-up can be used to properly attenuate the laser beam.
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4.3.2

LaserCam-HR Series

Figure 4-12. Optics Attenuation Set-Up

Background Light

Background light seen by the camera should be closely monitored. This
light comes from scattering, room lights, flashlamp lights, and instrumenta-
tion lights.

Elimination of background light is especially critical with pulsed laser diag-
nostics when some cameras are required to time-integrate the image to
avoid image splitting. In these situations, low background light may be
time integrated to large levels.

The BeamView.NET software cannot distinguish background light from the
laser beam image, and includes this light in its analysis. In applications
where the beam image size is small, even a modest amount of back-
ground light can greatly affect the accuracy of the beam analysis.

An attenuator window with low transmission should be attached to the
camera housing to reduce background light and protect the sensor from
collecting dust particles from the environment.

Coherent recommends using a Low Distortion Faceplate (LDFP or LDFP-
UV), which eliminates ambient room light that may reach the camera ar-
ray. The Faceplate is made of 2.65 mm thick NG-9 laser-grade filter glass.
Both LDFP or LDFP-UV surfaces are laser-grade polished.
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The Faceplate provides a protective window for the camera array from UV.
It also acts as a background attenuator with 0.03 to 0.06% transmission
from 400 nm to 1100 nm. For wavelengths shorter than 400 nm, the cam-
era must be used without the Low Distortion Faceplate. For details, see
the specific User Manual for the camera.

Focus Optics

High quality, low-distortion optics and low background light noise are criti-
cal to obtain accurate beam diagnostics results with the BeamView.NET
software. A focusing optic can be used for Far Field beam diagnostics.

For best results, choose a focal length to get an image size that fills rough-
ly 2/3 of the array diameter. If multiple wavelength testing is to be per-
formed, a parabolic mirror can give better results than a lens, since
chromatic aberration is not present in mirrors.

The focusing optic should be of superior quality to avoid distortion and ab-
errations. Be aware that the shorter the focal length, the larger the inher-
ent aberrations within the image. Focal lengths of 2 meters or more are
sufficient to avoid these aberrations for small laser beams of 1/8 to 1/4
inch (0.3 to 0.6 mm) in diameter.

Another important point to consider is the size of the laser beam spot that
the camera images. As the image size gets smaller, the digitized spatial
data resolution decreases, reducing the accuracy of the results. There-
fore, the focusing optics should be chosen so that the beam image is not
less than 20 to 30 pixels in diameter.

The maximum allowable beam image size is dependent upon the camera
used. The beam image must be contained within the camera's active area
and should not overlap the edges. For example, this corresponds to a
beam image size of about 6 mm on the 2/3 inch format CMOS LaserCam-
HR Il sensor. A reduction or expansion telescope may be required if these
spot sizes cannot be achieved by varying the focal length of the optics, or
if Near Field diagnostics must be performed.

The Focal Length command inputs the focal length for a lens or focusing
mirror used in conjunction with the camera for measurement of Far Field
values. See 'Setup > Focal Length’ (p. 65) for details.

Align the Laser and Camera

The Live Video feature on the Home Tab is useful when setting up and
aligning the laser and camera.
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4.5

WARNING!

LASER RADIATION! Always avoid eye or skin exposure to both
DIRECT and SCATTERED radiation, including damage or noise from
laser back reflection. See ’Safety and Compliance’ (p. 217) for more
information and safety precautions.

The Live Video command switches the BeamView.NET software system
from displaying images in Start mode (with overlay graphics and calcula-
tions) to a real-time display in Live Video mode (with no overlay graphics
or calculations).

When Live Video mode is On, the View area displays a contour or 3D plot,
which allows real-time viewing of the camera video.

To choose the Live Video command:
d On the Home tab, select the Live Video command from the toolbar.

. To turn Live Video Off, choose the Stop Capturing command.

Set Up for Remote Mode

To set up and run a Remote application, follow these general steps:
1. Runthe BeamView.NET software and configure settings for the inter-
face that is needed.

2.  Turn on Remote Mode in BeamView.NET by clicking the Remote
Control icon in the toolbar for the Home tab. This provides a fast,
single-click control to set up a connection.

Connect a camera, which BeamView.NET then automatically detects.

4. Run the Remote application (such as the Coherent Remote Data
Logging Utility) and enable the connection.

For more information about configuring and running applications in Re-
mote Mode, see 'Remote Mode Set Up’ (p. 151).

For details about host commands that can be used in a remote interface,
see 'Remote Mode Host Communication Protocols’ (p. 163).
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5.1.1

Software Interface

Software Interface

This section describes the various windows and commands for the Beam-
View.NET software, as well as basic settings to capture beam images.

Main Window

The following splash screen is briefly displayed after the software is start-
ed.

BeamView.NET

1

‘( s

Version: 5.0.1.4
Copyright © 1992-2020, Coherent, Inc..

Authorized Use Only

This program is protected by US &t International copyright laws as described in Help

Figure 5-1. BeamView.NET Splash Screen

The splash screen identifies the product name, current version number,
and copyright information.

The main window shown in Figure 5-2 is then displayed.

The main window consists of display and control elements similar to most
Windows applications, along with the following elements specific to the
BeamView.NET application.

Title Bar

The Title Bar displays the software name, version number, and test name
(if a configuration or session file has been saved or loaded). This area
also includes a File menu.
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5.1.2

5.1.3

Title bar o e L
E o - . - Prafiles

Tabs and

tOOI ba rS Samples All Cleared
Lo Y Camera type

Status of samples

View area
Results area with
Calculations

!;EEEEE § BE¥ EEEEE BEE SSsgggggEEssss

Statistics Divider bar

Camens conmactd | 11| W | Cont | 1280 028110 o] [ ssas

Status bar
Figure 5-2. Main Window Areas

Tabs

The Tabs list menus available for the BeamView.NET window, and con-
tain commands that allow specific actions to be performed or display dia-
log boxes. These elements provide various controls for such functions as
graphics, analysis, configuration set-up, etc.

Tool Bar

The Tool Bar consists of various icon buttons, which are small symbols
that provide quick access alternatives to using menus or keyboard equiva-
lent keys to perform various functions. To use a Smart Icon button, move
the mouse cursor over the icon and click on the button using the left
mouse button. To view the function of any icon button, place the cursor on
the icon and wait momentarily; a brief function description is displayed
near the icon.

The set of tabs across the top of the BeamView.NET software application
include the following toolbars.

L Home
d Edit
4 View

° Capture
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° Analysis

. Setup
L Help
View Area

This graphics area on the left side of the BeamView.NET window shows
the current beam image, along with cross-section profiles, crosshair cur-
sors, overlaid apertures, and other selected fitted or reference profiles and
position graphics.

The digitized pixel intensities of the image can be plotted as a contour
map in one of four different color scales shown in the color scale bar at the
left side of the image area or as a 3D isometric plot.

A polar wander plot is also available, which plots the location of the cen-
troid for a series of samples, visually showing beam wander over time.

When graphics Zoom is enabled, scroll bars are displayed on the sides of
the View area. Interactive mouse control of graphics cursors, 3Dplot view
angle, and pan functions are provided when the mouse cursor is within the
View area.

Results Area

This area at the right side of the BeamView.NET window display shows
the results of selected calculations for the beam image shown in the View
area.

The Sample header at the top of the results area reports the sample num-
ber, current time, and date.

The panel on the right lists Calculations selected.

When the Stats On command is selected, an area at the bottom of the
main window is displayed.

Divider Bar

The divider bar allows users to change the relative size of the View area
and Result area. Click and drag the divider bar to the left or to the right to
resize.
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5.1.7

5.2

5.2.1

5.2.2

Status Bar

The Status bar is located at the bottom of the BeamView.NET window,
and indicates the current status of key system measurement, as well as
configuration and operational parameters.

File Menu

The file menu at the top of the main window includes commands and
menus to manage tests, configurations, images and results.

Open Test

The Open Test command opens a Test file from a standard Windows fold-
er.

The Open Test command provides selection of previously-saved test ses-
sion files. A saved test session file contains all images that were in the im-
age buffer when the file was saved, as well as information about the
BeamView.NET software settings (buffer, graphics, calculations, pass/fail,
units, etc.).

When a test session file is loaded, the same software settings are
changed to those specified in the test session file. All images stored in the
test session file are also loaded into the image buffer.

Save Test | Save Test As

Saving a test session file stores all images currently in the image buffer,
as well as information about the BeamView.NET system configuration set-
tings (buffer, graphics, calculations, pass/fail, units, etc.) to a user-speci-
fied file.

Saving data as a test session allows that data to be recalled at a later
date, maintaining the analysis parameters that were in place when the
data was captured.

The Save Test command saves the current test session to the current file
to a standard Windows folder. The default file name extension for the con-
figuration files is “.ATS” (Analyzer Test Session).
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NOTIC

After users save the first test session, any subsequent Save Test
commands override the contents of the existing test session file and
replaces them with the current images and configuration informa-
tion. If an existing file is replaced, the old file cannot be restored.

To save the test session without destroying the existing test session file,
use the Save Test As command.

The Save Test As command saves the current test session to a new file to
a standard Windows folder.

Load/Save Config

A saved system configuration file contains information about the Beam-
View.NET software settings (buffer, graphics, calculations, pass/fail, units,
etc.). When a saved configuration file is loaded, the same software set-
tings are changed to an identical state in which they were originally saved.

The default file name extension for the configuration files is “.ATC” (for An-
alyzer Test Configuration).

Load Config Command

The Load Config (configuration) command loads a previously saved sys-
tem configuration from a standard Windows folder.

Multiple configuration files can be stored and recalled to quickly reconfig-
ure the BeamView.NET software to other test configurations.

Save Config Command
The Save Config command saves the current system configuration to a

standard Windows folder.

The default file name extension for the configuration files is “.ATC” (for An-
alyzer Test Configuration).

Import/Export

The default file name extension for image files is .”bin” (for Beam-
View.NET binary images).
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5.24.1

5.24.1.1

5.2.4.1.2

Import Image Command

The Import Image command allows import (recall) of beam image data
from stored files for reanalysis, display, or data comparison.

The command to import images clears the current buffer in the software.
Selected images replace any previous images in the current buffer.

Selecting the Import Image command opens a standard Windows folder.
Choose an image data file from the list, and click Open.

Import File Format

Raw Images can be imported (recalled) from any of several different file
formats. The standard BeamView.NET formats are Binary and ASCII, but
other graphic file formats are supported as well, including .bin, .img,
and .png images. Both Binary and ASCII include header information. This
is used only by the BeamView.NET software to properly reload images.

When a file type is selected, the File Name list box displays only file
names for the selected type.

NOTIC
The .JPEG file format is not supported for import BeamView.NET

software.

The Analyzer uses 8-bit, intensity pixel values. Although the 24-bit pixel
values can be scaled to 8-bit values, a valid intensity value cannot be de-
rived from an RGB value.

An alternate format that provides good compression, portability, and data
integrity is the Portable Network Graphics (.png) format.

Select Image to Recall

Images can be recalled one at a time, each from an individual file, or se-
lect multiple files from the file name list using the Windows click-and-drag,
click-and Shift-click, or use multiple Ctrl-clicks. The selected images are
added to any images currently in memory, just as if they were captured
with the Start Capturing command. The sample number changes to re-
flect the last image loaded.
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The Image files contain only data for a single image and no other
information. The current configuration settings may not match the
settings used at the time the image was captured.

If a configuration file was stored at the time the image was captured,
recall that configuration file before importing the raw image.

Export Image Command

The Export Image command allows export (storage) of beam images to
disk for import into other programs, data logging, archival, or later recall
and reanalysis.

The Export Image command saves an image data file in a binary image
format (*.bin) to a standard Windows folder. Click Save.

NOTIC

Export Image file formats contain in only the raw image data and no
system configuration information. If an image is saved for future
recall, remember to store a configuration file under the same name.
The configuration file should then be loaded before importing the
raw image.

Export File Format

When entering the filename, it is not necessary to specify the extension
for the file type. The correct extension is added automatically.

The BeamView.NET software allows selection of multiple images to export
to a file. Most file formats allow only one image to be stored in a file.

When multiple images are selected, the flename is modified by appending
the Sample number for each selected image. For example, if the filename
is specified as “TestA.png” and Sample numbers 1, 2, and 5 are selected
for export, the BeamView.NET software saves three files:

o ‘TestA1.png’
A ‘TestA2.png’
A ‘TestA5.png’
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5.2.4.2.2

5.2.4.3

5.24.3.1

The BeamView.NET Binary image format is the only format that allows
multiple image to be stored in a single file. So, if the filename is specified
as ‘TestA.bin’ and Sample numbers 1, 2, and 5 are selected for export, the
analyzer saves all three images into the single file named “TestA.bin”.

Select an Image to Store

After a file name has been chosen, the Image Select window is displayed
and automatically highlights the numbered icon for the sample that is cur-
rently being displayed on the BeamView.NET software.

If that is the only image to be exported, simply click the OK button.

Export Results Command

The Export Results command saves a Results file (in a .txt format) to a
standard Windows folder. Click Save.

The Export Results command allows export (storage) of analysis results
data for ALL captured samples to disk in an ASCII text format for data log-
ging and archival.

This is a one-way operation because there is no “Import Results” com-
mand. If It is important to be able to access these results inside the Beam-
View.NET file later, then save the desired images and a configuration file
into a special directory where the files are not mixed with other data.

Results File Format

The Result Data file format contains only the calculated results. The Save
as type list shows file names for the following file types:

. Result Data (*.txt): Stores results & statistics for all captured samples.
d All Files (*.*): Use this file type to display all the files contained in a

directory.

The Export Results command creates a data file containing the calcula-
tions for captured images (from the Image buffer) and statistics on all sam-
ples (from the Sample buffer).

° The first data set contains the calculations for each sample in the

Image buffer. The data set is numbered 1 through x; in this example,
results are numbered 1 through 5.
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° The second data set contains the statistics on the calculations in the
Sample buffer and is always numbered 1 through 4. This data set is
listed directly below the first data set. in the Export Results file.

The example in Table 5-1 shows the results after exporting a data file from
BeamView.NET and importing it into a spreadsheet.

Table 5-1. Export Results File

. Peak % Aper. Diam-
Sample Date Time Response P/F | eter 86.5% | PIF

(mm)

1 “Dec. 19, 2019” | “03:39:01 PM” 96.1 P 1.690

g 2 “Dec. 19, 2019” | “03:39:01 PM” 95.3 P 1.690
é 3 “Dec. 19, 2019” | “03:39:02 PM” 95.3 P 1.690
g 4 “Dec. 19, 2019” | “03:39:02 PM” 94.9 P 1.690
5 “Dec. 19, 2019” | “03:39:02 PM” 95.7 P 1.690

= 1 “MIN” 94.9 1.690
E 2 “MEAN” 95.5 1.690
é- 3 “MAX” 96.1 1.690
» 4 “SIGMA” 0.4 0.000

In the data file, samples are separated by a carriage return and a line
feed. Individual results and pass/fail indicators for each sample in the file
are separated by tab characters. This file format allows the analysis re-
sults to be imported into spreadsheet programs.

A calculation taken while the Perform Pass/Fail checking option (Calcula-
tions dialog box) is enabled displays a result that is followed by a ‘P’
(Pass) or ‘F’ (Fail). These designations indicate whether that specific re-
sult is inside or outside the acceptable test range limits.

In the example above, there are no entries in the ‘P/F’ column on the far
right. This signifies the Perform Pass/Fail checking option was turned off
for this calculation.

The Sample buffer always contains all samples in the Image buffer and, in
addition, can include samples not in the Image buffer. As a result, users
may see something similar to the following example (see highlights to
compare).

In the example in Table 5-2, the MIN, MEAN, and SIGMA values are cor-
rect. Based on those values, users know the Sample buffer contains more
samples than the Image buffer.
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To generate statistics based solely on the samples in the Image buffer, re-
move the unwanted samples (that is, samples with no images) from the

Sample buffer before the results are exported:

1. Under the Edit tab, open the Clear Buffer dialog box.
2.  Select ‘Keep Samples that have Images.’
3.  Click the OK button.

Table 5-2. Export Results File — Samples NOT in Image Buffer

Peak % Aper. Diam-
Sample Date Time ° | PIF | eter86.5% | PIF
Response

(mm)

1 “Dec. 19, 2019” | “03:39:01 PM” 96.1 P 1.690

q..ﬂ:-‘ 2 “Dec. 19, 2019” | “03:39:01 PM” 95.3 P 1.690
=]

'g 3 “Dec. 19, 2019” | “03:39:02 PM” 95.3 P 1.690
o)

£ 4 “Dec. 19, 2019” | “03:39:02 PM” 94.9 P 1.690

5 “Dec. 19, 2019” | “03:39:02 PM” 95.7 P 1.690

. 1 “MIN” 1.6 1.690
2

= 2 “MEAN” 39.1 1.690
[}

E- 3 “MAX” 96.1 1.690
©

» 4 “SIGMA” (o 22.3 0.000

5.24.4 Export Profiles Command

The Export Profiles command allows export (storage) of image profile
data to an ASCII text (.txt) file. The profiles that are stored are the image
profiles displayed in the View window when Export Profiles is selected.

Reference profiles and fit curves are not stored.

The Export Profiles dialog box provides selection of file names, data
types, and directory locations in a standard Windows folder.

The Save as type list shows file names for the following file types:

. Profile Data (*.txt): Stores the currently displayed image profiles. See
Profile Data Format for details on the file structure.
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d All Files (*.*): Use this file type to display all the files contained in a
directory.

Profile Data Format

When profile data is stored, the image intensity information for each pixel
are stored in a single file, along both X and Y axis profiles.

. The X axis profile is stored first, with each pixel value separated by a
comma (,) and ending with a carriage return and line feed.

. The Y axis profile is then stored in similar fashion.

As an example, profile data looks similar to:

0,0,0,0,0,1,3,6,13,25, ... ,22,17,13,8,4,2,0,0,0,0
0,0,0,1,2,5,8,12,18,23, ... 27,22,16,11,7,4,3,1,0,0

Note that the number of data points in a profile vary, relative to the
Capture > Resolution settings.

Print Set-Up

The Print Set-Up command displays a standard Windows print dialog box.

This command allows users to select a Windows printer from the list of in-
stalled printers, as well as select options for printing. Use this dialog box to
verify (or modify) printing parameters.

Click OK to save the currently-displayed printing parameters.

Print Report

The Print Report command prints a report, current image, results, or
saves a report to a .PDF file.

Selecting the Print Report command displays the following dialog box:
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ﬂ Print Report Setup *
Source
* Report « | Cross Hair
v Profiles

[ ] Reference Profiles
To capture a screenshot, press “‘Ctrl” +

‘Alt' + ‘PriScr' and paste into the Fit Profiles
apphication of your choice. | White Background ‘
OK Cancel Help |

Figure 5-3. File > Print Report Set-Up Dialog Box

NOTIC

The report is set by default to a black background on the image area
to better display the laser image. Click the checkbox to select a
White Background to safe ink when printing.

Depending on the source selected for the report—Report or Beam-
View.NET Window (Screen shot)—a different menu displays when the OK
button is clicked in the Report Setup dialog box.

Selecting Report as the source then displays a Report that users can
then:

d Click the Save button to store a .pdf version of the report to a location
that is selectable by the user.

° Click Print on this menu to send the report to the printer previously
selected on the Print Setup menu.This prints a single-page report that
contains both the image and user-defined calculations.

A sample report is shown in Figure 5-4:

To capture a screen shot, press 'Ctrl' + 'Alt' + 'PrtScr' and paste into the
chosen application.
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BeamView 5.0.1.8 Report

Save
[pimt

Cancgl

&4 1805

Figure 5-4. Print Report Example

Test Information

The Test Information command displays a dialog box where users can en-
ter descriptive information about the test session, as shown in Figure 5-5:

The Test Information dialog box includes a title, a serial number, an opera-
tor name, a comment field, and a workstation number.

Any test information that is entered is displayed on the right side of the
display screen, below the calculation Results area. All fields are optional,
and only those that have information are displayed.

When a Test Session is saved to disk using either the Save Test or Save
Test As menu, the test information is also stored. A subsequent recall of
the test session (Open Test) then loads and displays that test information,
along with the image and result data from the test session.

The only information that is remembered by the BeamView.NET software
after exiting and restarting it is the workstation.
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&) Enter Test File Information 4

This information is optional, but if entered. will be displayed below the
calculation results, and will be stored when data is saved using the Save
Test or Sawve Test As commands.

Tithe
-
SEnal =
Operator

" §
Lommenis

Wizrk Station

Lok || Concel |[ Help |

Figure 5-5. File Menu > Test Information

5.2.8 Exit

The Exit command closes the BeamView.NET program.

53 Home Tab

The Home Tab shown in Figure 5-6 lets users select the sample, start and
stop capture, as well as whether to include crosshair, aperture, profiles or
reference positions for the sample. Users can also select the level of
zoom and coloring style.

1 Seam View NET — [m] W
Home Edit Capbare Anahysis Satup el

View
. ﬁ + Crosshair Reference Position ;-J iﬁ
. e Aperturs Inclusian e 30 Pt d Ea= -
Ca;i:z':mg Caﬁﬁﬁng v-;:n it Profiles  Crooshic Location: |User Coord™| @ Palar Plot i_.ir:f:el

Figure 5-6. Home Tab

The commands available in the Home tab include:

° Operations:
A Start Capturing Samples
o Stop Capturing Samples

° Live Video — Capture and display image samples s fast as
possible
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L Select the First Sample, Previous Sample, Next Sample, or Last
Sample
Enable/Disable Profiles - Turn properties for each on or off for:
o Crosshair
° Aperture
° Profiles
o Reference Position
° Inclusion
° Crosshair Location — Drop-down menu to select:
° User Coordinates
. Peak

d Centroid

Plot Type — Set the plot type:
o Contour Plot

° 3D Plot

° Polar Plot

Screen

° Change Zoom — Adjust the zoom level.

A Coloring Style — Change the plot between colors and black-
and-white

Communications

L Remote Control — Enable or disable

These are described in more detail in ’Analyze Calculations’ (p. 91). For
an example about remote data logging, see 'Remote Data Logging Utility’
(p. 156).

Edit Tab

The Edit Tab shown in Figure 5-7 lets users select the current sample dis-
played, copy the view plot or selected results to the clipboard, and clear
the image data buffer.

The Edit tab includes the following options. Selecting the commands dis-
plays a dialog box for each:
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5.4.1

5.4.2

[i4) m | | BeamView MNET

E Home Edit View Capture Analysis Setup Help

- e
-

Sample Clear
Mumber | Bufffer

Figure 5-7. EditTab

Edit > Sample Number

This command lets users select a specific image sample to display.Enter
the sample number in the dialog box shown in Figure 5-8:

Select Sample Mumber n
Select the desired sample number for viewing:
Sample Number
19
1 19
| Ck | | Cancel | | Help
Figure 5-8. Sample Number
Edit > Clear Buffer

This command clears the captured image samples or select buffer proper-
ties. The options listed in the dialog box shown in Figure 5-9 include:

° Keep Samples that have Images
. Keep Samples marked “Saved”
° Delete Samples marked “Saved”

. Clear all Samples
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Clear S5ample Buffer n

Select the type of samples you wish to delete
from the sample buffer:

) Keep Samples that have Images
) Keep Samples Marked "Saved "
) Delete Samples Marked *Saved"

® Clear All Samples

| Ck || Cancel || Help

Figure 5-9. Clear Buffer

View Tab

On the View Tab (shown in Figure 5-10), users can select the level of
zoom, display calculations, statistical results, and/or test results. Also, us-
ers can configure crosshair and various profile settings.

P BeamVisw NET

Home Edit Wiew Capture Analysis Setup Help

Zoom Levels: | Zoom X1 « | [#] fx Calculations Piot Type Reference Profiles
T Statistics Crosshair Fit Profiles

Test Information e

Figure 5-10. View Tab

The View tab includes the following options:
° Zoom
° Display

. Profiles

View > Zoom Levels

Select a zoom level from the drop-down menu.
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5.5.2 View > Display

This command sets the fit profile properties and turn the display on or off
in the main window of the View Tab for:

° Calculations—The panel shown in Figure 5-11 on the right of the main
window is now populated with the following calculations:
o General calculations
° Ellipticity
° Gaussian Fit
° Aperture Uniformity
A Image Uniformity
° Flat Top

Click the up or down arrows to display or hide each section.

Samples All Cleared
Camers Modet  LaserCam-HE-Uy
=} vl

EEIIEEEEEEEELE

Prair Tz dug
| Elkiphicity

-R-§-

| .
|
| (=} Grussion Fit

i3 Caeger

EZ

Figure 5-11. View Calculations

. Statistics—The same categories listed for Calculations are displayed
in the bottom panel of the main window, shown in Figure 5-12.

. General calculations
. Ellipticity

b Gaussian Fit
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A Aperture Uniformity
o Image Uniformity
° Flat Top

Click the up or down arrows to display or hide each section.

(= e Capass Anpimis  Seiep b

B gw M- S s W | N

Py &P s Ve

ar dur g ot Mewi  Lami wunge Coloring — Remote
gl Castorreg Caphurng Cuplsy Sampls Sampk o roble  Crouhei Locwscre Ll Cooed Polaz Pzt Ioom e t

Sample 109 - 24/Apr/2020 - 08:50:32 AM
Camera Modd:  LaserCam-HR-I-203
C‘_:' General
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(0.4345, 0.3434) 0.5538
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Figure 5-12. View Statistics

. Test Information — Data is displayed under the Results area, shown
in Figure 5-13. For more information, see "Test Information’ (p. 47).
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Figure 5-13. View Test Information

5.5.3 View > Profiles

Set fit profile properties for the following:
. Plot Type

° Crosshair

° Profiles

° Reference Profiles

d Fit Profiles

Each of these are described in the sections that follow.

5.5.3.1 View > Plot Type

Set the image plot type properties in the dialog box shown in Figure 5-14:
° Contour

The options for the Color Scaling under Contour include:
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Image Display Plot Type n

Iw] On

Contour | 3D | Polar

Color
Scaling Style
Froed = Smoath

Ok Cancel Help

Figure 5-14. Image Display Plot Type — Contour

° Fixed

o Scale to Peak

° Low intensity

° High intensity

The options for the Color Style under Contour include:
. Sharp 17

° Smooth

d Gray Scale

° Shaded Bands

3D

The options for the Type of Plot Construction for image displays
under 3D, shown in Figure 5-15, include:

° Transparent Wire
° Hidden Wire
. Solid Wire

The options for the Movement for the Viewing Angle under 3D
include:

° Stationery

o Counter Clockwise

° Clockwise

The options for the Color Scaling under 3D include:
° Fixed

4 Scale to Peak
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Image Display Plot Type n

[+] On

Contour | 30 | Polar

Plot Construction

{ Transparent Wire

Wires _ Colors
o4 W 64

Viewing Angle

Movement

Stationary V

Rotation[degrees] Tili{degrees]
335 46

Color
Scaling Style
Fooed i Smooth bt

ok || cancel || Hep

Figure 5-15. Image Display Plot Type — 3D Plot

. Low intensity
° High intensity
The options for the Color Style under 3D include:
. Sharp 17
* Smooth
. Gray Scale
. Shaded Bands
° Polar
The options for Plot points, shown in Figure 5-16, include:
° Centroid
° Peak
The options for Plot Center include:
° User Coordinate

d Mean Centroid/Peak
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W] On

Contour | 3D | Polar

Data Points

Plat paints for
Centoid
Plot Center

Center plot around
Mean Centroid/Peak *

X[lem]

¥[cm]

335 s

Polar plot colors

Select plot objects Set object color

Mean location e Yellow

Software Interface

| ok || Cancel

|| e

Figure 5-16. Image Display Plot Type —

4 Current Centroid/Peak
d Center of Image

d Reference Position

Polar

The options for Polar Plot Objects include:

° Mean location

° Center location

. Current sample

° Passing samples

. Failing samples

The options for Object color for a Polar Plot include:

. White
o Red
4 Green

° Magenta
. Yellow

d Blue
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5.5.3.2

° Cyan

View > Crosshair

The Crosshair feature is commonly set to track the centroid of the beam.
This shows the profiles set along the crosshair, as in the example in
Figure 5-17.

Crosshair n

W] On
Position
Track

User Coord v
X [em] ¥ [em]
04657 0.4861

Angle
Track

w fero

Degrees

0.0

Style Settings
Coler

Green w

I Ok | | Cancel Help

Figure 5-17. Crosshair Properties

The options for Position for the Crosshair include:
o User Coordinate
° Peak
o Centroid

For the crosshair to be most useful, set the angle setting to either user an-
gle or ellipticity.

° User angle: Setting this to 0 degrees displays the crosshair
exactly horizontal and vertical in the image.
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° Ellipticity: If the laser is an elliptical beam, the angle displays the
profile along the long and short axis of the beam.

The options for Color for the Crosshair include:

. White
o Red
4 Green

° Magenta

4 Yellow

4 Blue

° Cyan
5.5.3.3 View > Profiles

Set profile properties as shown in the dialog box in Figure 5-18

Profiles E

[ ]10On Select Profile: | Fixed A
Style Settings
Calor Lime
White - Solid
Ok | | Cancel Help

Figure 5-18. Profile Properties

The options the Selected Profile include:
o Fixed
o Scale to Peak

The options for Color for the Profile include:

o White
o Red
L Green

° Magenta
° Yellow

L Blue
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° Cyan
The options for a Line for the Profile include:
o Solid
° Dash 1
° Dash 2
5.5.3.4 View > Reference Position

Set reference profile properties as shown in Figure 5-19.

Reference Profiles n
] On Select Reference: | Gaussian Fit A
Style Settings

Color Line
Yellow " Solid
Ok | | Cancel . Help

Figure 5-19. Reference Position Properties

The options for a Reference Profile include:
o Current Profile
° Gaussian Fit

The options for Color for the Reference Profile include:

o White
L Red
. Green

° Magenta

° Yellow

. Blue

° Cyan

The options for a Line Style for the Reference Profile include:
o Solid

° Dash 1
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5.5.3.5 View > Fit Profiles

Set fit profile properties as shown in Figure 5-20.

Fit Profiles u

On Select Fit; | Gaussian Fit hd

Style Settings
Color Line

Red - Solid

Ok . Cancel . Help

Figure 5-20. Fit Profiles Properties

The options for a Fit Profile include:
* Gaussian Fit

The options for Color for the Fit Profile include:

o White
L Red
. Green

° Magenta

° Yellow
. Blue
° Cyan
The options for a Line Style for the Fit Profile include:
o Solid
° Dash 1
5.6 Capture Tab

On the Capture tab shown in Figure 5-21, users can choose to show or
delete the Collection Map, enable CW or pulsed capture operations, select
trigger operations, set the resolution and depth, as well as configure the
storage buffer for samples. Users can also specify the exposure time.

The sections for the Capture tab include:

. Background Map
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m | | Beam\View.NET

Home Edit View Capture Analysis Setup Help
ik Collect Map ¥ oW Capture/Trigger | Exposure Time (u5)
On Pulsed Resalution — M

71 O Buffer

Figure 5-21. Capture Tab

. Trigger Mode (Source)
A CW (Continuous Wave)

4 Pulsed

. Capture Settings
° Capture/Trigger
° Resolution
o Buffer

. Exposure Time Settings

See 'Capture Beam Image’ (p. 71) for details and instructions for settings.

5.7 Analysis Tab

The Analysis tab shown in Figure 5-22 lets users configure settings for
analysis calculations, pass/fail options, overlay apertures, and other pro-
file information.

a > ' m BeamView MET
ﬁ Home Edit View Capture Analysis Setup Help
Calculations Apertures Units

Fault Actions =~ Reference Position Average Images
Inclusion

Figure 5-22. Analysis Tab

For details about how to set up and use options this toolbar, see 'Analyze
Calculations’ (p. 91).
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5.8.1

5.8.2

Software Interface

Setup Tab

In the Set-up Tab shown in Figure 5-23, identify a camera, adjust proper-
ties for the selected camera, define input power/energy for calibrations,
set the input optical magnification scale, input Far Field optical focal
length, and set password protection for configuration settings.

& BeamView.NET

Home Edit View Capture Analysis Setup Help

' Remote Maode

| Camera Password

Figure 5-23. Setup Tab

There are three sections in the Setup Toolbar:
° Camera

° Settings
o Calibrate Power
o Scale Factor
° Focal Length

4 Remote Mode

. Configuration Protection (Password)

Setup > Camera

For information about how to connect one or more cameras, see 'Set Up
Hardware’ (p. 21).

After a camera is connected, the BeamView.NET software automatically
recognizes the camera. See 'Software Settings for Cameras’ (p. 27) for
details.

Setup > Calibrate Power
The Calibrate Relative Power/Energy command provides entry of a pow-

er/energy value as a “base” power/energy level.
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5.8.3

The power /energy calculation sets the total summed intensity of all pixels
in the next sample captured to this value. All subsequent samples are cali-
brated with this factor for Power/Energy and Peak Power/Energy Density
(Fluence) calculations.

To choose the Calibrate Relative Power/Energy command, go to the Set-
up menu >> Calibrate Power. Select the Calibrate Relative Power/Energy
command to open the following dialog box, shown in Figure 5-24:

&) Calibrate Relative Power x

Please enter the Power value and press
“Finish"”. The next time you press "Run” the

first image captured will be set to this value.
All subsequent images will have Power
5 readings relative to that image.

Power Valpe; 2.000 W

[_Finish | [ Cancel |[ Help |

Figure 5-24. Setup >> Calibrate Power

The Power Value function is available in the Calibrate Relative Power dia-
log box. This function allows users to input the power/energy calibration
value, which is entered numerically.

After entering the value, click Finish the displayed instructions to perform
the calibration operation

Setup > Scale Factor

The Scale Factor command lets sets the optical magnification scale factor
by defining a scaling factor to multiply the camera pixel size.

The Scale Factor settings are defined in the dialog box shown in Figure 5-
25:;

Scale Factor n

The Pixel sizes are multiplied by the Scale Factor to account for any
magnification or reduction in the beam.

Scale Factor
1.00000

| Ok | | Cancel | Help

Figure 5-25. Setup > Scale Factor
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5.8.6

Software Interface

The Scale Factor command provides input of a scaling factor to multiply
the camera pixel size to compensate for magnification or de-magnification
of the laser beam by various optical systems, such as a magnifying lens.

If there are optics (either expanding lens or a reducing lens) in the beam
path, users can set a Scale Factor into this setting to adjust calculations.
For example, if users enter a scale factor of 6 into the BeamView.NET
software, and it makes all of the corrections to match the calculations to
the actual beam size.

Setup > Focal Length

In the Focal Length dialog box, define the focal length value for a lens or
focusing mirror being used with the camera for Far Field measurements
(such as Divergence or Pointing Stability).

For all Far Field calculations to be correct, the focal length of the optic be-
ing used must be entered in the Focal Length function.

When users select Focal Length, the dialog box shown in Figure 5-26 is
displayed:

£ rocal Length *
Use the Focal Length parameter if a lens is being used with this camera

to measure divergence.

Focal Length
100.0000

0K . | Cancel | . Help

Figure 5-26. Setup — Focal Length

Setup > Remote Mode

Remote Mode lets users set or disable a TCP/IP or serial (RS-232) con-
nection. See 'Remote Mode Set Up’ (p. 151) for detailed information about
Remote Mode.

Setup > Configuration Protection (Password)
This an option only if users need the added security and is not considered

a general set-up task.

To enable Password protection:
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1. Clickthe Lock icon. The dialog box shown in Figure 5-27 is displayed:

Configuration Protection is: OFF

Teo protect the current test configuration from accidental changes, enter

a new password (up to 15 characters). You will need to confirm the
password before it will be accepted.

Enter Mew Password:

| Ok | | Cancel | | Help |

Figure 5-27. Configure Password Protection

Enter a password, and click OK. The message shown in Figure 5-28
is displayed.

Locked >
! N The test configuration information is now locked!
Figure 5-28. Test Configuration Locked
5.9 Help Tab
The Help tab is displayed as shown in Figure 5-29:
& » = BearmView NET
ﬁ Home Edit View Capture Analysis  Setup | Help

Keyboard Shortcuts % 0
Background Warning s
Systemn About
tatus  BeamView. MET

Using
Help

Figure 5-29. Help Tab

In the Information area:

Using Help — displays contents of the Help file
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d Keyboard shortcuts — see 'Keyboard Shortcuts’ (p. 68)

. Background Warning — displays Help information about background
warnings

In the About area, users can check:

d System Status shown in Figure 5-30 — Details about the host PC.

Huost PC Systemn Status n
= Info

Total Physical Memaory 34.16 B

Available Physical Memany: 2383 GB

Available Virtual Memory: 134 GB

Free System Resources: T

Microsoft Windows 10 Enterprise 6.2, Build9200

Sendice Pack

CPLU: ntel(R) Core(TM) i7-88530H CPU & 2.60GHZ

Number of CPUs or cores: 12

[ ok || Hep

Figure 5-30. Help — System Status

° About shown in Figure 5-31 — View license and copyright information
for the software.

€) About BeamView NET X

BeamView.NET

Version 5.0.1.8

Copynight @ 1992-2020 Coherent, Inc.

Web: http:/ /www.coherent.oomy

Email: LMC sales@coherent.com

Phone: (800) 343-4912

Address: 27650 5W 95th Avenue
Wilsonwille, OR 97070 USA

OK

‘Wiarning: Tris computer program is protected by copyright Lew and imtemational treatees
Unautorized reproduction or distribution of this program. or any portion of it may result in
savere chill and criminal peralttes. and will be procecuted =0 the raimue SIRNT POSE bk et
[

Figure 5-31. Help — About BeamView.NET
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5.10

5.10.1

5.10.2

Controls for the User Interface

Within BeamView.NET are a functions offered by the mouse cursor, key-
board shortcuts, and commands/menus.

Mouse Cursor

The BeamView.NET software utilizes a mouse-driven cursor for selection
of menus and commands, as well as manipulation and control of various
graphics and result display functions.

These different cursor functions are dependent on the position of the
mouse within, or over, specific areas of the Windows display.

d When the mouse is moved over menus, command lists, dialog boxes,
oricon buttons, it retains its normal “arrow” configuration and function-
ality.

i When the mouse is moved within the View Area, it changes to a
“crosshair” cursor. This allows users to manipulate and position
various graphics and data display functions.

Details about the cursor function for various functions are provided in lat-
er sections.

Keyboard Shortcuts

Table 5-3 lists shortcuts that provide keyboard access to commonly used
operations:

Table 5-3. Keyboard Shortcuts

Operation

Key Description

Background Subtraction <Ctrl>+<B> Open the Background Map Collection dialog window

tion

Calculation/result Configura- <Ctrl>+<R> Open the Calculations dialog window

Calculations On/Off

<F7> Toggle calculation result display On or Off

Centroid Location

<Shift>+<F6> | When in Stop mode, move image crosshair to the
centroid location

Crosshair Display

<F5> Toggle image crosshair display On or Off
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Table 5-3. Keyboard Shortcuts (Continued)

Operation Key Description

Crosshair Movement Arrow Keys When in Stop mode, move image crosshair position

CW/Pulsed Selection <Shift>+<F7> | Toggle capture settings between CW and Pulsed
modes

Goto Sample Number <Ctrl>+<G> Open dialog window allowing entry of Sample
number to display

Help <F1> Opens the Help file

Image Next <PgUp> When in Stop mode, go to the next sample

Image Previous <PgDown> When in Stop mode, go to the previous sample

Inclusion Area Adjustment <Shift>+<F8> | Open the Inclusion area dialog window

Live Video <F9> Toggle Live Video image display On or Off

Peak Position <Shift>+<F5> | When in Stop mode, move image crosshair to the
peak intensity location

Profile On <F2> Toggle profile display On or Off

Reference Position On <F4> Toggle reference position On (crosshair location) or
Off (upper left corner)

Reference Profile <F3> Open the Reference Profile dialog window

Start/Stop <F12> Toggle between Start and Stop modes

Statistics On/Off <F6> Toggle display of statistics On or Off

Zoom Level <F8> Zoom in with each key press. The last zoom level
returns to the 1x zoom level.

Test Information <Ctrl>+<I> Test Information dialog

5.10.3 Choose Commands

Like most Windows applications, the BeamView.NET commands may not
always be functional or available in some modes of operation or configura-
tions. Commands that are not available are dimmed in the user interface.

To choose a command or menu item from an open menu list, use one of

the following methods:
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5.11

° Move the cursor with the mouse or arrow keys over the desired
command or item name, and click the left mouse button or Enter key.

° Type the underlined letter (hot key) in the command or item name.
. Type the key equivalent shown to the right of the command or item

name.

If a command function is currently active, a check mark is displayed in
front of the command or item name.

If a command has a sub-menu associated with it, a right arrow mark (“>”)
is displayed after the command or item name.

If the command has a dialog box associated with it, the box is displayed
when the command is selected.

Next Steps

Go to 'Capture Beam Image’ (p. 71) for information about settings for cal-
culations and how to capture a beam image.

70



6.1

6.1.1

Capture Beam Image

Capture Beam Image

There are several methods described in this section to capture a beam im-
age using the BeamView.NET software.

Capturing desired samples is important in measurement instrumentation.
The Capture toolbar section lets users collect a Background Map, identify
the source of the beam image, and define settings (including Trigger op-
tions).

NOTIC

It is recommended that to first collect a Background Map, which
identifies background noise. That noise map is subtracted from all
subsequent beam images before image analysis is performed. See
'Background Map’ (p. 74) for more information.

Image File Formats

The BeamView.NET software currently supports a variety of Graphical for-
mats as well as Image file formats.

Graphic File Formats

Almost any graphics package supports at least one of the following file for-
mats. Some image analysis software imports some of these formats. The
intended use of the image should help determine which format to use.

A BeamView.NET software image file can be imported into almost any
other graphical application.

The graphic file formats are listed in Table 6-1:

Table 6-1. Graphic File Formats

File Extension File Format
.bmp Bitmap Compressed or Uncompressed
Jjpg JPEG, JFIF
.png Portable Network Graphics
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6.1.2

6.1.2.1

6.2

The .jpg format performs compression and is good for image display, but
that format alters the data and is NOT suitable if further image analysis is
needed.

The .bmp and .png formats perform compression and leave the data in-
tact, so they are good for both display and further image analysis. Some
analysis software packages allow direct importation of .bmp formats.

Analysis File Formats

Two file types, Binary and ASCII, store the raw data only. No header infor-
mation is included. The primary purpose for these file formats is to export
for further analysis by other programs, or for later recall and analysis by
the BeamView.NET software.

If the file is being stored for later recall, Coherent strongly recommends
that users also store a BeamView.NET software Test Configuration file un-
der the same name. That way, the capture settings for the image can be
restored before the image is recalled.

The ASCII image file format is the only format guaranteed to preserve the
integrity of every data point in the image, and therefore is best suited
when further analysis is to be performed on an image.

The ASCII format is a comma delimited file, and can be imported directly
into spreadsheets or mathematical software programs.

ASCII Image (*.IMG; I*.*)

In ASCIl image file format, each image pixel value may require up to
5 bytes (one for each digit of the value), plus a comma to separate pixel
values. Each video row in ASCII format must be separated by a carriage
return and line feed. It is possible for an ASCII format file to be four times
larger than a binary format file of the same image.

The advantage of an ASCII format file is that it may be loaded directly into
a word processor or spreadsheet program, whereas a binary file cannot.
When this file type is selected, the file list displays all files that end in .IMG.

Capture a Beam Image

In the Home Tab, the following commands allow users to quickly capture,
analyze, and display of beam image data:

. Start a Capture
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6.2.2

Capture Beam Image

d Stop Capture
. Live Video (real-time display)

. These icons are displayed in color on the toolbar.

@ ™ BeamView. NET

E Home Edit View Capture Analysis Set

Start Stop Live
Capturing | Capturing Video

Figure 6-1. Home > Start and Stop Capturing

Start a Capture

The Start Capturing command switches the BeamView.NET software from
either Stop Capturing mode or Live Video mode to a Start mode. In Start
mode, there is capture, analysis, and display of beam image data.

To choose the Start Capturing command:
. From the Capture toolbar, select the Start Capturing icon.

° When Start is On, a green icon is displayed at the top of the window.

To turn Start Capturing Off, click the Stop Capturing icon. The Beam-
View.NET software then switches to Stop mode.

Stop a Capture

The Stop Capturing command switches the BeamView.NET software from
either Start Capturing mode or Live Video operation to a Stop mode. All
data capture, analysis, and display of beam image data is halted.

To choose the Stop Capturing command:
. From the Capture toolbar, select the Stop Capturing icon.

. When Stop is On, a red icon is displayed at the top of the window.

To turn Stop Capturing Off, click the Start Capturing icon. The Beam-
View.NET software then switches to Start mode.
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6.2.3

6.3

Real-Time Display in Live Video

BeamView.NET offers a feature that is useful when setting up and aligning
the laser and camera. See ’Align the Laser and Camera’ (p. 33) for de-
tails.

The Live Video command switches the BeamView.NET software from
displaying images in Start mode (with overlay graphics and calculations)
to a real-time display in Live Video mode (with no overlay graphics or cal-
culations).

Background Map

The Background Map command collects the noise level of the camera and
creates a background noise map for that particular camera.

This Background Map can be used to perform a pixel-by-pixel intensity
Background Map noise subtraction from all subsequent beam images
captured, depending upon whether the background subtraction mode is
On or Off. Setting a Background Map ensures that calculations are correct
by eliminating fixed-pattern environmental or camera noise and ignoring
bad camera pixels.

Before collecting a Background Map, reduce background noise as much
as possible. See 'Background Noise Is Too High’ (p. 199) for details.

The following options are displayed in the Background Map section of the
Capture toolbar:

A Collect Map: Opens the Collect New Background wizard.

o On: Enables (turns ON) the subtraction of the existing Back-
ground Map.

o Off: Disables (turns OFF) the subtraction of the existing Back-
ground Map.

° Show Map: Displays the Background Map.

° Delete Map: Removes the current Background Map.

NOTIC

Before collecting a Background Map, sources of background noise
must be reduced as much as possible. See ‘Background Noise Is
Too High’ (p. 199) for more information.

This Background Map is used to perform a pixel-by-pixel noise subtraction
from all subsequent beam images captured before image analysis is per-
formed. (Background subtraction mode can be set to On or Off.) The iden-
tified noise is not added into a captured image nor into the calculations.
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The centroid and crosshairs in the image may not track correctly if a Back-
ground Map was not set in advance.

6.3.1 Capture > Collect a Background Map

To collect a Background Map:
1.  Block (cover) the beam at or near the source such that the camera
sensor detects no laser light.

2.  From the Capture toolbar, go to the Background Map section and
select Collect Map.

If there is currently no Background Map for the selected camera, the
message shown in Figure 6-2 is displayed:

Collection Background Map

There is no background map for this camera. Would you like
! to capture one?

Figure 6-2. Capture — No Background Map Message

3.  Click Yes to proceed.

The Collect New Background wizard is displayed, as shown in
Figure 6-3:

£ Collect New Background x

Please block the beam at the source in order to
collect a background noise map, then press
“MNext". Collection may take up to 10 seconds.

[ MNext-> '|| Cancel || Help

Figure 6-3. Capture—Collect a Background Map Wizard
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CAUTION!
If not done so already, first block the laser beam at its source before
work is continued.

4.

Click Next, and the wizard displays the following:

£ Collect New Background x

A Bias removes peak noise, by reducing each
pixel by the specified digital levels. The Bias
determined below may be changed if desired.
The Bias value must be 0 to 1966.

Bias Value: 304 Digital

| Back || Mext -= || Cancel || Help

Figure 6-4. Capture—Background Map Bias Value

Enter a Background Bias Value in the dialog box. The range is from 0
to 1966.

This provides additional digital levels of subtraction to reduce the
effects of random video noise.

The software automatically determines a recommended bias value for
the selected camera, but users can change that value as desired. The
Bias factor depends on the type of LaserCam camera connected to
the system, and varies depending on whether the camera has a 10-
bit output or a 14-bit output.

Click Next, and the dialog box lists the bias factor that was entered.

It is recommended to turn the background warning indicator on. To do
so, click the checkbox to Enable Background Noise Level Monitoring.

The BeamView.NET software continuously monitors the background
noise level during image capture, and issues a warning if that noise
level is significant enough to affect calculation accuracy (see 'Display
a Warning Message’ (p. 200)).

Click Finish, and the Main Window with the crosshair is again
displayed.

The BeamView.NET software acquires a Background Map by capturing
and averaging a set of 16 images.
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Capture Beam Image

£ Collect New Background x
Remove the block from the beam, and press
“Finish" to start using the new background
subtraction map.

Bias factor set to: 504

4

[ Enable Background Noise Level Monitoring

[ Back | [ Finish || Cancel || Help

Figure 6-5. Capture—Complete Background Map

Test the Background Map

To study the effects of the Background Map and Bias level:

1.

Configure the BeamView.NET software to display a contour map:

a.) From the View Menu, select Plot Type command.

b.) Inthe dialog box, select the Contour tab.

c.) Select the Scale to Peak scaling function.

d.) Click OK.

Block the laser beam at the source.

In the Home toolbar, click Start Capturing and monitor the View area.

° If the Background Map and Bias level are set correctly, only a
few randomly scattered points of noise should be seen.

° If more than just a few points of noise are seen, click Stop
Capturing and take a second Background Map. This time,
increase the Bias level by one, then reevaluate the noise in the
View area.

When finished, the BeamView.NET software displays the averaged Back-
ground Map in the View area. All subsequent images captured with Beam-
View.NET now have this Background Map subtracted.

The background subtraction can be disabled or re-enabled. In the Capture
toolbar, select On or Off in the Background Map section.

If no Background Map was previously stored, the background
subtraction remains disabled (Off) and indicates that no map is avail-
able.
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6.4

6.4.1

d If the background subtraction feature is disabled (turned Off) and a
Background Map has been collected, BeamView.NET retains the
Background Map, but does not subtract it from the subsequent
captured images.

Switching the background subtraction On means the BeamView.NET soft-
ware uses the already-stored Background Map and subtract it from subse-
quent images collected. If a new Background Map is collected, it replaces
the previously-stored Background Map. An updated map can be collected
at any time it seems that the background level has changed.

When changing resolutions or cameras, the BeamView.NET software re-
quires capture of a new Background Map.

Capture > Capture/Trigger

The BeamView.NET software provides a number of features and options
to control the timing of sample capture for both CW (Continuous Wave)
and Pulsed laser applications. See details about these settings in '"Capture
Tab’ (p. 61).

Capture/Trigger: Source

When users select Capture/Trigger in the Capture Settings section, the
following dialog box is displayed:

Trigger Settings n
Source

OCW () Pulsed
External

Capture

Continuously “

| Ck || Cancel || Help

Figure 6-6. Capture Trigger: Source in Status Bar

The following Capture modes are available, with a radio button to select
either CW or Pulsed mode.
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6.4.1.2

6.4.1.3

Capture Beam Image

CW (Continuous Wave)

The CW (Continuous Wave) button switches the software from Pulsed
source capture to CW source capture mode.

4 To choose the CW mode, choose the radio button for CW button.

d To turn CW mode Off, choose the radio button for Pulsed.

Pulsed

The Pulsed button switches the BeamView.NET software from CW (Con-
tinuous Wave) source capture to Pulsed source capture mode.

d To choose Pulsed mode, choose the radio button for Pulsed.

d To turn Pulsed mode Off, choose the CW button.

Capture/Trigger: Edge

If the source selected is Pulsed, the dialog box displays additional selec-
tions to select Rising or Falling Edge and enter a Trigger Delay:

Trigger Settings n
Source Edge
O cw ® Rising ) Falling

Trigger Trigger Delay (sec)

External “ 0.000
Capture

Continuously “

| Ck | | Cancel | | Help

Figure 6-7. Capture > Capture/Trigger Pulsed Settings

1.  Select either a Rising or Falling Edge.
2. Enter a Trigger Delay (in seconds).
Click OK.
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6.4.1.4

6.4.1.5

6.4.1.5.1

6.4.1.5.2

Capture/Trigger: Trigger Option

From the drop-down menu, select a Trigger option:
. External

° Auto Trigger

NOTIC

Trigger selection is ONLY active for Pulsed mode operation.
No trigger signal is required in CW (Continuous Wave) operation, so
the Trigger drop-down menu is not available for CW.

Capture/Trigger: Capture Timing

From the drop-down menu, select an option from the Capture drop-down
menu. Click OK when finished.

Continuously

Beamview.NET continuously captures beam images in a repetitive pro-
cess until the user intervenes by selecting the Stop function, or the image
storage count is achieved.

The speed of capture depends on the computer being used, image cap-
ture resolution, number and type of calculations being done, and whether
calculations are being done after each image capture or after all specified
images have been captured.

On Time Interval of

Beamview.NET continuously captures beam images only after a user-
specified time interval has passed. The units for this time interval setting
can be adjusted by selecting the Analysis menu and the Units menu item.

This process repeats until the user intervenes by selecting the Stop func-
tion, or the image storage count is achieved.

When this option is selected, the dialog box displays a field for “Interval” -
enter a user-defined value in seconds.
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6.4.2

6.4.2.1

Capture Beam Image

On Key Press

Beamview.NETcaptures beam images only after the <Enter> or <Space-
bar> keyboard keys have been pressed, or the OK button in the Capture
Image dialog box is selected.

This process repeats until the user intervenes by selecting the Cancel
function in the Capture Image dialog box with the mouse, or the image
storage count is achieved.

Capture with Trigger (Pulsed Mode)

To capture samples, a trigger signal is often used. This signal tells other
devices to either generate or capture data at a specific time.

Most camera types have a small period of vulnerability, between one im-
age and the next, where the incident light on the camera detector is not
being recorded or is otherwise invalid (analogous to a camera shutter be-
ing closed).

. For CW (Continuous Wave) systems, this period is not important.

° For Pulsed laser systems, the laser pulses must either not be gener-
ated during the period of vulnerability, or the image generated during
the vulnerable period must be disregarded.

The triggering configuration used is especially important in Pulsed laser
applications where these signals are used to fire and/or detect the output
laser pulse.

NOTIC

Trigger selection is ONLY active for Pulsed mode operation.

This section describes how to select a trigger to capture beam informa-
tion. See 'Connect a Camera Using an External Trigger’ (p. 24) for instruc-
tions about set up and connecting a cable specific to the trigger function.

Triggering Methods

To take Pulsed measurements using the LaserCam, the camera and soft-
ware offer two triggering methods that can be used to capture images.

L External

° Auto Trigger
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6.4.2.2

The Auto Trigger and Trigger Delay features do not work well for capturing
single-pulse lasers. In the case of a single pulse laser, the timing between
the trigger signal and the laser firing needs to be adjusted to allow the
camera to capture the first pulse while still accounting for the 150 us de-
lay in the camera. Often a pulse generator or signal delay box can be
used to help set this up.

External Trigger Mode

External Trigger mode allows the camera to synchronize its capture period
to the pulses being fired by the laser.

The software sends a voltage signal (typically a TTL pulse from the
laser) to the camera to synchronize its capture period to the timing of
the laser.

In External Trigger mode, the software disregards input trigger signals
that occur during the period of vulnerability.

To access the Trigger Delay feature:

1 Go to the ‘Capture > Capture/Trigger’ menu.

2. Select the radio button for Pulsed.

3.  Select the radio button for a Rising or Falling Edge.

4 Under Trigger, Select ‘External’ from the drop-down menu. The dialog
boxes changes to display a box where users enter a value for the
delay.

Trigger Settings n
Source Edge
O cw ® Pulsed ® Rising ) Falling

Trigger Trigger Delay (sec)

External - 0,000
Capture

Continuously “

| Ck | | Cancel | | Help

Figure 6-8. Capture — Set Trigger Delay
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Capture Beam Image

5.  Enter the delay value in microseconds. This is the time from the hard-
ware trigger until exposure begins. The allowable range is 0 to
100,000,000 (one hundred seconds).

The LaserCam external trigger circuit has a variable delay that is set via
the Trigger Settings Dialog. This is something that is inherent to the cam-
era and there is no way the delay can be shortened through the camera
set-up.

For this camera to operate correctly with an external trigger, the trigger
signal needs to occur at least 150 us before the laser pulse hits the cam-
era. The LaserCam has a 10 ms integration time, which means the cam-
era is ‘open’ to capturing pulses for 10 ms after the trigger delay.

As long as the trigger delay of 150 us has passed, the pulse can hit the
camera anytime within the next 10 ms and be captured correcily.

Figure 6-9 shows a timeline for the trigger period.

pulse image can be captured
< any time in this period >
________ 150 ps delay >l 10 ms capture period ). ceneeee time
A A
trigger signal LaserCam-HR LaserCam
takes place begins capture ends capture
here period period
Figure 6-9. Capture — Trigger Delay Timeline
A 150 us delay can be an issue with some laser systems. On many lasers,
the trigger signal and laser pulse may not match up with a 150 us delay.
6.4.2.3 Trigger Set-Up Example

For example, if a user has a laser that triggers only 50 us before the pulse
fires, the LaserCam triggers but does not capture any images. That is be-
cause the laser is firing during the 150 us delay, so nothing is captured by
the camera.

In this situation, the user must add some delay, either into the trigger sig-
nal or into the actual firing of the laser. If, for example, a 200 us delay is
added to the time between the trigger signal and the laser firing, it should
work correctly.
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6.4.2.4

This can often be done through external delay boxes or signal genera-
tors. If the LaserCam is being used in Pulsed mode and is capturing only
blank images, trigger timing may be the problem.

The BeamView.NET software added a feature that helps in cases where
the trigger delay is causing issues, called the ‘Trigger Delay’ setting. This
feature uses the first trigger signal to capture the second laser pulse.

The Trigger Delay feature may be useful in cases such as described here,
where the laser is firing only 50 us after the trigger signal is sent to the
camera. Due to the 150 us delay, this usually results in the camera not
capturing anything. If, however, a longer than normal delay is added be-
tween the trigger signal and the second pulse, the camera does capture a
second pulse while triggering on the first trigger signal.

A user has a pulsed 10 Hz laser with an external trigger that sends a trig-
ger signal about 50 us before the laser fires a pulse. If hooked up directly
to the external trigger connection on a LaserCam camera, this results in
the camera triggering but not capturing any images because the laser
pulse is firing during the 150 us delay period.

If the time between the trigger and the laser pulse cannot be adjusted on
the laser, the trigger delay on the camera can be lengthened to correctly
help capture the pulse.

In this example, one possible solution is to set up a lengthy delay between
the trigger signal and the second laser pulse. Because the camera has a
10 ms integration time and the laser is firing one pulse every 100 ms (1/
10 Hz), a user could set a trigger delay of 95 ms in the BeamView.NET
software. With a 95 ms setting, the laser sends a trigger signal and then,
50 us later, the laser fires.

The result is that the first pulse is ignored and 95 ms passes before the
camera starts its integration time. The laser then triggers again, fires an-
other pulse, and the camera catches this second pulse. This second pulse
is taking place approximately 5 ms into the 10 ms integration time and is
captured correctly.

Set a Trigger Delay

The amount of delay can typically be determined by using an interval
slightly shorter than the time between laser pulses. For a 10 Hz laser
(100 ms between pulses), a 95 ms delay could be used. For a 50 Hz la-
ser (20 ms between pulses), a 15 ms delay could be used. This sets
enough delay for the camera to start its integration period before the next
pulse is fired.

The 10 ms capture time on the LaserCam also sets the camera's maxi-
mum rep rate that can be used for pulsed measurements. For a 10 ms
capture window, the inverse is 100 Hz.
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This means the camera can have up to 100 of these 10 ms capture peri-
ods per second and, therefore, can capture single-pulse images for rep
rates up to 100 Hz.

This does not mean the software captures images at 100 Hz. The update
rate of the software is still limited to approximately 10 to 20 Hz, depend-
ing on the computer speed and the resolution being used.

However, the camera can capture pulses at up to 100 Hz without getting
multiple pulses into the same image. At 200 Hz, the camera picks up two
pulses in each capture period, which does not give an accurate image of
each pulse. This 10 ms capture period limits the camera to rep rates of
100 Hz while capturing only single pulses in each image. If working at rep
rates above 100 Hz, the camera can be put into CW mode, which should
capture correctly.

Auto Trigger Mode

The Auto Trigger mode is a simple setting to capture pulses that does not
require any trigger signals or need to synchronize the camera to the laser.
Therefore, it is often used for set-up and alignment.

The software uses a set intensity threshold to determine if it captures
or discards a pulsed image.

Auto Trigger is similar to the trigger used in oscilloscopes. Image
capture occurs when the intensity level on any pixel in the video
image is greater than a user-defined level.

Using this trigger method captures video images that have a pixel intensity
above a user-defined level. Note that % response refers to a percentage
level from 0 to 100 percent of the maximum intensity.

To select Auto Trigger:
1. Go to the Capture tab, select Capture/Trigger from the Capture
Settings area in the toolbar, and the following dialog box is displayed:
2.  Select the radio button for Pulsed.
Select the radio button for a Rising or Falling Edge.

Under Trigger, Select 'Auto Trigger’ from the drop-down menu. The
dialog boxes changes to display a Qualifying Level:

This feature allows the user to define a pixel intensity threshold that
BeamView.NET uses to determine whether to capture an image or discard
it. If a laser pulse hits the camera and causes a certain number of pixels to
exceed the set intensity level, that image is captured and saved into the
BeamView.NET software.

Auto Trigger is suggested for first time set-up if the repetition rate is great-
er than approximately 10 Hz. After some images are captured, using more
advanced triggering methods can improve capture performance.
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6.5

@ Trigger Settings W
Source Edge
O cw ® Pulsed ® Rising ) Falling
Trigger Cuualify Level
Eﬁlutc Trigger “ 153 % resp.
Capture
Continuously “
| Ck | | Cancel | | Help

Figure 6-10. Capture — Select Auto Trigger

. Note that % response (Qualify Level box) refers to a percentage level
from 0 to 100 percent of the maximum intensity.

° The intensity threshold level can be adjusted to any value between 0
and 100% to qualify whether an image is kept or not. Start with an
intensity value of approximately 50%.

It is recommended to not use the Auto Trigger mode of capture for Pulsed
laser sources below 10 to 20 Hz.

One drawback to the auto-trigger method is that not all pulses reaching
the camera are captured. Due to the timing of the capture period on the
LaserCam-HR camera, it is not possible for the camera to capture every
pulse when working in auto-trigger mode.

Generally, this is not an issue when collecting pulses from a laser Start
running at rep rates higher than 10 Hz or so. At those rates, the camera
collects images on a fairly regular interval and runs at a good rate.

Below 10 Hz, BeamView.NET seems to run slower because of the low rep
rate and the camera’s inability to capture every pulse. For lasers running
at rep rates lower than 10 Hz (especially for single-pulse applications), it is
recommended to use the External Trigger mode.

Capture > Resolution

To choose the Resolution command:

1.  Select the Capture menu.

2.  From the toolbar select Resolution, and the following dialog box is
displayed:
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Capture Beam Image

@ Image Sample Resclution x
Sub-sampling
Resolution and Depth

1280 x 1024 x 10~

Mormal speed capture .
P P Every pixel captured

(] Invert ¥ Axis

| Ok || Cancel || Help |

Figure 6-11. Capture > Resolution Command

The drop-down menu lists options, and the selection changes depending
on which camera model is used:

. 1280 x 1024 x 16
o 640 x 512 x 16

d 650 x 512 x 8

The grid on the right side of the dialog box changes to reflect the settings,
as shown in this example:

@ Image Sample Reselution x
Sub-sampling
Resoclution and Depth

60 x 512 x10 |

Higher speed capture Alternate pixels capture:

(] Invert ¥ Axis

| oK || Cancel || Help

Figure 6-12. Capture > Change in Resolution
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6.6 Capture > Buffer

The Buffer command in the Capture toolbar provides configuration of the
size and actions of the sample buffer. There are a variety of settings in this
dialog that interact with each other. Each sample captured and stored to
the sample buffer contains the calculated results for that sample.

To choose the Buffer command:

1.  Select the Capture menu.

2. From the Capture Settings section of the toolbar, select Buffer. The
following dialog box is displayed:

@ Capture Buffer -
Size
Maximum number of samples to capture:
235 1 2500
Capture continucusly over old images

Do Calculations | After Capturing EACH Sample =

| Ck || Cancel || Help

Figure 6-13. Capture — Buffer

Enter a value for the maximum number of samples to capture.

Click the checkbox if the capture should continuously replace the old
images.

5. In the section for Do Calculations, select an option from the
drop-down menu:

° After Capturing EACH Sample
° After Capturing ALL Samples
6. Click OK to finish the settings.

6.6.1 Buffer Size

This function provides selection of the maximum number of results to be
stored to the Sample Buffer.
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The maximum sample capacity is dependent on the amount of computer
memory available and the selected image resolution, but typically allows
up to 2500 samples in the buffer.

NOTIC

Insufficient disk space can lead to errors, causing the software to
terminate.

Do Calculations

The Do Calculations function provides control over when the beam imag-
es are analyzed after being captured.

Two modes are provided for doing image calculations relative to their cap-
ture:

° After Capturing EACH Sample

Selecting After Capturing EACH Sample, configures the Beam-
View.NET software to perform image analysis and display immedi-
ately after each beam image is captured.

. After Capturing ALL Samples

This mode configures the BeamView.NET software to capture the
number of beam images specified to the image buffer without analysis
or display between captured images. In this mode, the Beam-
View.NET software captures all images first, and then analyzes and
displays the results for each one.

This mode provides image capture at high rates because calculations
and display are not done between each captured image. Because of
this, this method of image capture has been called “Burst Mode”. To
restart BURST MODE, select the Start command after the specified
number of beam images are captured.

Setting ‘Capture continuously over old samples’ is not valid when “Do Cal-
culations” is set to “After Capturing ALL Samples”.

NOTIC

Doing Calculations after all samples is incompatible with the Pass/
Fail fault actions because the analyzed results are not available
between samples. While in BURST MODE, the BeamView.NET
ignores all Pass/Fail fault actions (except the Background Color
option).
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6.7

6.8

Capture > Exposure Time Settings

In the section for Exposure Time, enter a value in uS. Exposure time must
be greater than or equal to (68) uS.

Exposure Time (pS): | 10000

Min Max
14.4%

Figure 6-14. Capture — Exposure Time

Next Steps

Now that images have been captured, go to 'Analyze Calculations’ (p. 91)
to view and analyze results.
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Analyze Calculations

Analyze Calculations

The BeamView.NET software can easily be configured to capture and dis-
play the information required for a particular application, then perform cal-
culations for the beam image.

In the Calculations area, there are two commands available:
i Calculations

d Fault Actions

Summary of Calculations

Following are features to consider when setting up calculations in the
BeamView.NET software. Click the check boxes to turn calculations on or
off.

Table 7-1 lists the calculations that are available for each type of analysis,
with a brief description of each:

Table 7-1. Summary of Calculations

Calculation

Description

General Calculations

Peak (X,Y)R

Beam peak intensity position

Centroid (X,Y)R

Beam centroid position

Peak % Response

Peak intensity of beam as a % response of the camera

Total Relative Power/Energy

Total relative power or energy in beam

Effective Area

Effective area of the laser beam

Peak Power Density

Peak power/energy density of beam

Effective Diameter (%Int)

Effective beam diameter at selected intensity level

Aperture Diameter
(Y%Power/Energy)

Beam diameter with selected % of total power/energy

d4 Sigma Widths

Beam widths based on second moments

d4 Sigma Diameter

Beam diameter based on second moment
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Table 7-1. Summary of Calculations (Continued)

Calculation

Description

Divergence

Far field beam divergence at selected % of total power/energy

Knife Edge Widths

Beam widths based on moving knife edge (image profiles)

Slit Diameters

Beam diameters based on moving slit

Peak to Average

Peak-to-average intensity of beam

Ellipticity Ellipticity of beam at selected intensity level
Major, Minor Major and minor axes diameter of ellipse
Angle Angular orientation of major ellipse axis
Circularity Angular orientation of major ellipse axis

Gaussian Fit

Least squares Gaussian fit of cross-section beam profiles

Coefficient

Fit correlation (normalized residuals)

Centroid

Center location of Gaussian fit

Peak Intensity

Peak intensity of Gaussian fit

Diameter

Beam diameter of Gaussian fit

Roughness

Roughness of Gaussian fit

Aperture Uniformity

Statistical analysis of beam intensity uniformity within an aper-
ture

Minimum, Mean, Maximum

Minimum, mean, maximum beam intensity within the aperture

Sigma, RMS

Sigma (standard deviation) and RMS

% Power/Energy in Aperture

% of total power/energy in selected aperture

Image Uniformity

Statistical calculations of the uniformity of the beam intensity
on the
captured beam image across the sensor's active area

Minimum, Mean, Maximum

The Uniformity calculates the minimum, mean (average), and
maximum
of the pixel intensities across the sensor's active area.

Flat Top Fit

Beam Uniformity

Normalized RMS deviation of the power (energy) density.
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Table 7-1. Summary of Calculations (Continued)

Calculation Description

Plateau Uniformity Ratio of the full width half maximum to the maximum of the
histogram of pixel intensities for all pixels in the active region
above the intensity threshold.

Flatness Factor Ratio of the average power (energy) density to the maximum
or peak
power (energy) density.

Edge Steepness Normalized difference between two Effective Irradiation areas
with intensity levels above 10% and 90% of maximum inten-
sity.

Effective Irradiation Area Area of the beam which exceeds the user-defined threshold.

Effective Average Power | Average power (energy) density of the portion of the beam
(Energy) Density exceeding the user-defined threshold.

7.1.1 Settings for Calculations

When users select Calculations, a dialog box is displayed for the selected
calculation.

. The panel on the left shows which calculations are currently enabled
(turned On) for beam analysis and display. These list a check mark to
the left of the name of the calculation.

° The panel on the right side of the window changes to display a dialog
box with settings and controls unique to the selected calculation.

The dialog box for each calculation includes the following common fields.
Any additional fields unique to each calculation are displayed in the dialog
boxes.

° Check Box: The check box enables or disables the selected calcula-
tion. If no x appears, the selection is not calculated nor displayed.

. Format: Indicates the format of the analysis result value to be
displayed in the Results Area (total number of digits and number of
significant digits). The (X,Y)R format means:

° X is the X axis position relative to the coordinate origin.
° Y is the Y axis position relative to the coordinate origin.

° R is the direct radial distance from the (X,Y) coordinate to the
coordinate origin.
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i Units:

° Indicates the units to be displayed with the analysis results in the
Results Area.

A If the box is disabled, the units for this calculation match the
global Units selected from the Units command.

d Pass/Fail Test Settings: This function provides selection of parame-
ters to be used to perform a Pass/Fail test on the analysis result to
check whether it falls inside (Pass) or outside (Fail) of the settings
range. The following functions are provided:

4 Perform Pass/Fail Checking: If x is selected, the Pass/Fail test
is performed for every captured and analyzed beam image. If no
X appears, no testing is performed.

° Range: The minimum and maximum values for the test range.
o Center: The X and Y axis position of the test range Center.

L Maximum Radius from Center: The maximum radial distance
range from the test Center.

° Fault Actions: This button provides access to the Fault Actions
command to select actions to be taken if the results should fail the
selected tests. Click the Fault Actions button at the bottom of the dialog
box to display settings (see 'Fault Actions’ (p. 135) for more informa-
tion).

To turn calculations on or off within the BeamView.NET software, double-
click anywhere in the calculations portion of the software screen to dis-
play a menu of available calculations. The list of available calculations de-
pends on the type of application this system is being used for and the
measurements that are wanted.

If the following symbol is displayed in the dialog box, then the calculation
is compatible with the proposed International Standards Organization
(ISO) standards for laser beam measurements:

5:&@___
=0

150

I
=

Figure 7-1. 1SO Symbol
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1.2

Analyze Calculations

Categories of Calculations

The categories of calculations commonly used in the BeamView.NET soft-
ware include:

* General

d Ellipticity

° Gaussian Fit

d Aperture Uniformity
. Image Uniformity

° Flat Top

Each of these categories are more fully described in the sections that fol-
low.

General Calculations

The following options with their units of measurement and associated dia-
log boxes are available under the General settings:

d Peak (X,Y)R [mm]

° Centroid (X,Y)R [mm]

. Peak % Resp. [%]

° Total Relative Energy [mJ]

° Effective Area [mm2]

*  Fluence [Jicm?]

d Effective Diameter 86.5% [mm]
° Aperture Diameter 86.5% [mm]
. d4 Sigma Width [mm]

d d4 Sigma Diam. [mm]

° Divergence 86.5% [mrad]
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7.2.1

o Knife Edge 84.0$% [mm]

. Slit Diameter 868.5% [mm]

. Peak to Average

General Calculations > Peak (X,Y)R

The beam peak intensity location is found by searching all the pixels in a
sample for the maximum digital intensity level. The location of the pixel

with maximum intensity is the peak location.

It is possible that more than one pixel is at the maximum intensity signal.
In this case, the peak location is the peak intensity pixel which is found
first. The search is conducted by scanning the image from left to right, top

to bottom.

The Peak (X,Y)R calculation provides the position of the Peak intensity in

the captured beam image as defined in the peak location algorithm.

The settings are defined in the following dialog box.

Calculations
Ayailable Caloulations

@ General

W] Centroid (X.YIR
Peak % Resp.
Total Rel Power
Eff. Area
Pk Pwr Density
Eff. Diameter
Aper. Diameter
dd Sigma Width
d4 Sigma Diam
Divergence
Knife Edge
Stir Diameter
Peak To Avg.
() Euipticity

| Major, Miner
/| Angle

R R R AR EE R R

| Circularity
(~) Gaussian Fit
IFl  Crefficient

¥ peak (X,Y)R

Format

ViR

Units

mm

Pazs/Fail

7
(=}

L

[ Perform Pass/Fail checking
Center 0.000 0.000

Maximum Radius from Center 0.000

mm

mm

oK | [ Cancel

| | Fault Actions | |

Help

Figure 7-2. General Calculations > Peak (X,Y)R Settings
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General Calculations > Centroid (X,Y)R

The Centroid calculation shows where the weighted center of the beam is
located. This calculation corresponds with the center of the crosshairs in
the main window. This Centroid measurement is typically tracked to deter-
mine if the beam is moving.

The Centroid (X,Y)R calculation provides the position of the Centroid in-
tensity in the captured beam image, as defined in the Beam Centroid Lo-
cation algorithm.

The location of the centroid of power or energy of a beam is determined
by summing the intensities of all image pixels in both X and Y axes, and
computing the “center of mass” of the power or energy. The pixel coordi-
nates of this location define the beam centroid. The X and Y location of
the centroid are computed using the following formula:

X =SUM[x * p(x,y)//I
Y =SUM[y * p(x,y)l/l
where:
° p(x,y) = intensity at location (x,y)
° | = total intensity
o SUM taken over total area.

Because the beam centroid involves summing over the entire sample ar-
ea, a large area of pixels with a small amount of background illumination
signal can have a larger effect on the centroid location than a small area
of relatively bright pixels.

NOTIC

For this reason, it is important that steps be taken to reduce the
background noise level. Use the Background Subtraction feature to
ensure the most accurate calculation (see p. 74).

Click the checkbox in the left column for the calculation that is wanted to
use to display settings in the following dialog box.
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7.2.3

L
Centroid (X,Y)R 1SO
=
Format
Units
cm =
Pass/Fail
[ Perform Pass/Fail checking
Center 0.2760 0.3240 m
Maximum Radius from Center 0.1130 cm
| 0K | | Cancel | | Fault Actions | | Help |

Figure 7-3. General Calculations > Centroid (X,Y)R Settings

General Calculations > Peak % Response

The Peak % Response calculation is one of the most important calcula-
tions to use when setting up BeamView.NET because it shows how close
users are to saturating the camera.

. Basically, 100% is the saturation level of the camera and, at that level,
it may be clipping part of the beam profile.

° Conversely, a response level set too low means that the full dynamic
range of the camera is not being used.

A general recommendation is to try getting the Peak % Response setting
in the 85% to 95% range. A setting above 95% risks saturating the cam-
era and a setting below 85% may miss out on some of the dynamic range
of the camera.

To reach the 85 to 95% range, adjust the attenuation in front of the cam-
era by using something like a C-VARM. A C-VARM has some fine adjust-
ments that allow users to tweak the attenuation until it falls within the
appropriate range.

Using this Peak % Response calculation is a good way to track camera
saturation. This is also a good way to help monitor if the beam is increas-
ing or decreasing in intensity over time.

The Peak % Resp. calculation provides the beam peak intensity in terms
of a percentage (%) of peak camera response, as defined in the Peak
Camera Response algorithm.

Click the checkbox in the left column for the calculation needed to use to
display settings in the following dialog box.
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Peak % Resp.

Format

Units
%

Pass/Fail
[] Perform Pass/Fail checking

0.3 204

&

Range

| OK | | Cancel | | Fault Actions | | Help |

Figure 7-4. General Calculations > Peak % Response

General Calculations > Total Relative Energy

The Total Relative Power/Energy calculation provides the total integrated
power or energy in the captured beam image, as defined in the Power and
Energy algorithm.

d Total power is calculated for CW beams.

° Total energy is calculated for pulsed beams.

Before taking a measurement, the user should use the Calibrate Relative
Power/Energy command; see 'Setup > Calibrate Power’ (p. 63).

The Calibrate Relative Power/Energy command provides entry of a pow-
er/energy value as a “base” power/energy level. The power /energy calcu-
lation sets the total summed intensity of all pixels in the next sample
captured to this value.

The method for calculating the Total Power (CW) or Total Energy (Pulsed)
of the beam uses an intensity summation of all pixels in the captured im-
age. The power or energy summation is calibrated by measuring the
beam using an energy or power meter. The meter reading is then entered
into the Relative Power/Energy command in the Set-Up menu.

After the externally-measured power or energy level is entered, the Beam-
View.NET software stores this value and the total summed intensity for
that image. This information is then used as a reference for the power/en-
ergy measurement of all the subsequent samples.

Click the checkbox in the left column for the calculation needed to use to
display settings in the following dialog box.
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SRS
Total Rel. Power 150
Format .
ddd.ddd
Units
KW u

Pass/Fail
[ Perform Pass/Fail checking

Range 0.000 0.000 KW

| QK | | Cancel | | Fault Actions | | Help |

Figure 7-5. General Calculations > Total Relative Energy

7.2.5 General Calculations > Effective Area

The Eff. Area calculation provides the effective area of the captured beam,
as defined in the Effective Area algorithm.

Click the checkbox in the left column for the calculation needed to use to
display settings in the following dialog box.

Eff. Area

Format
ddd.ddd

Units

z et

pm

Pass/Fail
] Perform Pass/Fail checking

Range 0.0 0.0 pm®

| QK | | Cancel | | Fault Actions | | Help

Figure 7-6. General Calculations > Effective Area

The Effective Area of a beam is calculated by dividing the total power or
energy, as follows:

EffArea = TotalEnergy / PeakFluence
or
EffArea = TotalPower / PeakDensity
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The Effective Area of a beam represents the area of an ideal flat top beam
having the same peak intensity and total energy of the measured beam.

General Calculations > Peak Power Density

The Pk. Pwr Density calculation provides the peak power or energy densi-
ty (Fluence) of the captured beam, as defined in the Peak Power/Energy
Density algorithm.

The peak power or energy density (or peak fluence for pulsed laser appli-
cations) is the power density at the pixel with the greatest intensity in the
beam image.

Click the checkbox in the left column for the calculation needed to use to
display settings in the following dialog box:

Pk Pwr Density 'I’”E‘\E
Format ]
Units
W/cm® =

Pass/Fail
[ Perform Pass/Fail checking

Range 0.000 0.000 chm:

| QK | | Cancel | | Fault Actions | | Help

Figure 7-7. General Calculations > Fluence

The peak intensity of the captured beam image and the physical area of a
single camera pixel are used to calculate the Peak Power/Energy Density
(Fluence) at the beam peak intensity pixel location.

This measurement is calibrated with the Setup > Calibrate Relative Pow-
er/Energy command using a reading from an external energy or power
meter; see 'Setup > Calibrate Power’ (p. 63).

By summing the total digitized intensities over the beam image, the value
of energy or power per pixel digital level can be determined. Multiplying
this value by the peak pixel intensity yields the total energy or power on
the peak pixel. Dividing by the area of the pixel (in cm2) yields the Peak
Power Density or Peak Energy Density (Fluence).
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7.2.7

General Calculations > Effective Diameter

The Eff. Diameter (%Int) calculation provides the effective beam diameter
of the captured beam image, as defined in the Effective Beam Diameter
algorithm.

Effective Beam Diameter calculates the diameter of a circle with an area
equal to the area of all pixels with intensity above a (user-defined) per-
cent of the measured beam peak intensity.

This intensity level is set in the Eff. Diameter calculation dialog box, and is
given as a percentage of the beam peak. The actual level is considered as
X% down from the peak response, where X is the user-defined level. For
example, if 70% is selected, then the beam diameter is the result of all pix-
el intensities above 30% of the peak response (70% down from the peak).
The effective beam diameter is calculated by the method shown as fol-
lows.

1.  The intensity level from the user-defined percentage level is deter-
mined. For example, to determine the effective beam diameter at the
60% level of a beam that has a peak intensity of 800 (on a scale of 0
to 1023 (10 - bit)), the intensity level is calculated as follows:

Intensity = Peak Intensity — (Peak Intensity * Percentage Level)
In this example, this yields:
Intensity = 800 — (800 * 60) = 320

2. Thetotal area (Apixels) of all pixels that have an intensity greater than
the defined level is calculated. This is done by counting the number of
pixels with intensity of 320 or more (for this example) and multiplying
by the area of a single pixel. The effective beam diameter (Deff) is
calculated from this area using the formula for the area of a circle.

Deff = SQRT(4*Apixels)/SQRT (pi)

The BeamView.NET software calculates the Effective Beam Diameter
based on the area of the pixels with an intensity above the user-selected
percentage of beam peak intensity. If there are pixels from beam wing
structure or satellite images on the camera array with intensities above the
selected intensity, they are added to the main beam area and yield a larg-
er beam diameter than expected.

Click the checkbox in the left column for the calculation needed to use to
display settings in the following dialog box:
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Eff. Diameter

Format % Peak

86.5 % Peak
Units
mm ~ [] Use Fluence

Pass/Fail
[ Perform Pass/Fail checking

2.000 3.000 mm

Range

| QoK | | Cancel | | Fault Actions | | Help |

Figure 7-8. General Calculations > Effective Diameter

Calculation Settings

In addition to common fields, the following parameters define settings for
the Effective Diameter calculation:

° % Peak: Provides selection of the user defined percentage (%) of
Peak intensity level. All beam image pixels above this level will be
included in the Beam Diameter calculation.

General Calculations > Aperture Diameter

The Aper. Diameter (%Power/Energy) calculation provides the diameter of
the captured beam image containing a specified % of total power or ener-

gy.

This command calculates the diameter of a circular aperture that would
enclose (encircle) a specified percentage of the total beam power/energy.
This percent power/energy level is set in the Aper. Diameter (%Power/En-
ergy) calculation dialog box.

As defined in the Aperture Diameter algorithm, the BeamView.NET soft-
ware performs this calculation by summing the intensities of all pixels con-
tained within a circular aperture of a certain diameter, centered at the
beam centroid location.

The percentage of the total power/energy contained in that area is then
calculated. If the resultant power or energy is not equal to the user-defined
percentage of the total beam power or energy, the diameter of the artifi-
cial aperture is adjusted and the summation calculation is repeated.
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7.2.9

This measurement is often called the “energy-in-the-bucket,” “encircled
energy,” or “D86” diameter (if 86.5% of the total power/energy is speci-
fied).

NOTIC

It is important that steps be taken to reduce the background noise
level. Use the Background Subtraction feature to make sure that the
most accurate calculation (see p. 74) is used.

Click the checkbox in the left column for the calculation needed to use to
display settings in the following dialog box:

Aper. Diameter —fé‘\a
Farmat Sampr—
Units

Pass/Fail

[ Perform Pass/Fail checking
Range 0.000 0.000 mm

| QK | | Cancel | | Fault Actions | | Help |

Figure 7-9. General Calculations > Aperture Diameter

In addition to common fields, the following parameters define settings for
the Aperture Diameter calculation:

% Power/Energy: Provides specification of the % of Total Power or
Energy to be used in the Diameter calculation.

General Calculations > d4 Sigma Width

The d4 Sigma Width calculation provides the X and Y axes widths of the
captured beam image, as defined in the d4 Sigma Width Measurement al-
gorithm.

The d4 Sigma Widths are the widths in the X and Y axes, based on the
second moments of the power (energy) distribution of the beam.

The widths are derived by summing the square of the distance from each
point of the image to the centroid, multiplied by the intensity at that point.
The entire summation is then divided by the total power (energy) of the
beam, and the square root of that value is multiplied by 4.
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d4o x =4 * SQRT(SUM [(x - xc)2 * p(x,y)] / )
dd4oy=4*SQRT(SUM [(y - yc)2 * p(x,y)] / )

where:
o xc and yc are the coordinates of the image centroid
° p(x,y) is the intensity at location (x,y)
° | is the total intensity of the image

° SUM is taken over the total image area

NOTIC

Because the d4 Sigma Width measurement uses the square of the
distance from the centroid, background noise can have a significant
impact on the calculation. Therefore, it is important to use the Back-
ground Subtraction feature with this measurement (see p. 74).

Click the checkbox in the left column for the calculation needed to use to
display settings in the following dialog box:

d4 Sigma Width 1?5
Format Eaefer
Idd.dk
Units

Pass/Fail

[ Perform Pass/Fail checking
Horiz. 2.000 3.000 o
Vert. 2.000 3.000 o

| QoK | | Cancel | | Fault Actions | | Help |

Figure 7-10. General Calculations > d4 Sigma Width

General Calculations > d4 Sigma Diameter

The d4 Sigma Diameter calculation provides the diameter of the captured
beam image, as defined in the d4 Sigma Width algorithm. This calculates
the beam diameter, based on the second moments of the power (energy)
distribution of the beam.
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The diameter is derived by summing the square of the distance from each
point of the image to the centroid, multiplied by the intensity at that point.
The entire summation is then divided by the total power (energy) of the
beam, and the square root of that value is multiplied by 2 times sqrt(2).

d4o=2"* SQRT(2 * SUM [((x - xc)2 + (y - y¢)2) * p(x,y)]/ 1)
where:

° xc and yc are the coordinates of the image centroid

o p(x,y) is the intensity at location (x,y)

° | is the total intensity of the image

° SUM is taken over the total image area

NOTIC

Because the d4 Sigma Diameter measurement uses the square of the
distance from the centroid, background noise can have a significant
impact on the calculation. Therefore, it is important to use the Back-
ground Subtraction feature with this measurement (see p. 74).

Click the checkbox in the left column for the calculation needed to use to
display settings in the following dialog box:

d4 Sigma Diam _@6
Format S
UnI‘S ........................................
Pass/Fail
] Perform Pass/Fail checking
Range 2,000 3.000 mm
| QK | | Cancel | | Fault Actions | | Help |

Figure 7-11. General Calculations > d4 Sigma Diameter

7.2.11 General Calculations > Divergence

The Divergence calculation provides the far field divergence of the cap-
tured beam image, as defined in the Divergence Measurement algorithm.
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CAUTION!

Because the Divergence measurement depends on a percentage of
power/energy passing through an aperture, it is extremely sensitive
to background light on the camera. Therefore, it is important to use
the Background Subtraction feature with this measurement (see
p. 74).

The Far Field Beam Divergence is measured by determining the angular
spot size of the beam in the far field of a focusing lens or mirror that con-
tains the user-defined percent of total power/energy.

To measure divergence correctly with the BeamView.NET software, a lens
or mirror with known focal length must be introduced into the laser path.
The sensor plane of the camera is then placed at the focal length of the
lens or mirror, as shown in Figure 7-12:

Lens
)
%/_—:
l« f »
D
Camera 1 T
Laser = — |

Mirror

Figure 7-12. General Calculations > Divergence Measurement Optical Set-Up

The camera sensor must be placed at the focal length of the lens to pro-
duce a far field image for divergence measurement. Placing the camera
sensor at any other location along the beam path (such as the minimum
beam waist) does NOT produce the far field image and gives an incorrect
divergence measurement.

Divergence measures the far field angular sub-tense of the user-defined
percentage of the total power/energy in the image. With this method, the
focal length of the lens and the percent of energy at which divergence is to
be measured is entered by the user in the Focal length command and the
Divergence calculation dialog box.
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The BeamView.NET software then calculates the beam divergence and
displays it in the Results Area. This method measures the percentage of
power/energy passing through a circular aperture containing the specified
percentage of energy or power. This is often called the “energy-in-the-buck-
et” method.

The BeamView.NET software performs this calculation by computing the
full angular sub-tense (spot size in the far field) of the beam. This is done
by summing the intensities of all pixels contained within a circular aperture
of a certain diameter centered at the beam centroid location.

The percentage of the total power/energy contained in that area is then
calculated. If the resultant power or energy is not equal to the user-defined
percentage of the total beam power or energy, the diameter of the artifi-
cial aperture is adjusted and the summation calculation is repeated.

The diameter of the aperture is then divided by the focal length to yield the
full angular sub-tense of the input radiation and, therefore, its divergence.

O=d/f
Where:
A f = the focal length of lens or mirror
° d = the aperture diameter
o © = the full angle divergence in radians

A second method can be used to find the divergence manually. This meth-
od uses the overlaid Aperture function in the View area to determine the
percent of energy in a user-specified aperture using the % Power/Energy
in Aperture calculation. The user varies the size, type, and position of the
software aperture manually in the Apertures command.

To calculate the percent energy or power within a specified aperture, the
total intensity of all pixels contained within the aperture is summed. This
value is then used to calculate the power or energy in the aperture as a
percentage of the total beam power or energy.

This percent of energy, or power, is displayed in the Results Area. The set
aperture diameter divided by the focal length of the lens yields the diver-
gence of the beam for the percentage of energy/power in the aperture.

Click the checkbox in the left column for the calculation needed to use to
display settings in the following dialog box:
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Divergence —lf?\ﬁ
Format % Power S
86.5 % Power
Units
mm -
Pass/Fail
] Perform Pass/Fail checking
Range 1.999 3.002 mm
| QK | | Cancel | | Fault Actions | | Help

Figure 7-13. General Calculations > Divergence

General Calculations > Knife Edge

The Knife Edge calculation provides the X and Y widths of the captured
beam image, as defined in the Knife Edge Measurement algorithm. The Knife
Edge widths are calculated by summing profiles, from left to right, and top
to bottom, until the profile sums contain specified percentages of the total
image energy. The locations at which the energy percentages are reached
are used to define the widths.

The Knife Edge Widths are widths in the X and Y axes that are derived by
summing profiles across the image until the energy in the summed profiles
equals some percentage of the total energy of the image. For example, to
determine the knife edge width in the X axis, vertical profiles would be
summed, starting from the left edge, and moving right, until the profile
sums contain 16% of the total image energy.

When 16% is reached, that location is marked as x1. Then continue sum-
ming profiles, moving to the right, until the profile sums contain 84% of the
total image energy. That location is marked as x2. 16% and 84% are the
levels specified in the ISO standard, however, the BeamView.NET soft-
ware does allow selection of any percentage level. Once the x1 and x2 lo-
cations are determined, the width is twice the difference of the two points.

dx=2*(x2-x1)

The profile in the figure below represents the energy contained in each
pixel column of the image, shown here:

The Y axis width is then determined in a similar manner, summing hori-
zontal profiles from the top of the image to the bottom, and determining lo-
cations y1 and y2. The width is twice the difference of the two Y locations.

dy=2%(y2-y1)
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Figure 7-14. General Calculations > Knife Edge Profile

If the crosshair is rotated to a fixed position, or if it is tracking the ellipticity
angle, the profiles used to determine the widths will be parallel to the rotat-
ed axes, so the widths will also be parallel to the rotated axes.

NOTIC

The Knife Edge measurement is sensitive to background noise.
Therefore, it is important to use the Background Subtraction feature
with this measurement (see p. 74).

Click the checkbox in the left column for the calculation needed to use to
display settings in the following dialog box:

Knife Edge 1 i“o‘j
% Power Sy
Format —_—
ddd.ddd 840 % Power
Units
mrad -
Pass/Fail
[ Perform Pass/Fail checking
Horiz. 2,000 3.000 o
Vert. 2,000 3.000 o
| QK | | Cancel | | Fault Actions | | Help |

Figure 7-15. General Calculations > Knife Edge Dialog Box
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Calculation Settings

In addition to common fields, the following parameters define settings for
the Knife Edge calculation:

% Power/Energy: Provides specification of the % of Total Power or
Energy to be used in the Knife Edge calculation. There are two
percentage values used by the calculation:

4 One is the value entered in this box.
L The other is 100% minus the value in this box.

Therefore, if 16% is entered, then 16% and 84% will be used. If 86.5%
is entered, then 13.5% and 86.5% will be used.

General Calculations > Slit Diameter

The Slit Diameter calculation provides the X and Y diameters of the cap-
tured beam image, as defined in the Slit Diameter Measurement algo-
rithm.

The Slit Diameters are calculated by scanning a 1-pixel wide slit across
the image, and identifying the two outermost positions at which the slit
contains the specified percent of Peak power or energy (86.5% by de-
fault). The diameter is then the distance between the two positions.

A Slit Diameter is determined by the distance between the two slit posi-
tions that define some percent of the peak energy of the beam. By default,
the Slit Diameter includes 86.5% of the energy of the beam.

For example, to determine the Horizontal Slit diameter:

Define a 1-pixel wide slit.

2.  Scan across the image from left to right and find the peak energy
through that slit.

3. Starting at the left edge of the image, again with a 1-pixel wide slit,
scan across the beam until the slit contains 13.5% of the peak energy,
and mark that position as X1.

4.  Starting from the right side of the image, scan back across the image
until our slit contains 13.5% of the peak energy, and mark that position
as X2. The diameter is then the difference between X1 and X2.

dx =X2 - X1

The profile in the drawing below represents the energy contained in each
pixel column of the image, shown here:

To determine the Vertical Slit diameter, perform the same process with a
slit that scans from the top of the image to the bottom, marking the points
Y1 and Y2.
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Figure 7-16. General Calculations > Slit Diameter Profile

dy =Y2-Y1

The Slit Diameter is always calculated ON-AXIS; that is, rotating the
crosshair does not cause the Slit Diameter to be performed along the new
axes defined by the crosshair.

NOTIC

The Slit Diameter measurement is sensitive to background noise.
Therefore, it is important to use the Background Subtraction feature
with this measurement (see p. 74).

Click the checkbox in the left column for the calculation needed to use to
display settings in the following dialog box:

Slit Diameter 1SO
3% Peak e
Format ==
ddd.ddd 86.5 % Peak
Units
mm ~
Pass/Fail
[ Perform Pass/Fail checking
Horiz. 2.000 3.000 -
Vert, 2.000 3.000 -
| QK | | Cancel | | Fault Actions | | Help

Figure 7-17. General Calculations > Slit Diameter
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Calculation Settings

In addition to common fields, the following parameters define settings for
the Slit Diameter calculation:

% Peak: Provides specification of the % of Peak Power or Energy to
be used in the Slit Diameter calculation. The percentage value indi-
cates the amount of energy to include in the diameter (86.5% by
default).

General Calculations > Peak to Average

The Peak To Avg. calculation provides analysis of the Peak to Average in-
tensity ratio of the captured beam image, as defined in the Peak-to-Aver-
age Ratio algorithm.

The Peak-to- Average Ratio is the ratio of the measured beam peak inten-
sity to the intensity of a flat-top beam containing the same total power or
energy within the calculated 1/e? diameter of the actual beam. This gives
a measure of the beam flatness. A beam with a peak-to-average ratio of 1
would be a perfect “flat top” beam. An example profile is shown here:

1 %F’eak Intensity
——Flat Top Intensity

—»

Intensity

0 Position
Area of Area of
1 = VA
Peak-to-Average Ratio _PeakiIntensity

Flat Top Intensity

Figure 7-18. General Calculations > Peak to Average Profile

Click the checkbox in the left column for the calculation needed to use to
display settings in the following dialog box:
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¥ Peak To Avg. o
9 1S0
Format =Sik=
Units
Pass/Fail
[ Perform Pass/Fail checking
Range 1.000 5.000 mm
| QK | | Cancel | | Fault Actions | | Help |

Figure 7-19. General Calculations > Peak to Average

Ellipticity Calculations

The following options with their units of measurement and associated dia-
log boxes are available under the Ellipticity calculation:

° Major, Minor: Major and minor axes diameter of ellipse
. Angle: Angular orientation (degrees) of ellipse axes

d Circularity: Circular symmetry of ellipse (ratio of major to minor axes)

Each selection contains a separate dialog box for setting control and anal-
ysis parameters.

The Ellipticity group of calculations perform a fitted Ellipticity Measure-
ment to the captured beam image at a specified intensity level to derive
the major and minor axis size, the circularity, and angular orientation of the
fitted ellipse axes, as defined in the Ellipticity Measurement algorithm.

The Ellipticity measurement fits an ellipse to the beam image data, as fol-
lows:

1.  The BeamView.NET software first finds the set of intensity points
which correspond to the user-defined intensity level (given as a
percentage of beam peak). The user-entered percentage level
appears in the Ellipticity—Major, Minor calculation dialog box. This
intensity level is determined as follows:

Intensity = PeaklIntensity — (Peaklintensity * PercentagelLevel)

2. Aleast-squares fit is used to fit an ellipse to the intensity contour. This
fit is done with the centroid of the beam image as the center of the
ellipse.
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3.  The major and minor axes of the fit ellipse are calculated by deter-
mining the distance from the centroid to the ellipse.

4.  Circularity is the normalized ratio of the minor to the major axis. A
circularity of “1” corresponds to a perfectly circular or round beam.

5. Theta (®) is a measure of the orientation of the major axes of the fit.
Theta is measured from the positive X-axis and varies between +90
and -90.

The dialog box for settings is shown here:

A

Major Axis

Data Points ‘\ . Theta

" Centroid

'
Minor Ax<‘/

Figure 7-20. Ellipticity Calculations > Elliptical Fit

NV;

Fitted Ellipse

Ellipticity > Angle

The Ellipticity > Angle calculation provides analysis and display of the An-
gular Orientation of the major and minor axes of the fitted ellipse at the
specified intensity level, as defined in the Ellipticity Measurement algo-
rithm.

Click the checkbox in the left column for the calculation needed to use to
display settings in the following dialog box:
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Angle G
150
Format S
ddd.ddd
Units

degrees =

Pass/Fail
] Perform Pass/Fail checking

Range 45,000 90.000 degrees

| QK | | Cancel | | Fault Actions | | Help

Figure 7-21. Ellipticity Calculations > Angle

7.3.2 Ellipticity > Circularity

The Ellipticity > Circularity calculation can be used to monitor how elliptical
a beam is.

° A number near 1.0 is very circular.

° Values dropping from 1.0 becomes more elliptical.

This is a useful calculation when checking the ellipticity of a diode laser or
other similar beams.

Click the checkbox in the left column for the calculation needed to use to
display settings in the following dialog box:

Circularity is&
tormat S
ddd.ddd
Units

Pass/Fail
[] Perform Pass/Fail checking
Range 0.750 1.000
| QoK | | Cancel | | Fault Actions | | Help

Figure 7-22. Ellipticity Calculations > Circularity
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Ellipticity > Major, Minor

The Ellipticity > Major, Minor calculation provides analysis and display of
the major and minor axes diameter of the fitted ellipse at the specified in-
tensity level, as defined in the Ellipticity Measurement algorithm.

Click the checkbox in the left column for the calculation needed to use to
display settings in the following dialog box:

Major, Minor ‘Isﬁﬁ‘
% Peak S
Format —_—
86.5 % Peak
Units
mm ~
Pass/Fail
[] Perform Pass/Fail checking
Major 1.999 3.002 mm
Minor 2.002 3.002 mm
| QK | | Cancel | | Fault Actions | | Help |

Figure 7-23. Ellipticity Calculations > Major, Minor

Calculation Settings

In addition to common fields, the following parameters define settings for
this calculation:

% Peak: Provides selection of the user defined % of Peak intensity
level. All beam image pixels at this level are included in the Ellipticity
calculation.

Gaussian Fit

The following options are available under the Gaussian Fit settings:
° Coefficient — Fit correlation coefficient (nhormalized residuals
d Centroid [mm] — Center location (centroid) of Gaussian Fit.

. Peak Intensity [digital] — Peak intensity of Gaussian Fit.
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d Diameter [mm] — Beam diameter of Gaussian Fit.
. Roughness of Fit [%] — Roughness of Gaussian Fit (difference
between actual profile and fitted curve).

Each selection contains a separate dialog box for setting control and anal-
ysis parameters.

A group setting of % Peak provides selection of the user-defined % of
Peak intensity level. All pixels above this level in the cross-section profile
are used for all Gaussian Fit calculations. The default setting of 86.5 in-
cludes all pixels above the 1/e2 intensity level.

The Gaussian Fit is a least-squares fit of a Gaussian equation to the
cross-section beam profiles. The correlation coefficient is the normalized
sum of the residuals of the fit.

The following equation is used to do the Gaussian Fit:
| = Ve-2[(x-c)/0]2
where | = the intensity of a pixel at location x.

In performing a least-squares fit to this equation, the following terms are
derived:

V = the maximum intensity of the fitted Gaussian curve (Peak Inten-
sity).
C = the center of the Gaussian fit peak (Centroid).

o = the radius of the Gaussian fit curve at the 1/e2 intensity level
(Diameter).

Gaussian Fit > Coefficient

The Gaussian Fit > Coefficient calculation shows how closely the beam
fits a Gaussian profile.

° Numbers near 1.0 are very Gaussian.

. Numbers dropping from 1.0 are further from being Gaussian.

This coefficient is useful to track the quality of the beam profile and how
close to Gaussian it is.

Click the checkbox in the left column for the calculation needed to use to
display settings in the following dialog box:
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Coefficient i”?b:
S
Format _—
ddd.ddd
Units
mm =
Pass/Fail
[] Perform Pass/Fail checking
Horiz. 0.750 0.990
Vert. 0.750 0.990
| QK | | Cancel | | Fault Actions | | Help |

Figure 7-24. Gaussian Fit Calculations > Coefficient

Gaussian Fit > Centroid

The Gaussian Fit > Centroid calculation provides the center location (cen-
troid) of the least squares Gaussian fit of the cross-section profiles.

Click the checkbox in the left column for the calculation needed to use to

display settings in the following dialog box:

Coefficient -I”ﬁ‘ﬁ_-
S
Format _—
ddd.ddd
Units
mm
Pass/Fail
[] Perform Pass/Fail checking
Horiz. 1.000 2.000 mm
Vert. 1.000 2.000 mm
| QK | | Cancel | | Fault Actions | | Help |

Figure 7-25. Gaussian Fit Calculations > Centroid
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Gaussian Fit > Peak Intensity

The Gaussian Fit > Peak Intensity calculation provides the peak intensity
of the least squares Gaussian fit of the cross-section profiles.

Click the checkbox in the left column for the calculation needed to use to
display settings in the following dialog box:

Peak Intensi %o
eak Intensity 1SO
S

Format —
ddd.ddd
Units
digital ~
Pass/Fail
[ Perform Pass/Fail checking
Horiz. 1910 2520 digital
Vert, 1910 2520 digital

| oK | | Cancel | | Fault Actions | | Help |

Figure 7-26. Gaussian Fit Calculations > Peak Intensity

Gaussian Fit > Diameter

The Gaussian Fit > Diameter calculation provides the profile diameter of
the least squares Gaussian fit of the cross-section profiles at the 1/e2 in-
tensity level.

Click the checkbox in the left column for the calculation needed to use to
display settings in the following dialog box:

120



7.4.5

Analyze Calculations

Diameter i’?&
S
Format
ddd.ddd
Units
mm =
Pass/Fail
] Perform Pass/Fail checking
Horiz. 2000 3.000 mm
Vert, 2,000 3.000 mm
| QK | | Cancel | | Fault Actions | | Help |

Figure 7-27. Gaussian Fit Calculations > Diameter

Gaussian Fit > Roughness of Fit

The Gaussian Fit > Roughness calculation is a percentage (0 to 100) indi-
cating the difference between the actual profile and the fitted Gaussian
curve. The smaller the roughness value, the smaller the difference be-
tween the two curves, consequently the more Gaussian the profile.

Click the checkbox in the left column for the calculation needed to use to
display settings in the following dialog box:

. S
Roughness of Fit 1SO
=
Format —_—
ddd.ddd
Units
%
Pass/Fail
] Perform Pass/Fail checking
Horiz. 10.0 50.0 9
Vert, 10.0 50.0 9
| QK | | Cancel | | Fault Actions | | Help |

Figure 7-28. Gaussian Fit Calculations > Roughness of Fit
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Aperture Uniformity

The Aperture Uniformity calculation group provides a statistical analysis of
pixel intensities within the specified aperture area overlaying the captured
beam image, as defined in the Uniformity Measurements algorithm. The
Aperture Uniformity calculates the minimum, mean (average), maximum,
RMS (root mean square) and Sigma (standard deviation) of the pixel in-
tensities within the defined aperture area.

The following options are available under the Aperture Uniformity settings:

d Min, Mean, Max [digital] — Minimum, mean, and maximum beam
intensity within the aperture

. Sigma, RMS [digital] — Sigma (Standard Deviation) and RMS

° % Power/Energy in Aper. {%]

Each of these are described in the sections that follow.

Aperture Uniformity > Min, Mean, Max

The Aperture Uniformity > Min, Mean, Max calculation provides the mini-
mum, mean (average) and maximum of the pixel intensities within the
specified overlaid aperture.

Click the checkbox in the left column for the calculation needed to use to
display settings in the following dialog box:

Min, Mean, Max -isgt\a
Format =
Units
digital =

Pass/Fail

[ Perform Pass/Fail checking
Min 0.0 200 digital
Mean 127.0 191.0 digital
Max 491513 64870.7 digital

| QK | | Cancel | | Fault Actions | | Help |

Figure 7-29. Aperture Uniformity Calculations > Min, Mean, Max
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Aperture Uniformity > Sigma, RMS

The Aperture Uniformity - Sigma, RMS calculation provides the Sigma
(standard deviation) and RMS (root mean square) of the pixel intensities
within the specified overlaid aperture.

Click the checkbox in the left column for the calculation needed to use to
display settings in the following dialog box:

Sigma, RMS lﬁ\sd
Sgr=
Format —_—
Sigma, RMS
Units
digital -
Pass/Fail
[] Perform Pass/Fail checking
Sigma 0.0 300 digital
RMS 0.0 840 digital
| QK | | Cancel | | Fault Actions | | Help |

Figure 7-30. Aperture Uniformity Calculations > Sigma, RMS

Aperture Uniformity > % Power/Energy in Aper.

The Aperture Uniformity > % Power/Energy in Aperture calculation pro-
vides the percent of total integrated power or energy in a specified aper-
ture area overlaid on the captured beam image in the View area.

Click the checkbox in the left column for the calculation needed to use to
display settings in the following dialog box:
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7.6

% Power in Aper. ]’?\d
Format =N
ddd.c
Units
%

Pass/Fail
[ Perform Pass/Fail checking

0.0 524280.0

w2

Range

| oK | | Cancel | | Fault Actions | | Help |

Figure 7-31. Aperture Uniformity Calculations > % Power/Energy in Aper.

Image Uniformity

The Aperture Uniformity > % Power/Energy in Aperture calculation pro-
vides the percent of total integrated power or energy in a specified aper-
ture area overlaid on the captured beam image in the View area, as
defined in the Percent Power/Energy in Aperture algorithm.

The following option is available under the Image Uniformity settings:

. Min, Mean, Max [digital]

Click the checkbox in the left column for the calculation needed to use to
display settings in the following dialog box:
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Min, Mean, Max -IA?\E
Format =N
Units
digital v

Pass/Fail

[ Perform Pass/Fail checking
Min 0.0 20.0 digital
Mean 127.0 191.0 digital
Max 49151.2 64879.7 digital
| oK | | Cancel | | Fault Actions | | Help |

Figure 7-32. Image Uniformity Calculations > Min, Mean, Max

Flat Top

Flat top calculations are based upon the ISO 13694:2000(E) Standard, al-
though this specific implementation relies upon numerical approximations
over a fixed inclusion region.

This inclusion region can be set using the Inclusion Area command on the
Analysis menu. This area should be made as large as possible, up to the
limit of capture resolution: 1279 x 1023. All calculations are based upon
the Inclusion Area—a rectangular region with upper left corner (xm,ym)
and lower right corner (xM,yM).

Because these calculations have a chain of dependence, start with the
most basic idea: a Threshold Fraction n. This is a ratio of “floor” Power
(Pth) to Peak Power (Pm). Note that an equivalent definition is made for
pulsed beams, where Uth and Um are threshold and maximum energy, re-
spectively.

Typically this ratio is set based upon the “floor” being close to the ob-
served noise level of the camera. This roughly corresponds to the bias
level when taking a Background Map.

For all Flat Top settings, Threshold selects the user-defined % of Peak in-
tensity level. All pixels above this level in the cross-section profile are
used for all Flat Top calculations. The default setting is 14.0%.

The following options with their units of measurement and associated dia-
log boxes are available under the Flat Top settings:

° Beam Uniformity
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1.7.1

d Plateau Uniformity

° Flatness Factor

. Edge Steepness

*  Eff. Irradiation Area [cm?]

. Eff. Avg. Energy Density [J/m2]

Each of these are described in the sections that follow.

Flat Top > Beam Uniformity

The Flat Top > Beam Uniformity command is the normalized RMS devia-
tion of the power (energy) density. The Beam Uniformity range is zero to
one, with a perfect flat top beam having a value of zero. To calculate this
value:

1.  Calculate the average power (energy) density of the portion of the
beam exceeding the user defined Threshold.

2. Calculate the RMS deviation of the power (energy) density of the
portion of the beam exceeding the user defined Threshold.

3. Calculate the ratio:

RMS power (Energy) Density

AVE. power (Energy) Density

Figure 7-33. Flat Top Calculations > Beam Uniformity Ratio

4.  Enter the value in the dialog box:
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Beam Uniformity S
150
Format ——
Units
Pass/Fail
[] Perform Pass/Fail checking
Range 0.000 5242.800
| QK | | Cancel | | Fault Actions | | Help |
Figure 7-34. Flat Top Calculations > Beam Uniformity
1.7.2 Flat Top > Plateau Uniformity

The Flat Top > Plateau Uniformity is the ratio of the full width half maxi-
mum to the maximum of the histogram of pixel intensities for all pixels in
the active region above the intensity threshold. The Plateau Uniformity
range is zero to one, with a perfect flat top beam having a value of zero.

To calculate Plateau Uniformity:
1. Construct a histogram of pixel intensities for all pixels above the user-
defined threshold.

2.  Find the peak in the histogram—that is, the pixel intensity value which
has the largest number of pixels at that intensity.

3.  Measure the full width half maximum (FWHM) of the peak in the histo-
gram.

Find the highest pixel intensity (Max).

Calculate the ratio:

FWHM
Max

Figure 7-35. Flat Top Calculations > Plateau Uniformity Ratio

The plot in Figure 7-36 illustrates the histogram of pixel intensities with the
peak in the histogram, the highest pixel intensity, the full width half max,
and the user-defined threshold individually labeled.
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Peak

Threshold Maximum

Figure 7-36. Flat Top Calculations > Plateau Uniformity Histogram

Note that there are two peaks in the histogram, one corresponding to the
illuminated area of the beam, which is used for the Plateau Uniformity cal-
culation, and one near zero pixel intensity, below the user-defined thresh-
old, which represents the dark region of the camera not illuminated by the
laser beam.

Click the checkbox in the left column for the calculation needed to use to
display settings in the following dialog box:

Plateau Uniformity =

Format
ddd.ddd

Units

Pass/Fail
[] Perform Pass/Fail checking

Range 0.000 5242.800

| QK | | Cancel | | Fault Actions | | Help |

Figure 7-37. Flat Top Calculations > Plateau Uniformity

128



173

Analyze Calculations

Flat Top > Flatness Factor

Flat Top - Flatness Factor: The ratio of the average power (energy) densi-
ty to the maximum or peak power (energy) density. The Flatness Factor
range is zero to one, with a perfect flat top beam having a value of one.

Flat Top - Flatness Factor: The ratio of the average power (energy) densi-
ty to the maximum or peak power (energy) density. The Flatness Factor
range is zero to one, with a perfect flat top beam having a value of one.

To calculate Flatness Factor:

1. Calculate the average intensity of all pixels with intensities above the
user-defined threshold.
2.  Find the peak pixel intensity.

3. Calculate the ratio:

Average

Peak

Figure 7-38. Flat Top Calculations > Flatness Factor Ratio

4, Enter the value.

Flatness Factor —f?\ﬁ
Format ==
Units

Pass/Fail

[ Perform Pass/Fail checking
Range 0.000 5242.800
| QK | | Cancel | | Fault Actions | | Help

Figure 7-39. Flat Top Calculations > Flatness Factor

129



BeamView.net Operator’s Manual

1.74 Flat Top > Edge Steepness

The Flat Top > Edge Steepness calculation is the normalized difference
between two Effective Irradiation areas with intensity levels above 10%
and 90% of maximum intensity.

Click the checkbox in the left column for the calculation needed to use to
display settings in the following dialog box:

Flatness Factor —Iﬁ?ﬁ
Format =
Units

Pass/Fail
[ Perform Pass/Fail checking

Range 0.000 5242.800

| oK | | Cancel | | Fault Actions | | Help

Figure 7-40. Flat Top Calculations > Edge Steepness

The range is zero to one, with a Flat-Top beam with vertical edges having
a value of zero.

NOTIC

The Edge Steepness calculation does not use the threshold value
per ISO 13694:2000 Standard for laser beam measurement.

To find this value:
1.  Find the area of the beam where the intensity is 10% (of the peak
intensity) or greater. Call this A1.

2.  Find the area of the beam where the intensity is 90% (of the peak
intensity) or greater. Call this A2.

3.  Normalize to A1 and find the difference, then simplify:
View the “perfect” flat top beam in Figure 7-42:

The area of the beam at 10% intensity is equal to the area at 90% intensi-
ty (A1 =A2). For a 1 mm diameter beam, the area is 0.79 mm? and the
calculation is:
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Al 22 simplifyto: (ALZA2)
Al Al Al

Figure 7-41. Flat Top > Edge Steepness - Normalize

Figure 7-42. Flat Top > Edge Steepness: ‘Perfect’ Flat-Top Beam

(0.79 — 0.79)
0.79

=0
Figure 7-43. Flat Top > Edge Steepness - Calculate for 1 mm Beam

The expected Edge Steepness value for a ‘perfect’ flat top is zero (see

row 1 in Table 7-2). Two flat top images are included in the Beam-
View.NET sample library.

Now compare the “perfect” beam to the “realistic’ beam in Figure 7-44:

90% 90%

10% 10%

Figure 7-44. FlatTop > Edge Steepness: ‘Realistic’ Flat-Top Beam
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In this beam profile, A1 > A2 and the Edge Steepness is greater than 0.
(Note that A1 < A2 is not physically possible.) When the diameter at 10%
intensity is 30% larger than the diameter at 90%, the Edge Steepness is:

(1.33 — 0.79)

=041
1.33

Figure 7-45. Flat Top > Edge Steepness Calculation

This measurement corresponds to the information in Row 4 of Table 7-2:

Table 7-2. Flat Top > Edge Steepness Calculations

Diameter at Area At
Row 10% | 90% Stooposs
10% 90% (A1) (A2) P
1 1.0 1.0 0.79 0.79 0.00
2 1.1 1.0 0.95 0.79 0.17
3 1.2 1.0 1.13 0.79 0.31
4 1.3 1.0 1.33 0.79 0.41
5 1.4 1.0 1.54 0.79 0.49
6 1.5 1.0 1.77 0.79 0.56
1.17.5 Flat Top > Eff. Irradiation Area [cm2]

The Flat Top> Effective Irradiation Area is the area of the beam that ex-
ceeds the user-defined threshold.

Click the checkbox in the left column for the calculation needed to use to
display settings in the following dialog box:

To calculate this value:

1. Count the number of pixels that exceed the user-defined threshold.

2. Multiply the number of pixels counted by the area of a single pixel.
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Eff. Irradiation Area iﬂsa!b:
Format e
ddd.ddd
Units

£ e

<m

Pass/Fail
[ Perform Pass/Fail checking

0.0000 0.0001 am?

Range

| QK | | Cancel | | Fault Actions | | Help

Figure 7-46. Flat Top Calculations > Eff. Irradiation Area

The result is the Effective Irradiation Area, shown in the following exam-
ple.

Effective
Irradiation
Area

__~ Threshold

Figure 7-47. Flat Top Calculations > Eff. Irradiation Area

This is similar to the Effective Area calculation, with the distinction that
non-symmetrical beams or donut-shaped beams are better represented.

1.7.6 Flat Top > Eff. Avg. Energy Density [J/m2]

The Flat Top - Effective Average Power (Energy) Density is the average
power (energy) density of the portion of the beam exceeding the user-de-
fined threshold.

This calculation is an extension of the Effective Irradiation Area.

To calculate this value:
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1. Every pixel that is above the user threshold is counted and its Power
(Energy) value is recorded.

2.  Sum all of the Power (Energy) values recorded in Step 1, and divide
by the number of pixels to find the Effective Average Power (Energy).

3. The Effective Irradiation Area is found by multiplying the number of
pixels (above the user-defined threshold) by the area of a pixel.

4. Calculate:

Effective Average Power (Energy)

Effective Irradiation Area

Figure 7-48. Flat Top Calculations > Eff. Avg. Energy Density Calculation

NOTIC

‘Effective’ means the portion of the beam (or the pixels) where the
intensity is above the user threshold.

Click the checkbox in the left column for the calculation needed to use to
display settings in the following dialog box:

Eff. Avg. Power Density =
150
Format et
ddd.ddd B
Units
W/cm® .

Pass/Fail
[] Perform Pass/Fail checking

Range 0.0000 0.015 W/ern?

| OK | | Cancel | | Fault Actions | | Help |

Figure 7-49. Flat Top Calculations > Eff. Avg. Energy Density
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Fault Actions

Each calculation in BeamView.NET has a Fault Action feature. This
means that a minimum and maximum value can be set in BeamView.NET
for each specific calculation.

The Fault Actions command works in conjunction with the Pass/Fail fea-
ture of the Calculations command dialog box to provide selection of the
action(s) to be taken when one or more of the selected pass/fail analysis
items fall outside the chosen Pass/Fail range.

If that calculation falls outside the minimum and maximum settings, Beam-
View.NET sends warnings through several user-selectable actions, such
as:

A An audible alarm (beep)

° Stop capturing an image

° Reverse the Background color

° Save or discard an image when one of these faults occurs
° TTL pulse out (high or low)

For example, if users always want the diameter of the beam to be be-
tween 2.2 mm and 2.5 mm, they can set those values as the minimum
and maximum. Then, if the beam size gets too large or too small, Beam-
View.NET warns users that the beam is outside of those parameters.

This can be useful in manufacturing set-ups where a beam size specifica-
tion is part of the quality control process on certain types of lasers.

To set Preferences for the type of notification, Go to the Analysis tab and
select Fault Actions. The following dialog box is displayed:

Any combination of Fault Actions can be selected—except Image-Save
and Image-Discard. All analysis results that fall outside range limits are
displayed with an “F” before the result in both the View and Statistics Ar-
eas. This provides visual identification of failed results.
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Fault Actions nl

Select the desired Fault Actions that will occur
when a calculation's value falls outside of the
Pass/Fail range.

Beep
[ ] Stop
Reverse Background Color
[ ] Image
Save

* Discard
[] TTL Pulse
® TTL High
TTL Low

| Ck || Cancel || Help |

Figure 7-50. Analysis — Fault Actions

7.8.0.0.1 Beep

This option produces an audible tone for each image captured that has
any result that falls outside of the acceptable Pass/Fail range set in the
Calculations dialog box.

7.8.0.0.2 Stop

This option stops capturing images on the first image captured that has
any result that falls outside of the acceptable Pass/Fail range set in the
Calculation dialog box.

7.8.0.0.3 Reverse Background Color

This option changes the color of the results area for any sample that has
results outside of the acceptable Pass/Fail range set in the Calculations
dialog box. This provides a visual identification of failed samples.
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Image Save | Discard

The BeamView.NET software can be configured to save or discard imag-
es, depending on whether any of the results are outside of the acceptable
Pass/Fail range set in the Calculations dialog box.

Image-Save and Image-Discard functions cannot be active at the same

time.

Image Save: This option stores images that have any result outside
of the acceptable range. The total number of failed images that can
be stored with this function—the BeamView.NET image buffer
capacity, minus one—insures at least one image location is available
for continued image capture.

All collected images can be subsequently displayed. All images that
have been saved due to a failed result value are indicated in the
sample header area with the word “Saved” next to the sample
number.

Image Discard: With this option, any image with results that fall
outside range limits are not stored in video memory but are discarded.
The results for that image are displayed in the View area during the
capture process, but are not stored and are not included in the statis-
tics calculations.

If an image is being discarded, the sample number does not incre-
ment, causing the next image to be captured over the image being
discarded.

If Pass/Fail settings are such that all images fail, the sample number
in the Results Area title bar does not update.

NOTIC

When Image-Discard is used, make sure that range limits are not set

to discard all captured images. The BeamView.NET software appears
to be “locked up” and does not store data, when in actuality every
image is being discarded.

TTL Pulse

This option tells the camera to send a pulse whenever a fault is detected.

A pulse can be set to Low or High, which means high or low voltage.

Using the optional Trigger In and Pass/Fail cable allows the user to trans-
late pass/fail calculations into TTL voltage levels. The calculation pass/fail
state is indicated on the status bar.
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7.9

7.9.1

This same state is also available on the external camera cable as a TTL
HI/LOW output. Polarity is selected from the Analysis > Fault Actions
menu by selecting the checkbox for the TTL High (> 2.0V) or TTL Low (<
0.8V) option.

Analysis Profiles

In the Profiles section of the Analysis toolbar, define parameters for the
following settings:

° Apertures

* Reference Position
° Inclusion Area

° Units

d Average Images (dimmed when not available)

Analysis > Apertures

The Apertures command controls the shape, size, and color of the over-
lay aperture displayed in the View area of the BeamView.NET interface.
The position and rotational orientation of the Apertures is controlled from
the Crosshair dialog box.

The Aperture setting can help determine if accurate diameter measure-
ments are taken. If the aperture that is drawn around the beam does not fit
the beam very well, the diameter calculations may not be accurate either.

The Aperture feature can be used with the different diameter calculations
to make sure the diameter calculations are valid. For example, if users set
the aperture to track the knife-edge diameter calculations on the beam
and the aperture does not actually fit nicely around the beam, the camera
is either picking up some noise that is throwing off that specific calculation
or the knife-edge diameter calculation is not the best diameter calculation
to use on that specific beam.

The Apertures represent a synthetic hard aperture, located with the cross-
hair for performing aperture related beam analysis functions.

If any part of the aperture moves outside the image area, uniformity calcu-
lations can only be performed on the part of the aperture area that is still
within the valid image area.
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Analyze Calculations
Check for Duplications

The aperture setting can help determine if diameter measurements taken
are accurate. If the aperture that is drawn around the beam does not fit
the beam very well, the diameter calculations may not be accurate either.

The aperture feature can be used with the different diameter calculations
to make sure the diameter calculations are valid. For example, if users set
the aperture to track the knife-edge diameter calculations on the beam
and the aperture does not actually fit nicely around the beam, the camera
is either picking up some noise that is throwing off that specific calculation
or the knife-edge diameter calculation is not the best diameter calculation
to use on that specific beam.

When users select Analysis > Apertures, the following dialog box is dis-
played:

@ Apertures b
[]0On Select Shape: | Ellipse o
Size

Track

Aper, Diameter *

Width [mm)]) Height [rmim]
Style Settings
Caolor
Yellow -
| Ok | | Cancel | | Help |

Figure 7-51. Analysis — Profiles — Apertures

Functions in the Apertures dialog box include:
° On
° Select Shape

. Size and Style Settings

The position and rotational orientation of the Apertures is controlled from
the Crosshair dialog box.
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7.9.1.2

7.9.1.3

7.9.1.4

Aperture Settings ON

The On check box enables or disables the display of the overlaid aper-
tures in the BeamView.NET window's View area. If no x appears, the ap-
ertures is not shown in the View area.

The apertures are not available with the 3D isometric plot.

Shape of the Aperture

The Aperture setting turns on an aperture that is traced around the diame-
ter of the beam. Select from following options for shapes:

° Circle — Provides a circular aperture overlaid on the beam
image

° Ellipse — Provides an elliptical aperture overlaid on the beam
image

° Square — Provides a square aperture overlaid on the beam
image

o Rectangle — Provides a rectangular aperture overlaid on the
beam image

The CIRCLE and SQUARE aperture types allow entry of one dimension
(width), while the RECTANGLE and ELLIPSE type allow two dimensions
(width and height).

Size of the Aperture

Select from the following options for the size of the Aperture:

A User Size — Selecting User Size as the tracking method acti-
vates the Width and Height boxes, allowing entry of a specific
aperture size.

° Effective Diameter

° Aperture Diameter

A d4 Sigma Width

A d4 Sigma Diameter
° Divergence

. Knife Edge

° Slit Diameter

. Elliptical Axes

L Gaussian Diameters
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7.9.2
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Width and Height

Enter values for Width and Height (in millimeters).

. Width allows the width of the aperture to be selected by either
entering the value numerically or by using the spin buttons (Up and
Down arrows) with the mouse to achieve the desired number. The
units for the coordinates are shown in parentheses next to the Width
label.

. Height allows the height of the aperture to be selected by either
entering the value numerically or by using the spin buttons (Up and
Down arrows) with the mouse to achieve the desired number. The
units for the coordinates are shown in parentheses next to the Height
label.

Color of the Aperture

Selects the color used for display of the Reference Position cross indicator
in the View area:

. White
L Red
4 Green

° Magenta

L Yellow
L Blue
o Cyan

Analysis > Reference Position

The Reference Position command provides control of the Reference Posi-
tion coordinate function. This function defines the location of the Beam-
View.NET system coordinate origin.

When Reference Position is selected, the following dialog box is dis-
played. The reference position is not available with the 3D isometric plot.
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Figure 7-52. Analysis — Profiles — Reference Position

The Reference Position point is displayed as a small cross in the View

@ Reference Position
[1on

Position
Set Reference at

Crosshair Positic Set

X [om] ¥ [cm]

0.4191 —{ |0.3063

Style Settings

Coler

Red -

| Ck | | Cancel | | Help |

left-hand corner of the View area).

. When the Ref. Position function is On, a (“+”) symbol appears in all
coordinate position displays. With this function On, positive calcula-
tion values are displayed up and to the right of the reference position

7.9.2.1 Enable Reference Position
area (“+”).
in the image.
7.9.2.2

This item provides selects the location where the Reference position will
be located when the Set button is pressed, or when the Reference posi-
tion is turned on from the Tool Bar Icon. Select from the drop-down menu

Set Reference Position Location

to locate the Reference Position and click Set:

L The current Crosshair Position

° User-specified coordinates

° Minimum centroid location shown in the Statistics
A Mean (average) centroid location shown in the Statistics Area

4 Maximum centroid location shown in the Statistics Area
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° Minimum peak location shown in the Statistics
o Mean (average) peak location shown in the Statistics Area
° Maximum peak location shown in the Statistics Area

Enter X and Y values for User Coordinates

° X (units) - This item allows the X axis location of the reference position
to be selected when User Coordinate location is set either by entering
the value numerically or by using the spin buttons (Up and Down
arrows) with the mouse to achieve the desired number. The units for
the coordinates are show in parentheses next to the X label.

° Y (units) - This item allows the Y axis location of the reference position
to be selected when User Coordinate location is set either by entering
the value numerically or by using the spin buttons (Up and Down
arrows) with the mouse to achieve the desired number. The units for
the coordinates are show in parentheses next to the Y label.

Style Settings

Select a color:

. White
L Red
4 Green

° Magenta

L Yellow
L Blue
o Cyan

Analysis > Inclusion Area

The Inclusion Area is a user-defined area within which the selected analy-
sis calculations are performed. The area is displayed as a red square in
the main window.

An Inclusion Area is used (activated) to improve beam diameter accuracy.
The size of the Inclusion zone should be approximately 2 to 2.5 times larg-
er than the beam diameter for beams less than 3 mm.

When the Inclusion Area is turned on (activated), BeamView.NET ana-
lyzes only the area inside that area. Any beam image data outside the in-
clusion area are ignored in the calculations.
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7.9.3.1

When an aperture is used with the Inclusion Area, that aperture is al-
lowed to move outside the Inclusion Area, but all uniformity analysis is
performed only within the area of the aperture that is inside the Inclusion
Area.

Using the Inclusion Zone is a good way to help the software ignore noise
from the camera or the environment that may be affecting the image. The
goal is to draw the Inclusion Zone around the area where the beam is lo-
cated.

To choose the Inclusion Area command:

1. From the Analysis menu, select Inclusion from the menu list. The
following dialog box is displayed:

€ Inclusion Area x
On

Center Position

X [rim] ¥ [mm]

0.676 — (0367 -
Size

Horiz, [mm] Wert, [mm]

0.640 — (0351 -
| oK | | Cancel | | Help |

Figure 7-53. Analysis — Profiles — Inclusion Command

There are three functions in the Inclusion Area dialog box:
° On
° Center Position
° Size

For information about using the Inclusion Area in troubleshooting, see 'Di-
vergence measurement seems too large’ (p. 203).

Enable Inclusion Area

Click the checkbox to turn Inclusion ON, which displays the red square in
the main window. When the Inclusion area is Off, the entire captured reso-
lution image area is used for calculations.
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Define Center Position

‘This function provides the ability to locate the center of the Inclusion area.

. X [pixels]: Allows the X axis location of the Inclusion area center posi-
tion to be selected by either entering the value numerically or by using
the spin buttons (Up and Down arrows) with the mouse to achieve the
desired number. The units for the coordinates are show in paren-
theses next to the X label.

. Y [pixels]: Allows the Y axis location of the Inclusion area center posi-
tion to be selected by either entering the value numerically or by using
the spin buttons (Up and Down arrows) with the mouse to achieve the
desired number. The units for the coordinates are show in paren-
theses next to the Y label.

Enter values for the X and Y coordinates for the center position (in milli-
meters).

Define Size

This function provides the ability to control the size of the Inclusion area:

. Horizontal [pixels]: Allows the width of the Inclusion area to be
selected by either entering the value numerically or by using the spin
buttons (Up and Down arrows) with the mouse to achieve the desired
number. The units for the coordinates are show in parentheses next
to the Horz. label.

. Vertical [pixels]: Allows the height of the Inclusion area to be
selected by either entering the value numerically or by using the spin
buttons (Up and Down arrows) with the mouse to achieve the desired
number. The units for the coordinates are show in parentheses next
to the Vert. label.

Enter values for the Horizontal and Vertical size (in millimeters).

Analysis > Units

The Units command provides selection of desired spatial, power/energy,
position, time, and intensity units to be used in the BeamView.NET soft-
ware. These units are used in the display of the various system-wide func-
tion and values, such as input dialog boxes, cursor position, and intensity
displays, etc.
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NOTIC

Many calculations provide independent unit selection in the Calcula-
tions command dialog box. These units are not affected by unit
changes made here for Analysis.

When Units is selected, the following dialog box is displayed:

Beam Analysis Units n
The system units determine how values are displayed in dialog boxes and
the status bar. Note that they do not affect display of calculation results.
Result units can be selected in the Calculations dialog.
Spatial mm ~ | [Inclusion and Aperture dialogs]
XY Position cm “ | [Status bar display of Crosshair position]
Power mwW B [Power Calibration wizard]
Intensity digital ~ | [Status bar display of Crosshair pixel]
Time seconds « | [Capture/Trigger dialag]

| Ok | | Cancel | | Help |

Figure 7-54. Analysis — Profile Settings— Units

The drop-down menu for each setting lists different units of measurement.
Select as desired from these lists.

79.4.1 Spatial and XY Position

The Spatial function provides selection of different spatial units used for di-
mensional values.

Both the Spatial and XY Position settings list the following options:
° mm (microns)
° um (millimeters)
A cm (centimeters)
° m (meters)
o inch
° pixel

° urad (radians)
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L mrad
4 rad

° degrees

7.9.4.2 Energy/Power

Power settings include the following options:

) uw
° mwW
° w
° KW
° GwW
7.9.43 Intensity

The Intensity function provides selection of the units for the pixel Intensity
level or energy/power density values. The settings include the following

options:

° uW/cm2

*  mW/icm?

e Wicm?

*  KWi/cm?

o digital

° % resp.
7.9.4.4 Time

The Time function provides a selection of different units used for time val-
ues and include the following options:

. milliseconds
4 seconds

° minutes
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7.9.5

Analysis > Average Images

The Average Images command allows users to select any images in the
image buffer to be averaged together. This menu item is dimmed when no
images have been captured.

The dialog box shown in Figure 7-55 is displayed:

Image Select n
Select the images to save by clicking the Sample number icons. Use the "Select All"
button to save all available images.
Available Image Samples
le 1 Select All
._ b
Images Selected: 0
| Cancel | | Help

Figure 7-55. Analysis — Average Images

The numbered icons represent samples that still have images in the im-
age buffer. Users can select more than 1024 images to average.

d To select an image, click the mouse on the checkbox beside each icon
that needed to compare. Clicking the checkbox a second time dese-
lects that image.

i To select all images in the buffer, use the Select All button.

When the desired images are selected, press OK to perform the average.

A progress bar at the bottom of the dialog box indicates the percent com-
plete during the averaging process.

After the selected images are averaged, the new average image is added
to the image and sample buffers, and the calculations are performed on
the image. The header bar for the results area displays the word “Aver-
age”, indicating the image is the result of an average, not a captured im-
age.

Use the Clear All button to deselect all images that are currently selected.
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The averaged image overwrites the oldest image in the buffer (the image
for Sample #1), as indicated by a Warning message. To avoid overwriting
an existing image, either press the Cancel button or stop image collection
before the maximum buffer size is reached. This action cancels the aver-
aging operation and closes the dialog box.

Options to Customize Settings

Table 7-3 lists settings that are commonly customized:

Table 7-3. Options to Customize Settings

To change this Menu command Shortcut
Source Type (CW or Capture | Capture/Trigger <Shift> + <F7
Pulsed) >

Trigger Mode (if Pulsed) Capture | Capture/Trigger

Resolution (use 1:4 to Capture | Resolution
begin)

Sample Buffer Size Capture | Buffer
Type of Image Plot View Plot Type,

Profiles, Cross-
hair, Fit Profiles

Graphic Zoom Level View Zoom <F8>
(use 1X for Setup)

Aperture Shape & Size Analysis | Apertures

Inclusion Area Analysis | Inclusion <Shift> + <F8
(use Off for the first time) >
Reference Position Analysis | Reference Posi- <F4>
(use Off for first time) tion

Desired Calculations Analysis | Calculations <Ctrl> + <R>
Desired Units Analysis | Units

Capture Background Map | Capture | Background Map

Save Settings File Save Config
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8.1

8.1.1

Remote Mode Set Up

Remote Mode Set Up

Remote Mode in BeamView.NET allows a terminal application to send and
receive commands directly into the Beam VIEW.NET software applica-
tion. This includes such programs as LabVIEW or a custom Windows ap-
plication.

Coherent also offers such a terminal application (named “Remote Data
Logging Utility”) that can be used to explore BeamView commands and to
test response/results. For example, users can use this application to query
information from the BeamView or automate data collection using this re-
mote interface, such as monitoring the beam position over time.

BeamView.NET must be running in the background to collect any informa-
tion from the camera.

Set Up Remote Mode

Both BeamView.NET and the Remote Data Logging application must be
configured before a connection can be established.

In general, here is an overview of the steps to run in Remote Mode. De-
tailed instructions and more information about set-up are in the sections
that follow.

1.  Start the BeamView.NET software and configure settings for the
inter-face needed to use. (Setup tab > select Remote Mode)

2.  After settings are configured, turn on Remote Mode in Beam-
View.NET (Home tab > Remote Control icon). This provides a fast,
single-click control for a connection.

Connect a camera, which BeamView.NET then automatically detects.

4. Start the Remote application (such as the BeamView Data
Logger Utility from Coherent) and enable the connection.

5. Enter host commands described in 'Remote Mode Host Communica-
tion Protocols’ (p. 163).

Define Communications Interface

Set-up for Remote Mode varies by the interface, described in more detail
in the following sections.These communication interfaces are supported in
the BeamView.NET software:

d RS-232 Serial Interface
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d TCP/IP network protocol

To configure Remote Mode in BeamView.NET, go to the Set-up Tab,
shown in Figure 8-1.

> BeamView. MET
Home Edit View Capture Analysis Setup Help

. Calibrate Power] Remate Mode I

Scale Factor
Camera  Focal Length Password

Figure 8-1. Setup Tab

The dialog box shown in Figure 8-2 for TCP/IP settings is first displayed.

. Click the check box to 'Enable Remote Mode' and the dialog box
changes to show 'Listening' at the bottom, as shown in Figure 8-2.

. The default Port number is assigned by the BeamView.NET software.
Enter the Port, Baud Rate, Data Bits, Stop Bits, and select Parity, then

click OK.
Remote Communication Settings n Remote Communication Settings n
[ Enable Remote Mode [l Enable Remote Mede
Remote Configurations Remote Configurations
TCPAIP | RS232 TCR/IP | RS232

Local Host USWIXWO0003 Local Host USWIXWO0003

IP Address 10.68.3.78 P Address 10.68.3.78

Port 1024 Port 1024

| Cancel | | OK | ( Ligtening ] | Cancel | | K

Figure 8-2. Setup — Remote Mode — TCP/IP Connection

When users select the tab for an RS-232 connection, the contents
change.

. Click the checkbox to 'Enable Remote Mode' and the dialog box
changes to show “Connected” at the bottom, as shown in Figure 8-3:

In the Remote Communications Settings dialog box, use the controls list-
ed in Table 8-1 to select an interface:
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Remote Communication Settings n Remote Communication Settings n
[lEnable Remete Meode Wl Enable Remete Mode ]
Remate Configurations Remote Configuraticns

TCP/IP| RS232 TCP/IP | RS232
Com Paort COM3 o Com Port COM3
Baud Rate 19200 - Baud Rate 18200
Data Bits ] o Data &
Stop Bits 1 V Stop Bits 1
Parity None " Parity Nane
| Cancel oK | I Connected J | Cancel | | oK
Figure 8-3. Setup — Remote Mode — RS-232 Connection
Table 8-1. Controls for Communication Settings
Control Description
Enable This checkbox toggles between Enable and Disable.
checkbox | «  When checked, Enable connects the Serial COM after OK is
clicked.
*  When not checked, disconnects the Serial COM after OK is
clicked.
To switch interfaces, first ensure that the checkbox for the inter-
face that is NOT to be used is not checked.
OK button | Saves the current settings and connects or disconnects the
Serial Port.
Cancel Closes the Dialog Box without making any changes to existing
button settings.
8.1.2 Serial Interface Connection
A Serial RS-232 interface requires both a hardware and software connec-
tion.
8.1.2.1 Serial Interface — Cable Requirements

The BeamView.NET software uses the serial port on the host PC for com-
munication. Interface to this port requires a Null Modem RS-232 cable.
Table 8-2 shows the pin-outs:
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8.1.2.2

Table 8-2. Serial Null Modem Cable Pin-Outs

9-Pin D-Type 9-Pin D-Type | or... 25_};2;'3'
Beam-
View.NET on Remote PC Remote PC
Local PC
DCD 1 1 | bcp 8 | DCD
RX 2 3 | TX 3 | TX
™ 3 2 | RX > | RX
DTR 4 6 | DSR 6 | DSR
GND 5 5 | GND 7 | GND
DSR 6 4 | DTR 20 | DTR
RTS 7 8 |CTs 5 |CTs
CTS 8 7 | RTS 4 |RTS
RI 9 9 |RI 22 |R

Serial Interface — Software Communication Settings

This section describes the BeamView.NET communication settings for the
Serial RS-232 interface.

1.  Go to the Setup tab in the BeamView.NET software.

2. Click Remote Mode in the Settings section of the toolbar.

3.  Ensure that the checkbox for 'Enable’ is not checked, then click the
tab for RS232. The following dialog box is displayed:

BeamView.NET remembers the 'Connected’ state; the application starts
up with the Serial Port connected in the state Box is Connected.

The Available and Recommended settings are listed in Table 8-3:
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@ Remote Communication Settings >
Enable Remote Mode

Remaote Configurations

TCR/IP | RS232
Com Port COM3

Baud Rate 19200

Parity Naone

Connected [ cancel |[ ox |

Figure 8-4. Serial Interface Communication Settings

Table 8-3. Communication Settings for RS-232

. . Recom-
Setting Options mended
COM Port COM1, COM2, COM3, COM4 No Hand shaking
Baud 1200, 2400, 4800, 9600, 19200, 38400, 115,200 bps
Rate 115200
Data Bits 7,8 8 Data Bits
Stop Bits 1,2 1 Stop Bit
Parity None, Even, Odd No Parity

TCP/IP Interface

The remote TCP/IP application may be installed on the same computer as
BeamView.NET, but this is not necessary. All that must be specified at the
client is the BeamView.NET server TCP/IP host name or IP address and
the port number.

TCP/IP Hardware Requirements

The only requirement to use the TCP/IP protocol is connecting the PC on
which the BeamView.NET software is installed to the network.
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8.1.3.2

8.14

8.2

TCP/IP Communication Settings

For TCP/IP settings:

1.  Go to the Setup tab in the BeamView.NET software.
2.  Click Remote Mode in the Settings section of the toolbar.
Figure 8-5 shows the dialog box that is displayed for the TCP/IP interface:

@ Remote Communication Settings x

Enable Remote Mode

Remaote Configurations

Connected | Cancel |[ ok |

Figure 8-5. TCP/IP Communication Settings

If TCP/IP is selected, the properties of the Local Host and IP address are
seen in the window; these are fixed as the computer is a TCP/IP server to
a client application. Port number 1024 is used as the default TCP/IP port
in the BeamView.NET application.

Run Remote Mode in BeamView.NET

To run Remote Control in BeamView.NET:

Go to the Home tab and click the Remote Control icon in the toolbar,
shown in Figure 8-6. This provides a fast, single-click control for a connec-
tion.

Remote Data Logging Utility

This section provides an example about using remote control with the
BeamView Data Logging Utility, a software application. To download the
Data Logging Utility for BeamView.NET:
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B Srarueew o
arE T dira Cartine Srddris s llsEe

. d _Q'J:-"l 'L\-'\-'d\- ArLAE -- Lr.h
1 Bpetae wilaf 4 0l .
e v s

t:p.- w g Cepareg W dss 3. PosFler  Coppai-Lommior; Vis Couds] 8 PolarFlat orwT

Femote
Control

Figure 8-6. Remote Control Icon on Home Tab

1.  Go to the Coherent website and locate the following page:
https://www.coherent.com/resources/

2. Search for ‘BeamView.NET'.

Click the name of the Data Logging Utility and download the file
BeamViewNet Data Logger v2002.exe to the computer.

For BeamView.NET software, v2.0 of the BeamView Data Logging Utility
must be used. This software supports cameras listed in 'Products Sup-
ported’ (p. 7).

8.2.1 Connect the Data Logging Utility

To set up and connect the BeamView Data Logging Utility to run with the
BeamView.NET software:
1.  Start the BeamView.NET software, shown in Figure 8-7.

2. Make sure that there is a camera connected and that users can collect
information.

3.  Verify the serial number for the camera; this is displayed in the bottom
right corner of the BeamView.NET window.

8.2.1.1 Verify the Connection

The following test validates the settings and communication that are need-
ed using the Send/Receive functions. Perform this test before work is
continued.
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o - | EEAMEw — o w

E Home  Edit  Wiew  Capture  Anabmiz Sewp  Help

Sample ...
Camera Model:  no Camera Attached

@ General

(~) Ellipticity

@ Gaussian Fit

@ Aperture Uniformity

@ Image Uniformity

@ Flat Top

| | putse | Cont [ T

Figure 8-7. BeamView.NET Software

1.  Open the BeamView Data Logger Utility, shown in Figure 8-8.

€3 conerenT o

Connect io Bepmviey Calculyticon Ouery (mober up o § caloslations 5o run each loop

Ca T ']

Figure 8-8. Data Logger - Run BeamViewNet Data Logger v2.0

2. In the BeamView Data Logger window, go to Connect to BeamView
and click Connect, as shown in Figure 8-9.

3. Enter a command in the Send / Receive window. See 'Remote Mode
Host Communication Protocols’ (p. 163) for a list of available host
commands.
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& Beamiiew Data Logger v20001 ]
€3 corerent. ety
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Figure 8-9. Data Logger - Connect to BeamView

For example, enter *idn? In the Send window and click the Send
button, as shown in Figure 8-10:

& gaymiviey Dty Logoer V20000 -'"
€3 corerenT. ety
Connect o Beamivewy Calculation Cuery (nter up to § caloslations 3 mun esch kop)

1P Acdress:
Etawrt
P B
Musber of Loeps: 3 = Timeimiervat | e L

o Enatie Connaction
Aun Contnucusty
Copture Images

A Time Famg

Sun Siop
Crwang File
Sarred Rt .
il Winie o file
“n
Sasfud
Receive

Figure 8-10. Data Logger - Send Command

The response from the camera is displayed in the Receive window, as
shown in Figure 8-11.
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Figure 8-11. Data Logger - Response from Command

8.2.1.2 Using XY Positional Data

For users who want to use the BeamView data logger to provide XY posi-
tional data to track beam movement, the following additional XY Position
settings can be used for reference to help with this task.

o mm (microns)

o um (millimeters)
° cm (centimeters)
° m (meters)

° inch

° pixel

o urad (radians)

° mrad

° rad

° degrees
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8.2.2 Example Using a Remote Command

Following is an example about how to set up a query for the XY centroid
position of the laser beam. This sample test was set up without a laser to
track position, but the process works the same.

In the Calculation Query section, shown in Figure 8-12:

1. Enter the command “ARCRV?”.

Other commands are listed in the section, 'Remote Mode Host
Communication Protocols’ (p. 163).

2.  Setthe query to request (loop) the position ten times. Note that there
is a checkbox to click if it is desired to run this continuously.

3. Set a time interval (such as three seconds) to wait each time before
the next query.

4, If desired, click the checkbox to add a time stamp to the results file.

= BeamiView Data Logger w2001

3 coHerENT. Help
. B - - I z ,
Connect 1o Beambiew Calculation Query {enter up 1o 5 caloul ations ta rum sach loop)
P Address: ARCEYT
Start
Poat Mumber
Mumber of Locps 10— Time intera: |3 | D
+ Enable Conrectian
Rusrs Contimuscnusky
Caplure Images
o Audd T Slamp
A Ziop L s & S1am )
Create File
Send/Receive
Fend Wirite 1o File

Send

Recesss

Figure 8-12. Query XY Centroid Position
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Users can run the query now, or set up a location on the desktop to collect

the data.

5. Click Create File and, in the standard Windows browser, select a desti-

nation.

6. Click the checkbox for Write to File to save a text file. If this checkbox
is not clicked, the results are displayed only in the window.

7. Click Start.

The resulting .txt file is collected on the desk top location that was select-
ed. This example text file shown in Figure 8-13 shows the time stamps

and XY locations

data logger testl3.txt - Notepad

Eile Edit Format

11-18-2028
11-18-2028
11-18-2028
11-18-2028
11-18-2028
11-18-2828
11-18-2828
11-18-2828
11-18-2828
11-18-2828

Figure 8-13. Data Logger - Text File Collected

15:
15:
15:
15:
15:
15:
15:
15:
15:
15:

Yiew Help

57:
57:
57:
57:
57
57:
57:
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1@
13
16
19
22
25
28
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9.1

9.2

Remote Mode Host Communication Protocols

Remote Mode Host
Communication Protocols

Almost any operation that can be performed or controlled via the keyboard
on the BeamView.NET software can be done using remote control com-
mands through the RS-232 serial interface or the TCP/IP interface.

Before Work is Started

To use the Remote feature, users must first set up the Remote connec-
tion. This generally requires both hardware and software (a terminal pro-
gram that supports the TCP or RS-232 protocol). The requirements vary
by interface. Go to 'Set Up for Remote Mode’ (p. 34) for instructions.

After image samples have been captured, data can be sent over the
RS-232 port.

Commands in Remote Mode

This section describes the command set in the BeamView.NET software.
These commands can be used to turn analysis functions on or off, set
configuration parameters (aperture size and shape, Trigger mode, etc.),
set Pass/Fail limits, and receive captured image data.

The following commands are available in Remote Mode:
d Help commands (p. 164)

. File commands (p. 165)

. Edit commands (p. 166)

d Control commands (p. 167)

. Capture Parameter commands (p. 177)

° Analysis commands (p. 181)

° Analysis Fault Actions and Units Parameters (p. 185)

d System configuration commands (p. 185)
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In these commands, replace the ‘XX’ placeholder with any valid calcula-
tion that is listed in the tables.

9.2.0.0.1 Syntax:
For example, to Query for the Result calculation for the Peak (X, Y) R, is-
sue the following command:
ARPXV?
where:
° Analysis Result: AR
. PX = Peak (X,Y)R (the expected calculation)
. V? = Query for Value
9.3 Help Command
Table 9-1 describes the output from Help commands in Remote Mode.
Table 9-1. Help Commands
Command Description Example
HELP;ALL; Displays all commands. HELP
HELP; command; Displays the command, its HELP;BDIR;
parameter. This command BDIR xxx?

provides more details than a
simple HELP command.

Use only the alphabetic part of
the command. The command

starts and terminates with a”;”.

Query the Live Image Profile data for the
specified image row.

Example: Enter BDIR 1207 Returns the
Image Profile Data for row 120.
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Table 9-1. Help Commands (Continued)

Command Description Example

HELP;command; HELP; PFDVR;

PFDVR?

Query the Pass Fail Range for divergence.
Example: Enter PFDVR? Returns the
Minimum Value followed by the Maximum
Value for Pass/Fail on divergence.

PFDVR Set the Pass Fail Range for diver-
gence. Format is PFDVR;x.x,y.y; where x.x
is the minimum and y.y is the maximum.

HELP;command; HELP; SAMPLE;

SAMPLE?

Query the Active Beam View Sample.
Example: Enter SAMPLE? Returns the
active sample number.

SAMPLE ; xxx; Set the Active Beam View
Sample.

Example: Enter SAMPLE ; 4; Sets the
active sample number to 4.

9.4 File Commands

Table 9-2 shows the file commands.

NOTIC

The file path must first be created on the hard drive before using the
File commands.

Table 9-2. File Commands

Command Description Example

FLCL; Full file path; File Configuration Load from | FLCL;C:\BV\USER32\Config 2.ATC;
specified file name. OK
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Table 9-2. File Commands (Continued)

FLCS; Full file path;

File Configuration Save to
specified file name.

FLCS;C:\BV\USER32\Config 2.ATC;
OK

FLST; Full file path;

File Save Test As to specified
file name.

FLST;C:\BV\USER32\Test 8.ATS;
OK

FLEI; Full file path;

File Export Image to speci-
fied file name.

FLEI;C:\BV\USER32\Image 5.BIN;

FLSI;Image File Select Images from FLSI;012,024,044;
numbers separated specified images. This OK
by commas; command needs to be

preceded by either FLST or

FLEI. Commas must sepa-

rate the image numbers.

Select ALL images. FLSI;ALL;

OK

FLSTL; Load .ats
files

Load all .ats files.

FLSTL;C: \BV\USER32\HasToWork2 .AT
S;

FLII; Load .bin, .img,

Load .bin, .img, and .png files

FLII;C:\BV\USER32\Image 5.bin;

and .png files FLII;C:\BV\USER32\Image 5.img;
FLII;C:\BV\USER32\Image 5.png;
Imports file from specified FLII;C:\BV\USER32\802samples-
location UV.bin;
9.5 Edit Commands
Table 9-3 shows the Edit commands.
Table 9-3. Edit Commands
Command Description Example
CLIB;ALL; Clear the Image buffer CLIB;ALL;
OK
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9.6.1

Remote Mode Host Communication Protocols

Control Commands

Table 9-4 shows the first two letters of the command language:

Table 9-4. Control Commands

Sub- . ..
Description
command
AR Analysis Result Calculation sub-command
PF Pass Fail Calculation sub-command
SR Statistics Result Calculation sub-command

Calculation Commands

Table 9-5 shows the next two letters apply to each of the calculations.
Note that these are listed bu function and are not in alphabetical order.

Table 9-5. Calculation Sub-Commands

Sub-command Description
PX Peak (X, Y)R
CR Centroid (X, Y) R
PR Peak % Response
TP Total Relative Power (CW only)
TE Total Relative Energy (Pulsed only)
EA Effective Area
PD Peak Power Density (CW only)
FL Fluence (Pulsed only)
ED Effective Diameter
AD Aperture Diameter
DW D4 Sigma Width
DD D4 Sigma Diameter
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Table 9-5. Calculation Sub-Commands (Continued)

Sub-command Description
DV Divergence
KE Knife Edge
SD Slit Diameter
EM Ellipticity - Major, Minor
EN Ellipticity — Angle
EC Ellipticity — Circularity
GO Gaussian Fit Coefficient
GC Gaussian — Fit Centroid
GP Gaussian - Fit Peak Intensity
GD Gaussian - Fit Diameter
GR Gaussian - Roughness of Fit
PA Peak To Average
AM Aperture Uniformity — Min, Mean, Max
AsS Aperture Uniformity — Sigma, RMS
AP Aperture Uniformity — % Power in Aperture (CW only)
AE Aperture Uniformity — % Energy in Aperture (Pulsed
only)
IM Image Uniformity — Min, Mean, Max
9.6.2 Calculation Sub-Commands

Table 9-6 shows the sub-commands for Calculations. Replace the ‘XX’
placeholder with a valid calculation listed in the tables.For more information
about setting Pass/Fail options, see 'Fault Actions’ (p. 135).

9.6.3 Set Sub-Command

Table 9-7 shows the sub-commands in Remote Mode to Set various pa-
rameters:
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Table 9-6. Calculation Sub-Commands

Command Description Examples
ARXXF? Query using Fluence as the Clip Level for calculation AREDF?
(currently only works on Effective Diameter). ON
AREDF?
OFF
ARXXF Set using Fluence as the Clip Level for calculation (currently | AREDF;ON;
only works on Effective Diameter). ON
AREDF;OFF;
OFF
ARXXL? Query Fluence Value as the Clip Level for calculation AREDL?
(currently only works on Effective Diameter). 50.0
ARXXL Set Fluence Value as the Clip Level for calculation (currently | AREDL;50.0;
only works on Effective Diameter). 50.0
ARXXO0? Query the ON/OFF status for calculation. ARDVO?
OFF
ARDVO?
ON
ARXXO Set the ON/OFF status for calculation. ARDVO;OFF;
OFF
ARDVO;ON;
ON
ARXXP? Query the Parameter Value for calculation. ARDVP?
86.5
ARXXP Set the Parameter Value for calculation. ARDVP;75.0;
Example: Enter ARXXP;x.y; sets the value. 75.0
ARXXU? Query the Units for calcula- ARDVU?
tion. Divergence uses Posi- Micrometers UMRP or UMRS
tion units. Aperture and Effec- Millimeters MMRP or MMRS
tive Diameter use Spatial Centimeters CMRP or CMRS
units. Meters MTRP or MTRS
Inches INCP or INCS
Pixels PIXP or PIXS
Micro radians URDP or URDS
Milliradians MRDP or MRDS
Sad'ans RADP or RAD
egrees DEGP or DEGS
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Table 9-6. Calculation Sub-Commands (Continued)

Command Description Examples
ARXXU Set the Units for calculation. ARXXU ; XXXX ;
Micrometers by UMRP
Position MMRP
Millimeters by Posi- | cMRP
tion MTRP
Centimeters by INCP
Position PIXP
Meters by Position URDP
Inches by Position MRDP
Pixels by Position RADP
POSitionM|cro radians by DEGP
Milliradians by MRS
" MMRS
Position
Radians by Position CMRS
Degrees by Posi- MTRS
tion INCS
Spatial Micrometers PIXS
Spatial Millimeters URDS
Spatial Centimeters | MRDS
Spatial Meters RADS
Spatial Inches DEGS
Spatial Pixels
Spatial Micro
radians
Spatial Milliradians
Spatial Radians
Spatial Degrees
DIMENSIONLESS UNITS Percent % PERCENT
Degrees DEGREES
Ratio RATIO
Coefficient COEFFICIENT
INTENSITY UNITS Microwatts/CM? UWCM
Milliwatts/CM? MWCM
Watts/CM? WCM2
Kilowatts/CM?2 KWCM
Microjoules/CM? UJCM
Millijoules/CM? MJICM
Joules/CM? JCM2
Kilojoules/CM? ®JCM
Digital DIGI
% Response PRCT
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Table 9-6. Calculation Sub-Commands (Continued)

Command Description Examples
POWER UNITS Microwatts PUWT
Milliwatts PMWT
Watts PWAT
Kilowatts PKWT
Gigawatts PGWT
ENERGY UNITS Microjoules PUJL
Millijoules PMJL
Joules PJUL
Kilojoules PKJL
Gigajoules PGJL
TIME UNITS Milliseconds MSEC
Seconds TSEC
Minutes TMIN
AREA UNITS Micrometers AUMT
squared AMMT
Millimeters squared | acMT
Centimeters AMTR
squared AINC
Meters squared APIX
Inches squared
Pixels squared
PFXXR? Query the Pass/Fail Range for calculation. PFDVR?
2000 3000
PFXXR Set the Pass Fail Range for calculation. For more informa- PFDVR;2.0,3.0;
tion about setting Pass/Fail, see 'Fault Actions’ (p. 135). 2.0 3.0
Example: Enter PEXXR;x.x,y.y; sets the value
PFXX0? Query the Pass/Fail ON/OFF status for calculation. PFDVO?
OFF
PFXXO Set the Pass/Fail ON/OFF status for calculation. PFDVO;OFF;
For more information about setting Pass/Fail, see 'Fault OFF
Actions’ (p. 135). PFDVO;ON;
ON

Table 9-8 shows examples of the Set sub-command. Replace “XX” in the
command with the DV (Divergence calculation) from the Calculation
sub-command table.
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Table 9-7. Set Sub-Commands

Sub- o
Description
command
O;ON; Set ON/OFF value
P; XX; Set Parameter value
U; XX; Set Units
R; XX; Set Range

Table 9-8. Examples of Set Sub-Commands

Sub- o
Description Notes
command
ARXXO Set the ON/OFF status for calculation. ARDVO;OFF;
OFF
ARDVO;ON;
ON
ARXXP Set the Parameter value for calculation. ARDVP;75.0;
Example: Enter ARXXP;x.y; 75.0
Sets the value.
9.6.4 Query Sub-Command
Table 9-9 shows the sub-commands in Remote Mode to Query various
values.
Table 9-9. Query Sub-Commands
Sub- e
Description
command

v? Query the value

M? Query the minimum value

N? Query the mean value

X? Query the maximum value
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Table 9-9. Query Sub-Commands (Continued)

Sub- -
Description
command
s? Query the sigma value
0? Query the ON/OFF status

Table 9-10 shows the Query sub-commands. Replace “XX” in the com-
mand with the DV (Divergence calculation) from the Calculation sub-com-
mand table.

Table 9-10. Examples of Query Sub-Commands

Sub- o
Description Example
command

ARXXV? Query the value for calculation. ARDVV?
4252

PFXXV? Query the Pass/Fail value for calculation. PFDVV?
FATL
PFDVV?
PASS

SRXXM? Query the statistics minimum value for calculation. SRDVM?
4229

SRXXN? Query the statistics mean value for calculation. SRDVN?
4257.5730

SRXXX? Query the statistics maximum value for calculation. SRDVX?
4291

SRXXS? Query the statistics sigma value for calculation. SRDVS?
14718118

9.6.5

Distance Units

Distance Units can be either Positional or Spatial
. Positional units correspond to a point.

d Spatial units correspond to a surface area.
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9.6.5.1 Positional Units

The calculations that use Positional Distance Units are listed in Table 9-

11:
Table 9-11. Commands for Distance Units
Sub- Description
command

PX Peak (X, Y)R

CR Centroid (X, Y) R

DV Divergence

9.6.5.2 Spatial Units

The calculations that use Spatial Distance Units are listed in Table 9-12:

Table 9-12. Commands for Spatial Distance Units

Sub- o

command Description

ED Effective Diameter

AD Aperture Diameter

DW d4 Sigma Width

DD d4 Sigma Diameter

KE Knife Edge

SD Slit Diameter

EM Ellipticity - Major, Minor

GC Gaussian Fit - Centroid

GD Gaussian Fit - Diameter
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9.6.6 Profile and Image Data Commands

Table 9-13 shows the Profile and Image Data commands.

Table 9-13. Profile and Image Data Commands

Command Description Example
BDIPH? Query the image profile X-axis from the Crosshair. BDIPH?
These display a profile only if the CMODE is Run. Returns profile example

PROFILE EXAMPLE:
0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,5,4,7,18
,29,22,23,26,39,36,26,32,41,39,48,51,51,
55,63,90,79,84,100,107,99,96,94,103,144,
159,
15,158,169,174,188,187,198,179,163,106,1
07,102,84,80,69,73,73,65,65,56,60,61,47,
34,27,18,14,11,10,7,5,6,8,5,1,0,0,0,0,0,

0,0,0,0,0,0,0,0,0,0
BDIPV? Query the image profile Y-axis from the Crosshair. This | BDIPV?

displays a profile only if the CMODE is set to Run. Returns profile example
BDRPH? Query the reference profile X-axis. This displays a BDRPH?

profile only if the CMODE is set to Run, and Ref. Profile | Returns profile example
ON, and Ref. Profile is set to GAUSS FIT

BDRPV? Query the reference profile Y-axis This displays a BDRPV?
profile only if the CMODE is set to Run, and Ref Profile | Returns profile example
ON, and Ref. Profile is set to GAUSS FIT.

BDGFH? Query the Gaussian fit curve X-axis. This displays a BDGFH?
profile only if the CMODE is Run, and FIT Profile ON, Returns profile example
and Ref. Profile is set to GAUSS FIT.

BDGFV? Query the Gaussian fit curve Y-axis. This displays a BDGFV?
profile only if the CMODE is set to Run, and FIT Profile | Returns profile example
ON, and Ref. Profile is set to GAUSS FIT.

BDIR xxx? Query the data for specified image row xxx. BDIR 1207
Returns profile example

BDCL? Query the current Crosshair location. BDCL?
1.171 -1.260

9.6.7 Miscellaneous Commands

Table 9-14 shows miscellaneous Remote commands:
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Table 9-14. Miscellaneous Commands

Command Description Example
*IDN? Displays the System ID and Revi- *IDN?
sion number. BeamView.NET
32Bit Release 5.0.1.4
TRM? Queries terminal mode for TRM?
displaying image or profile data with | ON
a CRLF after each 80-byte line. TRM?
OFF
TRM Sets terminal mode for displaying TRM;ON;
image or profile data with a CRLF ON
after each 80-byte line.For LabView | qryM.oFF;
set TRM to OFF. OFF
CMODE? Query Capture Mode STOP, RUN, CMODE?
LIVE STOP
CMODE?
RUN
CMODE?
LIVE
CMODE ;R Set Capture Mode to Run. CMODE ;R
RUN
CMODE; S Set Capture Mode to Stop. CMODE; S
STOP
CMODE; L Set Capture Mode to Live. CMODE ; L
LIVE
SAMPLE? Query active sample number. SAMPLE?
112
SAMPLE ; XXX ; Set active sample number. SAMPLE;100;
100
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Table 9-14. Miscellaneous Commands (Continued)

Command Description Example
SCAP Set Active Camera SCAP;1;
For use when more than one 1
cameras is connected t Beam- SCAP;2;
View.NET (Camera 1, Camera 2, 2
and so on). SCAP;5;

An error is displayed when selecting | grror :Exceeds number of cams
a camera number that is greater

than the number of available

cameras.
SCAP? Query Active Camera SCAP?
For use when more than one 1
cameras is connected t Beam- SCAP?
View.NET (Camera 1, Camera 2, 2
and so on). SCAP?
3
SCAP?
4
9.7 Capture Parameter Commands

Table 9-15 shows commands that set capture parameters.

Table 9-15. Capture Parameter Commands

Command Description Examples

sSccs? Query Capture Source CW/Pulsed sccs?
CwW

SCCSs?
PULSE

SCCs Set Capture Source CW/Pulsed SCCS;CW;

CwW

SCCS; PULSE;
PULSE
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Table 9-15. Capture Parameter Commands (Continued)

Command Description Examples
SCCT? Query Capture Trigger SCCT?
SYNC (Freq. in Hz) SYNC 10
SCCT?
ASYNC ASYNC
AUTO (Threshold in %) SCCT?
AUTO 40
SCCT Set Capture Trigger SCCT; SYNC 10;
SYNC (Freq. in Hz) 10
SCCT; ASYNC;
ASYNC ASYNC
AUTO (Threshold in %) ngT" AUTO 40;
SCCI? Query Capture Interval SCCI?
CONT
Continuous SCCI?
TIME 1000
Time (Interval mS, Sec, Min) SCCI?
PULSE 2
Pulse (Count) SCeI?
On Key Press KEY
SCCI~?
One Shot ONE SHOT
SCCI Set Capture Interval - Continuous SCCI;CONT;
CONT
Time SCCI;TIME 1000
1000
Pulse (Count) SCCI;PULSE 10;
10
On Key Press SCCI :KEY:
One Shot KEY
SCCI ;ONESHOT;
ONESHOT
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Table 9-15. Capture Parameter Commands (Continued)

Command Description Examples
SCCR? Query Capture Resolution SCCR?
HALF 1
Half Resolution, Full Array ON SCCR?
HALF O
Half Resolution, Full Array OFF SCCR?
_ FULL 1
Full Resolution, Full Array ON SCCR?
Full Resolution, Full Array OFF FULL 0
SCCR?
Frame Resolution, Full Array ON FRAME 1
SCCR?
Frame Resolution, Full Array OFF FRAME 0
SCCR Set Capture Resolution SCCR;HALF,1;
HALF,1
Half Resolution, Full Array ON SCCR;HALF,0;
HALF,0
Half Resolution, Full Array OFF SCCR;FULL,1;
_ FULL,1
Full Resolution, Full Array ON SCCR;FULL, 0;
Full Resolution, Full Array OFF FULL, 0
SCCR;FRAME, 1;
Frame Resolution, Full Array ON FRAME, 1
SCCR;FRAME, 0
Frame Resolution, Full Array OFF FRAME, 0
SCCp? Query Capture Pan (x, y) SCCP?
X=0 Y=0
SCCP Set Capture Pan (x, y) SCCP;48,0;
This example is for Full Array only. SCCP?
48,0
SCYI? Query Capture Y axis Invert SCYI?
OFF
SCYI?
ON
SCYI Set Capture Y axis Invert SCYI;ON;
ON
SCYI;OFF;
OFF
SCBZ? Query Buffer Size SCBZ?
256
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Table 9-15. Capture Parameter Commands (Continued)

Command Description Examples
SCBZ Set Buffer Size SCBZ;256;
256
SCBZ;128;
128
SCBL"? Query Buffer Location SCBL"?
Hard Drive HD C:\TEMP
SCBL"?
Frame grabber FG
SCBL Set Buffer Location
The buffer directory set to the HD. SCBL;HD,C:\TEMP;
C:\TEMP
Set the buffer on the Frame grabber SCBL;FG;
(FG). FG
SCBA? Query Buffer Analysis Normal/Burst SCBA?
NORMAL ON is EACH sample on GUI NORMAL ON
Capture Continuously is True SCBA?
NORMAL OFF is EACH sample on GUl | NORMAL OFF
Capture Continuously is False SCRA?
Burst is Capture ALL samples on GUI BURST
SCBA Query Buffer Analysis Normal/Burst
SCBA ;NORMAL ON;
NORMAL ON is EACH sample on GUI NORMAL ON
Capture Continuously is True SCBA ;NORMAL OFF;
NORMAL OFF is EACH sample on GUl | NORMAL OFF
Capture Continuously is False SCBA ; BURST;
Burst is Capture ALL samples on GUI BURST
SCBS? Query Background Subtract SCBS?
ON ON
SCBS?
OFF OFF
SCBS?
Capture CAP
SCBS Set Background Subtract ON/OFF/Capture SCBS;ON;
ON
Capture (CAP) may fail with ERROR 026 when SCBS;OFF;
the camera picks up too much light while OFF
capturing a background map.The user can set a SCBS ;CAP;
background bias value using the SCBB CAP
command.
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Table 9-15. Capture Parameter Commands (Continued)

Command Description Examples
SCBB? Query the background Bias SCBB?
1
SCBB Set Background Bias. SCBB retries to capture a | SCBB;4;
Background Map with the users entered value. 4
The Bias has to be between 1 and 8

9.8 Analysis Commands

Table 9-16 shows the commands used to configure the apertures Inclu-

sion area.
Table 9-16. Analysis Commands
Command Description Example
ACCP? Query Crosshair Position OFF/ | ACCP?
Centroid/Peak/User OFF
ACCP?
USER COORD
ACCP?
CENTROID
ACCP?
PEAK
ACCP Set Crosshair Position Off/ ACCP;OFF;
Centroid/Peak/USE COORD OFF
ACCP; CENTROID;
CENTROID
Move crosshair ACCP;USER COORD 0.51,0.41;
ACCA? Query Crosshair USER ACCA?
ANGLE, ELLIPTICAL USER ANGLE 23.4
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Table 9-16. Analysis Commands (Continued)

Command Description Example
ACCA Set Crosshair USER ANGLE, ACCA;USER ANGLE;
ELLIPTICAL USER ANGLE
ACCA;ELLIPTICAL;
ELLIPTICAL
Change the angle of the ACCA;USER ANGLE 23;
Crosshair
ACIP? Query Image Profile ON/OFF ACIP?
ON
ACIP Set Image Profile ON/OFF ACIP;OFF;
OFF
ACIP;ON;
ON
ACRP? Query Reference Profile ON/ ACRP?
OFF, Profile/Gauss Fit GAUSS FIT
ACRP?
REFERENCE FIT
ACRP?
OFF
ACRP Set Reference Profile ON/OFF, | ACRP;ON;
Profile/Gauss Fit. Doesn't actu- | ON
ally start on GUl unless Image | acrp;GAUSS FIT:
profile is on, and Gaussian Fit. | cayss FIT
ACFP? Query Fit Profile ON/OFF, ACFP?
Gauss Fit GAUSS FIT
ACFP?
OFF
ACFP Set Fit Profile ON/OFF, Gauss | ACFP; GAUSS FIT;
Fit GAUSS FIT
ACFP;OFF;
OFF
ACFP;ON;
ON
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Table 9-16. Analysis Commands (Continued)

Command Description Example

ACAS? Query Aperture Shape ACAS?
OFF OFF
ACAS?
CIRCLE CIRCLE
ACAS?
SQUARE

ELLIPSE ACAS?
ELLIPSE

RECTANGLE ACAS?
RECTANGLE

SQUARE

ACAS Set Aperture Shape ON/OFF/ ACAS;OFF;
Circle/etc. OFF

ACAS;ON;

ON
ACAS;CIRCLE;
CIRCLE

ACAZ? Query Aperture Size ACAZ?

APER DIAMETER Width=260 Height=260
ACAZ?

USER_SIZE Width=2200 Height=2200
ACAZ?

DIVERGENCE Width=260 Height=260
ACAZ?

GAUSSIAN DIAMETERS Width=260 Height
260

ACAZ?

EFF_DIAMETER Width=260 Height=260
ACAZ?

D4_SIG _WIDTH Width=260 Height=260
ACAZ?

D4_SIG_DIAM Width=260 Height=260
ACAZ?

KNIFE EDGE Width=260 Height=260
ACAZ?

SLIT DIAMETER Width=260 Height=260
ACAZ?

ELLIPTICAL_AXES Width=260 Height=260
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Table 9-16. Analysis Commands (Continued)

Command Description Example
ACAZ Set Aperture Size (can setthe | ACAZ;USER SIZE 1.2,1.4;
width and height for USER_- USER_SIZE 1.2,1.4
SIZE only).The user can have | pcaz»
different width and heights for | ysgr STIZE Width = 1.2 Height =
EII|pse§ and Rectangles only. ACAZ; USER SIZE 1.00,1.4;
The Height returned for a USER SIZE 1.2.1.4
Square or Circle will be the — Teree
same as the Width. ACAZ?
USER_SIZE Width = 1.2 Height =1.2
ACIA? Query Inclusion Area ACIA?
H = 240 V = 260
ACIA Set Inclusion Area ACIA;120,240;
120, 240
ACIA?
H = 120 V = 240
ACIL? Query Inclusion Location ACIL?
X =119 ¥ = 119
ACIL Set Inclusion Location ACIL;120,119;
X =120 Y = 119
ACIL?
X =120 ¥ = 119
ACIO? Query Inclusion ON/OFF State | ACIO?
OFF
ACIO?
ON
ACIO Set Inclusion ON/OFF State ACIO;ON;
ON
ACIO;OFF;
OFF
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Table 9-16. Analysis Commands (Continued)

Command

Description Example

ACRL?

Query Reference Position ACRL?

OFF

ACRL?

CROSS HAIR X = .1 Y = .2
ACRL?

USER COORDINATE X = .1 Y = .2
ACRL?

CENTROID MIN X = .1 Y = .2
ACRL?

CENTROID MEAN X = .1 Y = .2
ACRL?

CENTROID MAX X = .1 Y = .2
ACRL?

PEAK MIN X = .1 Y = .2
ACRL?

PEAK MEAN X = .1 Y = .2
ACRL?

PEAK MAX X = .1 Y = .2

ACRL

Set Reference Position (can ACRLOFF
only change coordinates for OFF;
USER COORDINATE) OFFACRL;ON;

ON

ACRL;USER COORDINATE .1,.12;
USER COORDINATE .1,.12

ACRL?

USER COORDINATE X = .1 Y = .12
ACRL;CROSS HAIR;

CROSSHAIR

ACRL?

CROSSHAIR X = .1 Y = .12

9.8.1

9.9

Analysis Fault Actions and Units Parameters Commands

Table 9-17 shows commands that set and query the analysis fault actions
and units parameters.

System Configuration Commands

Table 9-18 shows commands that set and query the Test Information pa-
rameters.
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Table 9-17. Analysis Fault Actions and Units Parameters Commands

Command Description

Examples

SCFA? Query Fault Actions

Beep

Stop

Reverse Background Color
Image

Save

Discard

TTL

SCFA?
BEEP
SCFA?
STOP
SCFA?
REVERSE BACKGROUND COLOR
SCFA?
IMAGE
SCFA?
SAVE
SCFA?
DISCARD
SCFA?

TTL PULSE

SCFA Set Fault Actions
Beep/Stop/Save/Discard/TTL

TURNS ON BEEP

TURNS OFF STOP IMAGE AND SAVE
SCFA; BEEP, ~STOP, ~IMAGE,
~SAVE;

BEEP, ~STOP, ~IMAGE, ~SAVE

SCUA? Query Units Spatial

Spatial Micrometers
Spatial Millimeters
Spatial Centimeters
Spatial Meters
Spatial Inches

Spatial Pixels

Spatial Micro Radians
Spatial Milliradians
Spatial Radians

Spatial Degrees

SCUA?
UMRS
SCUA?
MMRS
SCUA?
CMRS
SCUA?
MTRS
SCUA?
INCS
SCUA?
PIXS
SCUA?
URDS
SCUA?
MRDS
SCUA?
RADS
SCUA?
DEGS
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Command Description Examples
SCua Sets Units Spatial SCUA; UMRS;
UMRS
Spatial Micrometers SCUA ;MMRS ;
MMRS
Spatial Millimeters SCUA;CMRS ;

_ _ CMRS
Spatial Centimeters SCUA; MTRS ;
Spatial Meters MTRS

SCUA; INCS;
Spatial Inches INCS

SCUA; PIXS;
Spatial Pixels PIXS

SCUA;URDS;
Spatial Micro radians URDS

. T SCUA;MRDS;
Spatial Milliradians s
Spatial Radians SCUA;RADS ;

RADS
Spatial Degrees SCUA;DEGS;
DEGS
SCUL? Query Units Position SCUL?
UMRP
Micrometers by Position SCUL?
MMRP
Millimeters by Position SCUL?

) . CMRP
Centimeters by Position SCUL?
Meters by Position MTRP

SCUL?
Inches by Position INCP
SCUL?
Pixels by Position PIXP
SCUL?
Micro radians by Position URDP
A . SCUL?
Milliradians by Position MRDP
Radians by Position SCUL?
RADP
Degrees by Position SCUL?
DEGP
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Table 9-17. Analysis Fault Actions and Units Parameters Commands (Continued)

Command Description Examples
SCUL Sets Units Position SCUL; UMRP;
UMRP
Micrometers by Position SCUL;MMRP;
. - MMRP
Millimeters by Position SCUL ;CMRP ;
. - CMRP
Centimeters by Position
SCUL;MTRP;
Meters by Position MTRP
SCUL; INCP;
Inches by Position INCP
SCUL; PIXP;
Pixels by Position PIXP
Mi di by Positi SCUL; URDP;
icro radians by Position URDP
Milliradians by Position SCUL;MRDP ;
MRDP
Radians by Position SCUL;RADP;
RADP
Degrees by Position SCUL;DEGP;
DEGP
SCUP? Query Units Power (CW only) SCUP?
PUWT
Microwatts SCUP?
. PMWT
Milliwatts SCUp?
PWAT
Watts
SCuUPp?
Kilowatts PRWT
SCup?
Gigawatts PGWT
SCUP Set Units Power (CW only) SCUP; PUNWT ;
PUWT
Microwatts SCUP; PMWT ;
. PMWT
Milliwatts SCUP ; PWAT ;
PWAT
Watts
SCUP; PKWT;
Kilowatts PRWT
SCUP; PGWT;
Gigawatts PGWT
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Table 9-17. Analysis Fault Actions and Units Parameters Commands (Continued)

Command Description Examples
SCUE? Query Units Energy (Pulsed only) SCUE?
PUJL
Microjoule /CM? SCUE?
PMJL
Millijoules/CM? SCUE?
PJUL
Joules/CM?
SCUE?
Kilojoules/CM?2 PRJL
SCUE?
Gigajoules/CM? PGJL
SCUE Set Units Energy (Pulsed only) SCUE; PUJL;
PUJL
Microjoules/CM? SCUE ; PMJL ;
. 5 PMJL
Millijoules/CM SCUE ; PJUL ;
PJUL
Joules/CM?
SCUE ; PKJL;
Kilojoules/CM?2 PRJL
SCUE ; PGJL;
Gigajoules/CM? PGJL
SCUI? Query Units Intensity (CW and Pulsed) SCUI?
UWCM
Microwatts/CM?2 SCUI?
. 9 MWCM
Milliwatts/CM SCUI?
WCM2
Watts/CM?
SCUI?
Kilowatts/CM?2 KWCM
SCUI?
Microjoules/CM?2 UJCcM
SCUI?
Millijoules/CM? MJICM
Joul /CM2 SCUI?
oules, JCM2
Kilojoules/CM?2 SCUI?
KJCM
Digital SCUI?
DIGI
% Response SCUI?
PRCT
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Table 9-17. Analysis Fault Actions and Units Parameters Commands (Continued)

Command Description Examples
SCUI Set Units Intensity (CW and Pulsed) SCUI; UWCM;
UWCM
Microwatts/CM? SCUI ; MWCM;
N ) MWCM
Milliwatts/CM SCUT ; WCM2 ;
WCM2
Watts/CM?
SCUI;KWCM;
Kilowatts/CM?2 KWCM
SCUI;UJCM;
Microjoules/CM? UJCcM
SCUI;MJCM;
Millijoules/CM? MJICM
Joules/CM?2 SCUI;JCM2;
oules JoM2
Kilojoules/CM?2 SCUI;KJCM;
KJCM
Digital SCUI;DIGI;
DIGI
% Response SCUI;PRCT;
PRCT
SCUT? Query Units Time SCUT?
MSEC
Milliseconds SCUT?
S q TSEC
econds SCUT?
Minutes TMIN
SCUT Set Units Time SCUT ;MSEC;
Milliseconds MSEC
SCUT; TSEC;
Seconds TSEC
Minutes SCUT; TMIN;
TMIN

190




Remote Mode Host Communication Protocols

Table 9-18. System Configuration Commands

Command Description Example
TITL? Query Test Info Title. TITL?
TEST 004
TITL Set Test Info Title. TITL;TEST 044;
TEST 044
TISN? Query Test Info Serial Number TISN?
004
TISN Set Test Info Serial Number TISN;005;
005
TIOP? Query Test Info Operator TIOP?
JOE
TIOP Set Test Info Operator TIOP;ABE;
ABE
TICM? Query Test Info Comment TICM?
ABES TEST
TICM Set Test Info Comment TICM;JOES TEST;
JOES TEST
TIWS? Query Test Info Work Station TIWS?
USER 001
TIWS Set Test Info Work Station TIWS;USER 002;
USER 002
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9.9.1 Scale Factor, Focal Length, and Power Parameter
Commands

Table 9-19 shows commands that set and query the set-up > scale fac-
tors, focal length, and calibrated power parameters.

Table 9-19. Scale Factor, Focal Length, and Power Parameter Commands

Command Description Examples

SCSF? Query Scale Factor SCSF?
1.00000

SCSF Set Scale Factor SCSF;2;
2

SCFL? Query Focal Length SCFL?
100.0000

SCFL Set Focal Length SCFL;200;
200

SCPC? Query Power Calibrate SCPC?
1

SCPC Set Power Calibrate SCPC;2.4;
2.4

SCEC? Query Energy Calibrate SCEC?
1

SCEC Set Energy Calibrate SCEC;2.4;
2.4
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10 Troubleshooting, Tips, and Best
Practices

The following sections describe some common issues and solution, as
well as tips and best practices when using BeamView.NET software.

10.1 Categories of Errors

Most issues reported by users of the BeamView.NET software fall into a
few categories.
° Errors with Set-Up or Camera

o USB error

° Camera not connected or recognized

° Camera disconnected or underpowered

° Camera needs calibration

° Camera not compatible with software

d Operating Errors

° BeamView.NET does not capture beam images (or stops
capturing)

° See only fragments of the beam
° Printout has dots in the image background

L Loss of TCP/IP connection

° Analysis Errors
o Background noise is too high
o Calculations do not update fast enough
° Divergence measurement seems too large
° Percent energy in the aperture is too large
A Profiles are “flat topped”
° The beam is very small

L The Centroid does not track well

. Errors with Remote Mode

° No response on terminal screen
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10.2.1

10.2.2

Errors With Set-Up or Camera

General errors may be displayed when using a camera that is not con-
nected corrected or there are other compatibility issues.

USB Error

When using a USB connection, the computer’s operating system may dis-
play an error message warning about low power on a USB port.

This type of error occurs when a laptop is operating on a low battery or the
USB bus is overloaded and unable to supply the 500 mA power required
for a USB 2.0 connection.

When troubleshooting, it has been noted that certain systems are not ca-
pable of supplying the needed current to its USB ports.

If there are problems with a connection or software freezing, consider the
use of a USB hub with its own power supply. These powered USB hubs
maintain current to the external USB device if the computer or laptop is
unable to do so.

CAUTION!
Connect ALL power cables must be attached to a surge-protected
power source!

Camera Not Connected or Recognized

When a LaserCam camera is either not connected or is not being recog-
nized by the computer, the area above the Calculations panel displays “No
camera Attached”.

Sample ...

Camera Model: no Camera Attached

Figure 10-1. Error Message: No Camera Connected

Check the USB connections to the camera. If the USB cable is properly
connected, check in Device Manager on the computer to be sure the cam-
era's USB drivers have been installed properly.
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The application is now in Analysis Only mode. The Analysis mode of
BeamView.NET allows for the full analysis of a previously stored image or
the importation of an .ats test session file. Previously stored images, ats
files, and data files can be accessed using the File > Open command.

To return to Capture mode, close the application, connect the camera, and
restart.

Camera Disconnected or Underpowered

The following error message is displayed when the camera is disconnect-
ed or possibly underpowered. Try moving the cable to a different USB
port.

BeamYiew Analyzer x|

The LaserCamHR: USE connection has been interrupted. Please check and restart the application,

Figure 10-2. Error Message: Connection with Camera

Camera Needs Calibration

The Calibration Error message indicates that the gamma correction table
in the camera has been either incorrectly stored or corrupted. Contact Co-
herent Customer Support to arrange for evaluation of the camera evaluat-
ed and potential reprogramming.

-
y Your LaserZam needs calibration; please contact Coherent Custormer Support.

Figure 10-3. Error Message: Camera Needs Calibration
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10.3

10.3.1

Camera Not Compatible with Software

A compatibility error occurs when the camera and software are not de-
signed to work together. Contact Coherent Customer Support for the right
match.

USE Camera Error x|

L3
\l,r) Zameta Error: The camera detected is nok compatible with this application,

Figure 10-4. Error Message: Compatibility with Camera

Operating Errors

Operating errors include:

. BeamView.NET does not capture beam images (or stops capturing)
. See only fragments of the beam

. Printout has dots in the image background

4 Loss of TCP/IP connection

BeamView.NET does not capture images (or stops)

An error is displayed if the BeamView.NET software does not capture
beam images or if it stops capturing after a number of images have been
captured.

Check the following:
. Check that the BeamView.NET software is not in Stop mode. Do this

by verifying the Stop icon button on the Toolbar is not depressed, or
look at the left side of the Status bar to see if it indicates “Stopped”.

If the BeamView.NET software is in Stop mode, select the Start icon
button on the Tool Bar or, use the Start command to resume capturing
samples.
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d Check that the sample buffer size in the Size area of the dialog box is
set for the sample size expected. The BeamView.NET software halts
after the specified number of samples is reached. Checking the
“Capture continuously” check box causes the BeamView.NET soft-
ware to capture continuously over old images and wrap around to the
beginning of the sample buffer without stopping.

. Check that the proper laser source is selected in the Status bar. If
Pulse is displayed in the panel, the BeamView.NET software may be
waiting for an input trigger. If the LaserCam is being used in Pulsed
mode and is capturing only blank images, trigger timing may be the
problem.

° When Image-Discard is checked in Fault Action settings, make sure
that range limits are not set to discard all captured images. The Beam-
View.NET software appears to be “locked up” and does not store
data, when in actuality every image is being discarded. See 'Image
Save | Discard’ (p. 137) for more information.

See Only Fragments of the Beam

An error is displayed if the displayed beam image seems to have almost
totally disappeared in the View area, or only a small portion of the beam is
visible.

Verify that a Background Map command was not taken while an image
was on the camera. If a Background Map is taken with an image on the
camera, the BeamView.NET subtracts a beam image from all subsequent
images and only the portion of the beam that changes is seen.

To check this:

1.  Select the Background Map command from the Capture menu (see
p. 74).

2. Turn Off the background subtraction.

3. Go back to the View area and capture images.

The image should now be displayed normally.
Dots in the Image Printout
An error is displayed if the image displayed dots in the image back-

ground, similar to the sample shown here:

Notice the black dots around the beam. This effect occurs when the image
is captured with a background noise level that is too high.
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Figure 10-5. Error: Printout has Dots

By default, the print routine turns the bottom four levels of the image to
white to help conserve black ink. On properly adjusted images, using
background subtraction produces clear printouts.

To tell if the image taken has the proper background levels, be sure to turn
on the Automatic Background Warning Level indicator. If this feature is al-
ready on, the “Warn” indicator on the right edge of the status bar should
be On.

To correct the background problem, click on the warning panel and a Help
topic describing the corrective action is displayed.

Loss of TCP/IP Connection

Loss of a TCP/IP connection typically occurs when the computer is as-
signed an IP address via DHCP.

If the computer that is running BeamView.NET loses its DHCP lease, the
DHCP server has to assign the computer a new IP address. (IP addresses
are typically allocated to a system only for a fixed period of time.) The
DHCP server may assign the computer an address other than the original
address. If this happens, BeamView.NET no longer recognize packets that
have the old address (this is true, even if the computer is connecting to it-
self).

Note that “localhost” and “127.0.0.1” are special addresses that always in-
dicate “this computer”— no matter what the computer’s assigned external
address. When the client and server applications are running on the same
system, using “localhost” avoids dropped connections caused by chang-
es to the IP address.

Analysis Errors

Analysis errors in BeamView.NET include the following:

° Background noise is too high
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d Calculations do not update fast enough

° Divergence measurement seems too large
. Percent energy in the aperture is too large
d Profiles are “flat topped”

° The beam is very small

o The Centroid does not track well

Background Noise Is Too High

If the cross-hairs or the diameter calculations do not seem to be tracking
the beam correctly, most likely the software is picking up noise from the
camera. In such cases, capturing a new Background Map or adjusting the
Inclusion Zone could possibly help.

The Background Map function helps maximize system dynamic range by
eliminating fixed-pattern noise and ignoring bad camera pixels. For infor-
mation about collecting a Background Map, see 'Background Map’ (p. 74).

NOTIC

BeamView.NET cannot distinguish between background noise and a
true beam profile signal. The background noise must be minimized
to perform accurate beam diagnostics.

Several sources of background noise can contribute to the overall noise
level in the beam images. Before collecting a Background Map, sources of
Background Noise must be reduced as much as possible. If too high,
check these sections to reduce Background Noise:

d Sources of Background Noise

° Monitor Background Noise Level

o Noise Reduction

° Eliminate Background Light

Also see information about 'Background Light' (p. 32) and 'Background
Map’ (p. 74).

199



BeamView.net Operator’s Manual

10.4.1.1

10.4.1.2

10.4.1.2.1

Sources of Background Noise

High quality, low distortion optics, and low background light noise—free
from video electronic noise—are CRITICAL to accurate beam diagnostics
results.

Electronic noise in a video image is a common concern whenever video
systems are used in association with lasers. This is especially the case
with Q-switched lasers. Take special care to avoid placing any of the ca-
bles in a manner that could make them susceptible to EMI associated with
the laser system.

High-frequency sources can also induce noise into the cables and cam-
era electronics. Avoid grounding the camera with the laser or its power
supply in a manner that could make them susceptible to ground loops. Se-
vere damage to the camera and synchronization electronics may result.

NOTICE

If using the background subtraction function is used and cameras
need to be changed, users must take a new Background Map since a
different camera has its own unique background level (see p. 74).

Background light noise seen by the camera is another problem that should
be closely monitored. This noise can come from sunlight, room lights,
flash lamps, and instrumentation lights.

To offset some of these issues, users can attach an attenuator window of
polished NG-type absorption glass (with low transmission) to the camera
housing to reduce background light. The Low Distortion Face Plate (LD-
FP) included with the LaserCam-HR cameras serves this purpose. This al-
lows diagnostics to be performed in a lighted room.

Observe Background Noise Levels

When enabled, the BeamView.NET software continuously monitors the
background noise level during image capture, and issues a warning if that
noise level is significant enough to affect calculation accuracy.

Display a Warning Message

By examining the intensities of groups of pixels in each corner of the im-
age, the BeamView.NET software can determine the background noise
level. If the noise level is determined to be incorrect, the right side of the
Status bar displays the word “WARN”.
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If the WARN indicator is present, click on it to find out what corrective
steps should be taken. If this fails to remove the WARN indicator, follow
the steps below to check for other sources of noise. Users can also dis-
play the background warning by selecting “Background Warning” from the
Help menu.

Check for Background Noise

To check for background noise:

Remove any background light, electronic noise, or thermal noise.

2.  Capture a Background Map. A Background Map is basically an image
of the fixed-pattern noise, which is subtracted from captured beam
images before image analysis is performed (see ’Capture > Collect a
Background Map’ (p. 75)).

3. If there is still significant random noise after the fixed-pattern noise
has been subtracted out, a bias value may need to be added/
increased. The bias value reduces pixel intensity levels for every pixel
in the image. The bias factor should be kept as small as possible,
because it could remove beam information as well as noise.

To turn the Background Warning indicator On:

1. Run’Background Map’ (p. 74).

2.  Check “Enable Background Noise Level Monitoring” in the last dialog
box.

Noise Reduction

Most of the sources of background noise can be eliminated by taking the
time for proper precautions when setting up the BeamView.NET software.

All noise reduction efforts should first be performed optically:

° The best way to determine the background noise level is to block the
laser beam at the laser output port and observe the intensity at the
array while the laser is still operating.

. Check attenuation at the camera, shielding to avoid stray light, or
darken lights in the room lights to eliminate background light before
using the background subtraction feature.

° Block or cover the camera array so that no light can possibly be
detected. In the Results area, check if the minimum, mean, or
maximum (Uniformity: Min, Mean Max) values change when the
camera array is blocked.
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° If so, the camera is sensing background light and requires more
light baffling, darker room conditions, or background attenua-
tion.

Next, set up the BeamView.NET software:

1. In the Analysis menu, use the Apertures command and Calculations
command to turn on the overlaid Aperture and Aperture Uniformity
calculation. Set the aperture size to the maximum size allowed.

2. In the View menu, use the Crosshair command to set the Crosshair
position to USER COORD
3. In the Capture menu, use the Resolution command to set the Track

position to pixel in the Resolution capture mode.

This procedure sets up the BeamView.NET software to take the uniformi-
ty measurement over the entire image area.

This procedure can be used to evaluate possible electronic noise sources.
By monitoring the minimum, mean, and maximum values while moving ca-
bles, turning off possible noise sources, or adding electronic shielding, us-
ers can identify and eliminate some sources of noise.

Accuracy depends on taking the time to eliminate background noise
sources as much as possible.

Eliminate Background Light

See 'Background Light’ (p. 32) for details about eliminating background
light when using optics. Using a Low Distortion Faceplate (LDFP) is also
recommended.

Calculations Not Updating Fast Enough

There many things that can influence the speed of the calculations. Here
are several suggestions for speeding up the calculations:

° Turn off calculations that are not needed or not being used. Each
calculation slows down the update rate. Calculations such as Diver-
gence, Gaussian Fit, and Ellipticity take more time to process than the
other calculations.

° Using an Inclusion Area reduces the amount of data processed (see
’Analysis > Inclusion Area’ (p. 143). If using a very small beam or if
the Background Map feature does not cancel out all of the noise on
the camera, check the Inclusion Zone.
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° If Background Noise Level Monitoring is active, the calculations can
be increased by turning it off in the 'Background Map’ (p. 74).

. Consider using Analysis After ALL Samples Captured. This mode
captures images faster because it does not take time to analyze them.

After the capture cycle is completed, the specified number the images
are then analyzed. See the 'Capture > Buffer’ (p. 88) to learn about
these settings.

Divergence measurement seems too large

If the divergence measurement seems too large, some possible causes
include:

. Incorrect focal length is specified in the Focal Length command of the
Setup menu.
° Too much background noise is present on the camera.

Possible solutions:
° Double check the focal length setting in the Focal Length command.

. Place an aperture around the beam using the Apertures command of
the Analysis menu and check that the percent energy is greater than
90%.

If the percent energy is less than 90%, use the suggested solutions
under Background noise is too high and The beam is very small.

Percent energy in the aperture is too large

If the percent energy in the aperture is too large, a possible cause may be
that a Background Map has a Bias Value that is set too high.

Consider reducing the background Bias Value by using the Background
Map command in the Capture menu.

Profiles are ‘flat topped’

If the horizontal or vertical profiles appear to be “flat topped” in the View
area, no matter how much light is put on the camera, the peak intensity
does not reach 100%.
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If the problem only occurs with Background Subtraction On, try reducing
the Bias value using the Background Map command in the Capture menu
(see p. 74).

The beam is very small

If the beam is small, use the Inclusion feature to reduce the image area
used in the calculations to a small rectangular area surrounding the small
beam. This has two positive effects:

. It does not take into account all the noise that may be present outside
of the inclusion area.
° It speeds up calculations.

To activate the Inclusion feature, see the Inclusion command in the Analy-
sis menu.

Another solution is to change or add optics to magnify the beam size onto
the array. The Scale Factor setting allows the results to take into account
the added magnification (see 'Setup > Scale Factor’ (p. 64)).

The Focal Length setting allows a longer focal length focusing lens or mir-
ror to be used to enlarge the Far Field beam image for Divergence mea-
surements (see Focal Length Command in the Setup menu).

The Centroid does not track well

If the calculated centroid of the beam is moving around (bouncing), or if it
is off to the side from the apparent true centroid, this is an indication that
the background noise is too high or that the beam is too small.

Errors in Remote Mode

If there is no response on terminal screen:
1. Make sure that the computers are connected through the correct
COM ports with a NULL modem cable.

2.  Make sure that the serial COM port settings match in BeamView.NET
and the terminal program.

3.  Try to replace BeamView.NET with a terminal session, and check if
the two terminal sessions can communicate. That can isolate the
problem to Hardware or incorrect settings.
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Use the Serial Connect/Disconnect button on the right end of Beam-
View.NET toolbar for fast single-click control of the connection.

Capture may fail with ERROR 026 when the camera picks up too much
light while capturing a background map.The user can set a background
bias value using the SCBB command (see p. 177).

10.6 Errors Codes from the HELP Command

Table 10-1 lists the error codes when using the Help command.

Table 10-1. Error Codes from the Help Command

Error Description
001 New sample is greater than current sample.
002 HELP command is not recognized.
003 File is password protected.
004 ZEII_(-:(‘:Load or Save Configuration is invalid file type; should be

005 Unable to open file.

006 Save Images — nothing selected.
007 Save Images — invalid image.
008 Save Images — Unable to obtain memory to save compressed

images. Will save as uncompressed.

009 Export Image File is invalid; it needs to be type BIN.

010 Save Test As File is invalid; it needs to be type ATS.

011 Invalid command.

012 Row too large.

013 Wrong Trigger Mode.

014 No pre-existing Background Map.

015 Selected Profile has no binary data and cannot be displayed.

016 Selected Profile is OFF and cannot be displayed.

017 Invalid Repeat Command.

018 Unable to obtain Latest Divergence.
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Table 10-1. Error Codes from the Help Command

Error Description

019 Unable to Set this parameter.

020 Unknown Units.

021 Unknown Crosshair Position.

022 Unknown Crosshair Angle Setting.

023 Unknown Aperture Size.

024 DLL error.

025 Unable to write to INI.

026 BG Map; A/D Adjust as necessary.

027 BG Map; invalid Bias.

028 SCBL; Unable to find directory.

029 SAMPLE — Sample number is greater than maximum allowed.
030 There is NO parameter value.

031 This Calculation is turned OFF.

032 The units are invalid for this Calculation.

033 The configuration file does not exist.

034 Unable to perform Calculation. No Image.

035 Units not valid for CW mode.

036 Units not valid for Pulsed mode.

037 Invalid Port.

038 Unable to set Fluence Value.
10.7 Tips and Best Practices

This section provides additional information about best practices, tips, and
general information to optimize results when using the BeamView.NEt
software. This includes such topics as:
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d Exporting a binary file

° Ghosting images and solutions

. Camera drawings for depth to imager clarifications
° Preventing contamination

° Optimizing camera calculation

Exporting a Binary File

Exporting Images as a .bin file saves all selected images into one file. Ex-
porting and Importing a .bin file is faster than the other options. It also take
up less hard disk space on the computer.

When a binary file is exported, a header is attached to the beginning. This
is followed by all selected Images being exported. Images are appended
one after another in the file.

The exact size of a header is 128 bytes:
Images: Height = 1024, PixelsPerRow = 1280, sizeOfPixel = 2
PixelsPerRow* sizeOfPixel = bytesPerRow = 2560
Height * bytesPerRow = ImageSize = 2621440 bytes
Header file +2621440 = 2621568 bytes

The remote interface commands for BeamView.NET are the only way to
get images or calculations out of the BeamView.NET software. There is no
way to directly access the images from the camera itself without the
BeamView.NET software. The images that are collected by the camera
are a very raw format and they do not have any type of background sub-
traction or linearity correction performed on them.

In addition, the BeamView.NET software adds some image correction and
noise subtraction from the raw camera images in order to produce an ac-
curate beam image on which calculations can be performed. These imag-
es can then be exported from BeamView.NET and imported into other
programs.

BeamView.NET is focused on data evaluation from the camera. The data
is then reviewed in BeamView.NET and is not really designed to be used
outside of the software; however, it can be done and will take more work
for the user.

Exporting binary files to transfer images directly to LabVIEW or MatLab for
analysis is generally not useful because they are not a true representa-
tion of the beam.
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Working with LabVIEW

BeamView.NET is compatible with LabVIEW. The basic commands out-
lined in the 'Remote Mode Host Communication Protocols’ (p. 163) can be
interfaced through the LabVIEW application. This acts as a wrapper for
the Host commands. The BeamView.NET application must still be used
and the application must be set to Remote to run LabVIEW.

Exporting the images to LabVIEW is really of no value. LabVIEW is used
to remotely drive the camera through the BeamView.NET software. How-
ever, if the customer is simply looking for a way to remote commands to
the camera and take images at some rate, this can be done in LabVIEW.
The images must later be loaded into BeamView.NET for data evaluation.

An option is to first run the BeamView.NET Data Logger application (de-
scribed in 'Remote Mode Set Up’ (p. 151)) and make sure they can run all
of the commands that they want to use to get the camera to do the func-
tions that they want. The next step is to do the same thing in LabVIEW.
Again, though, the user must still use the BeamView.NET software to re-
view the images once they are collected.

Working with MatLab

Remember that MatLab is not an API, so users cannot interact with the
BeamView.NET software directly through MatLab.

This can be done directly through the BeamView.NET software or by us-
ing the remote commands. However, the images would have to be saved
into the BeamView.NET software, then exported, then imported into Mat-
Lab. There is no feature in BeamView.NET to allow images to be
streamed into another program or a specific folder location.

Ghosting Images

With the introduction of the LaserCam HR Il CCD camera many improved
performances have been realized. Lower overall noise, increased sensor
sizing and extension of the product due to obsolescence issues of the
CMOS predecessor. It is important to understand that due to the chip
structure camera pixels on the memory layer and the process to get the
data to the processor, there are Interactions with IR wavelengths exhibits
some vertical artifacts that can negatively impact calculations of beam di-
ameter.

The 1/2” version of the camera is more susceptible to this than the 2/3”
version, but both of these cameras can exhibit unacceptable errors in
some situations. It is important to understand the methods to compensate
for these errors.
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° Increasing the integration time and attenuation reduces this effect
significantly. The best trade-off on accuracy and frame rate is near
100ms, but the 25" camera performs acceptably at integration times
as low as 10ms.

° Inclusion Zone, adding an inclusion zone that effectively subtracts

unwanted artifacts from the camera calculation will improve the
behavior considerably.

10.7.2.1 Examples of Ghosting

Figure 10-6 shows examples of ghosting and the effects of integration
time. Notice how the camera picks up the artifacts with the use of our
1047nm laser. The effects of integration time have significant change on
the ghost image.
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Figure 10-6. Examples of Ghosting
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Figure 10-6. Examples of Ghosting

Examples of Use with Inclusion Zone

Using the inclusion zone selects the area in which the camera will use in
its data calculations. This effectively discards all data outside of the select-
ed area.

When using the LaserCam HR 2/3” camera, the effects of ghosting are al-
most eliminated with a 10ms integration time, as shown in Figure 10-7.

Depth-to-Housing

Depth-to-housing is a reference to the physical dimensions of the device
for the following cameras, listed in Table 10-2:

Figure 10-8 shows the depth to housing for the Laser Cam Il 1/2” USB
Camera system (P/N 1282868):

Prevent Contamination

The CCD array is very sensitive to contaminates. This is the reason for the
Low Distortion Faceplate (LDFP) or other sealing type of protective win-
dow. When the unit is open to the environment, the bare CCD chip can be
easily contaminated by particles and debris that are very difficult to re-
move.

210



-

Troubleshooting, Tips, and Best Practices

i Beamview-LiA 4B 1

i

BB #irn LareCarn 7 EVLATS lnaded
|

Vawe Captus Azshmx  Setp  Help

his L
Ot || | w o] [u @w|[w| @[+ [+ [n 0| [0 20 8la] 7]«

Sarpls D01 - Mg & 7006 - PTT 1AM - Canc 0 -

Pask % Resp %) B
[ L e e | L
iy

Firi e Ve A1

o TS (1 FGA0Y BET o it 5 70 ] i BT o L 18 [ O

1ms integration time

[ @ Besssitenimm an 1

Gk e

L | e

Hev Lasaan HA 14T ATS kuded

t Wew Coaplre Geabss  Senp  Hdp

2% @ e[ @3] [+ 2] w]s o0 ald Aa] ¥ e
Garwphe DBY - Migp & 2095 - PR 1ESM  Com 0 - M

Pask T Husp [ (]
Drveggere BEG% wvarf | | 26
Elpiicdy

™
Mz b BE BT Jwrs
ary

[ r—r

ot {1 THE [ PAD £ 50T o i 53 T3 jkgial] al 1390 8 TMx1E | Ow

10ms integration time

Figure 10-7. Examples of Using the Inclusion Zone

211



BeamView.net Operator’s Manual

i
1
=
~
P
- 3
2

LaserCam HR I
1/2” USB

Table 10-2. Depth to Housing

P/N Camera Depth to Housing
1282868 LaserCam HR 1l 1-2/” USB 0.68in [17.1 mm]
1282870 LaserCam HR 11 2/3” USB 0.68 in [17.1 mm]
1360550 LaserCam HR Il UV 0.67 in [16.9 mm]

0.68 in - 0.67 in - L.
[17.1 mm)] [16.9 mm]
Imager Depth Imager Depth

BT

LaserCam HR Il 2/3” USB

LaserCam HR Il UV

Figure 10-8. Depth to Housing: LaserCam HR Il Cameras

Contamination of the imager can also occur when removing the filter. In
addition, the attempted removal of debris by a user destroys the imager.

To check for symptoms of damage:

° Does the camera currently produce images?

° Does BeamView.NET display only a white screen or bright color, or

streaks of color?

. Are marks visible on the image that stay with the camera and appear

to block or reduce the image intensity on the defect site?

These are indications that the imager has already been damaged by a
cleaning attempt. If the imager has already been damaged, it is less ex-

pensive to replace the Camera then repair the unit.

Removal of the Low Distortion Faceplate (LDFP) or other protective win-
dow should not be done except when following these recommendations:

212




10.7.5

10.7.5.0.1

Troubleshooting, Tips, and Best Practices

i Perform the window exchange under a flow hood, or in a clean room.
. Never leave the CCD array open to the environment.

. Make sure that the protective window being installed has been
correctly cleaned before use.

Optimizing Camera Calculations

This section describes what to do to get the most out of the camera calcu-
lation.

WARNING!

Coherent cameras are provided with an LDFP filter to protect the
imager from contamination. Removing the LDFP filter can allow
contamination of debris and affect the image of the camera. These
imagers cannot be cleaned in the same way as normal optical
components. In most cases, cleaning attempts result in complete
camera failure.

A camera needs only a handful of mW to get a good image. The question
is how to take a laser and attenuate it down to a level to get the most data
from the camera without saturating and loosing valuable information.

Filters have a fixed density, and the camera must have the input power
adjusted to properly create the right amount of peak response for the best
image. Many times, users need to control the amount of power going into
the camera to select a desired level. This requires constant laser power
and the ability to knock that power down to a level that would be useful for
the camera.

Because lasers are limited in their ability to get a specific power and
achieve lasers stability level, Coherent offers variable attenuation options.
The use of a C-VARM provides dynamic control of the power level and
perfectly controls the power. This assumes users have 1W or less of in-
coming power. If there is more power than this, then additional attenua-
tion is required. BCUBEsS or fix optical attenuation work in this case.

Laser-Grade Attenuation Optics for Cameras

Features of laser-grade attenuation optics for cameras include:

° Laser-grade attenuation optics
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10.7.5.1

° Compatible with all Coherent beam diagnostic cameras
. Virtually undistorted and interference-free attenuation

° Variable and fixed attenuation for beams up to 2000W/cm2 or 50J/
cm2

° C-Mount threads couple directly to cameras

Attenuation Optics and Accessories

Most cameras are too sensitive for direct viewing of laser beams. For ex-
ample, a typical diagnostics camera saturates at only ~0.5 yW/cm2 pow-
er density (at ~633 nm) or at ~9 nJ/cm2 (at 1064 nm) pulsed energy
density. If the camera has an electronic shutter, it can be used for some
CW beam attenuation, but there is more flexibility in using optical attenua-
tion.

Any attenuation optics introduced in the beam path must be manufac-
tured to exacting specifications. The optics must be laser-grade sub-
strate, and use the proper flatness and wedge to avoid etaloning and
fringing, so that the beam is not distorted by the introduction of the attenu-
ation.

Coherent offers attenuation optics that are designed to these specifica-
tions and packaged for use with our cameras.

Typical attenuations are 1:1 to 400,000:1, but even larger attenuations are
possible. All Coherent diagnostic cameras accept C-Mount optics and ac-
cessories, and are delivered without a standard window in front of the sen-
sor array. Such windows are liable to distort the optical beam. However, a
LDFP (Low-Distortion Face Plate) filter is supplied with each camera pur-
chased from Coherent. The LDFP is a laser-grade optic specified and pol-
ished for diagnostics use. It is mounted in a housing with C-Mount threads
and provides attenuation of room light so that the camera can be used
with the lights on. For operation below 400 nm, the LDFP must be re-
moved.

The Continuously Variable Attenuator Modules (C-VARM and UV C-
VARM) contain two wedge attenuators that are continuously variable and
a step attenuator that allows attenuation from 107:1 down to 3000:1. The
C-VARM and UV C-VARM can be finely adjusted to achieve both precise
attenuation levels and maximum use of the camera’s optical dynamic
range.

The Variable Attenuator Module (VARM) is a triple-wheel filter holder that
contains three filters per wheel. The filters are made to our exacting speci-
fications for transmission value and material quality. The VARM is adjust-

214



10.7.5.2

10.7.5.3

Troubleshooting, Tips, and Best Practices

able in attenuation in 64 discrete steps of approximately 16% reduction
each time from 400,000:1 down to 1:1. The VARM can be easily returned
to exactly the same attenuation level as previously used.

The BeamCUBE Fixed-Attenuator Modules (BCUBE and UV-BCUBE)
provide fixed attenuation and beam pickoff for performing diagnostics on
high power laser sources. The BCUBE and UV-BCUBE utilize the front
surface reflection from an uncoated laser mirror to achieve beam samples
at 2% to 10% of the incident radiation, depending upon beam polariza-
tion. Multiple BCUBEs can be coupled together for even higher fixed at-
tenuation levels

BCUBE, UV-BCUBE, VARM, C-VARM, UV C-VARM and all other Coher-
ent cameras have female C-Mount threading, making them easy to con-
nect with the male C-Mount connection flange provided with each
attenuator. Also, all attenuators have 1/4-20 tapped holes for independent
post or plate mounting.

The C-Mount flanges (threaded rings) also have a female RMS micro-
scope thread. This allows a microscope objective to be coupled to the at-
tenuators and extension barrels in order to create a flexible close-up
imaging system for analysis of small/focused beams, fiber optics, laser di-
odes or LEDs.

Avoiding Multi-Filter Beam Distortion

The wavefront distortion through a number of optical filters can be calcu-
lated by taking the square root of the sum of the squares of the wavefront
distortion of the individual components. For example, if the individual op-
tics are made to AM/10 specifications and six are used, a total A\4 RMS
wavefront distortion will be introduced to the beam:

v 0.12+0.12+0.12+0.12+0.12+0.12=0.25

In general, a camera cannot sense less than ~\/4 total distortion in the
beam, so if a series of filters is used, they must be made to very exacting
laser-grade specifications. Attenuating optics from Coherent are manufac-
tured to better than a A/10 surface specification, so at least six optics in
series can be used. Calculate the Low-Distortion Face Plate (LDFP) and
each BCUBE as one optic, and the VARM or C-VARM as three optics
each.

Attenuator Selection

Attenuation is selected on the basis of power density in W/cm2 or energy
density in J/lcm2. The attenuation from the camera’s Low-Distortion Face
Plate (LDFP) allows an average power density of up to 1.2 mW/cm2.

There are only two more steps to attenuation selection:
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1. Choose either the VARM or the C-VARM for up to 1W/cm?2.

2.  In addition or alternatively, use a BCUBE beam splitter module to pick
off between 2% and 10% of the beam (depending on polarization and
wavelength).

For more information and assistance with attenuator selection, call a Co-
herent representative (Toll Free at 1-800-343-4912), go to shopcoher-
ent.com, or contact Coherent Technical Support (see 'Service and Support’
(p. 225)).

216


shopcoherent.com
shopcoherent.com
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Appendix A: Safety and Compliance

A1l

This section describes requirements for safety for persons setting up or
operating the BeamView.NET software in an environment:

. ‘Laser Safety Hazards’ (p. 217)
. 'Optical Safety’ (p. 218)
d ‘Laser Back Reflection’ (p. 219)

. 'Safety Precautions for Cameras’ (p. 222)

Users must review these laser safety sections thoroughly BEFORE oper-
ating the BeamView.NET software. Carefully follow all safety instructions
presented throughout this manual.

NOTIC

This user information reported in this manual is in compliance with
the following standards for Light-Emitting Products EN/IEC 60825-1
“Safety of laser products — Part1: Equipment classification and
requirements” 21 CFR Title 21 Chapter 1, Subchapter J, Part 1040
“Performance standards for light-emitting products”.

Laser Safety Hazards

Hazards associated with lasers generally fall into the following categories:

. Biological hazards from exposure to laser radiation that may damage
the eyes or skin

° Electrical hazards generated in the laser power supply or associated
circuits

. Chemical hazards resulting from contact of the laser beam with vola-
tile or flammable substances, or released as a result of laser material
processing

The above list is not intended to be exhaustive. Anyone operating a laser
must consider the interaction with its specific working environment to iden-
tify potential hazards.
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A.2

For the BeamView.NET software, hazards vary with the input angle and
the laser beam.

WARNING!
LASER RADIATION! Always avoid eye or skin exposure to both
DIRECT and SCATTERED radiation.

Optical Safety

Laser light, because of its optical qualities, poses safety hazards not asso-
ciated with light from conventional light sources. The safe use of lasers re-
quires all operators, and everyone near a laser, to be aware of the
dangers involved. Users must be familiar with the instrument and the
properties of coherent, intense beams of light.

The safety precautions listed below are to be read and observed by any-
one working with or near the laser. At all times, ensure that all personnel
who operate, maintain or service the laser are protected from accidental
or unnecessary exposure to laser radiation exceeding the accessible
emission limits defined in the laser safety standards.

WARNING!
Direct eye contact with the output beam from the laser may cause
serious eye injury and possible blindness.

The greatest concern when using a laser is eye safety. In addition to the
main beam, there are often many smaller beams present at various an-
gles near a laser. These beams are formed by specular reflections of the
main beam at polished surfaces such as lenses or beamsplitters. While
weaker than the main beam, such beams may still be sufficiently intense
to cause eye damage.

Laser beams are powerful enough to burn skin, clothing, or combustible
materials, even at some distance. They can ignite volatile substances
such as alcohol, gasoline, ether, and other solvents, and can damage
light-sensitive elements in video cameras, photomultipliers, and photodi-
odes.

218



A2.1

A.2.2

A23

A3

Safety and Compliance

Laser Safety Eyewear

Always wear appropriate laser safety eyewear for protection against the
specific wavelengths and laser energy being generated.

The appropriate eye protection can be calculated as defined in the
‘EN 207 Personal eye protection equipment—Filters and eye-protectors
against laser radiation (laser eye-protectors)’, in other national or interna-
tional standards (such as ANSI, ACGIH, or OSHA) or as defined in nation-
al safety requirements.

CAUTION!

Laser safety eyewear protects the user from accidental exposure to
laser radiation by blocking light at the laser wavelengths. Always
wear the appropriate laser safety glasses matched to the lasers used
in the environment.

Because laser safety eyewear may also prevent the operator from
seeing the beam or the beam spot, exercise caution even while
wearing safety glasses.

Viewing Distance

A laser produces optical power levels that are dangerous to the eyes and
skin if exposed directly or indirectly. Operate all laser products only with
proper eye and skin protection at all times. Never view directly emitted or
scattered radiation with unprotected eyes.

When viewing the laser during operation, the operator must maintain the
Nominal Ocular Hazard Distance (NOHD) between the laser or scatter ra-
diation and the operator's eyes. Check the Operator’'s Manual for the laser
being used for details.

Maximum Accessible Radiation Level

A laser produces visible radiation over the various wavelengths. See the
Product Label on the laser for details about maximum emission levels.

Laser Back Reflection

This section describes back reflection and tells how to prevent damage or
noise caused by back reflection.
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A3.1

A.3.2

What is Back Reflection?

Back reflection (also referred to as retroreflection) occurs when a part of
the laser beam is sent back into the laser’s exit aperture. Back reflection
can be caused by any object in front of the laser (such as other equipment
or even a wristwatch) and can result in instability, noise, or damage to the
laser.

In a normal application, the laser beam exits the beam aperture and none
of the light from the laser is reflected back. Ideally, 100% of the output
power from the laser is used in the application and none of the light is
scattered or sent back into the laser exit aperture.

The amount of back reflection that can damage a laser diode changes
from device-to-device. Sometimes a back reflection as low as 4% of the
total beam power is sufficient to cause damage.

Damage from back reflection can be immediate, or it can be subtle and
slowly decrease the service life of the laser.

Indications that there are back reflections to the laser that may cause per-
manent damage include:

° No output power
° Low output power

d Over-current of the laser diode

How to Prevent Back Reflection

The following procedure describes how to prevent a strong back reflec-
tion and possible damage to the laser:

1.  Use the USB or RS-232 controls to set the power to minimum output
power before opening the laser aperture.

2. Do optical or laser alignment at this low output power to confirm there
are no back reflections.

Sources of back reflections include:
d Fiber, Fiber Ferrule, or Fiber Connector
. Optical Filters that are not angled but are perpendicular to the beam

d Neutral Density Glass or Beam Attenuators that have a front surface
reflection that can create a back reflection.
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° Beam Block at normal incidence that reflects power back into the
laser

o Plano-concave or Plano-convex lenses where the flat surface reflects
back part of the beam

° Power measurement probes that use a reflective attenuator or have
a surface that reflects the laser light.

° Mirrors or other shiny surfaces from mounts or other optical compo-
nents in the beam path.

When measuring laser power with a power meter, always angle the pow-
er sensor so that the laser beam does not reflect back into the laser exit
aperture.

To properly measure laser power:

1. Take the measurement near the laser.

2.  Move the power sensor to maximize the reading of the output power.

CAUTION!
DO NOT let this movement and alignment create a back reflection.

In many cases an object is positioned in front of the laser as a beam
block. Make sure the object is not reflective and does not create a back re-
flection to the laser.

If the application cannot be adjusted to decrease the back reflection of the
laser light into the laser's exit aperture, add an optical isolator to protect
the laser. Although the optical isolator adds cost and requires additional
space, it can be an appropriate safety factor to increase the life of the la-
ser.

Be aware of every optical surface in front of the laser. All object have the
opportunity to create a back reflection. In many cases the front surface
and the back surface of the optic are a source of back reflection.

° The closer the object is to the laser, the more angle is needed to direct
the back reflection away from the laser exit aperture.

° The farther the object is away from the laser, the less angle is needed
to direct the back reflection away from the laser exit aperture.
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A4

CAUTION!

The Coherent product Warranty does not cover damages to the laser
caused by customer handling failure. Take precautions with initial
set-up to avoid damage to the laser. Avoid any condition where any
part of the laser beam reflects back into the laser exit aperture.

Safety Precautions for Cameras

Coherent LaserCam products use a Low Distortion Face Plate (LDFP) installed in
the camera aperture. The LDFP filter glass eliminates unwanted background
light, provides attenuation for the laser beam, and provides protection for the
camera sensor.

It is important to note that Coherent recommends to not remove this under most
circumstances, as this is the only protection the camera sensor has against
debris and mechanical damage. The LaserCam warranty is void if the LDFP is
removed.

CAUTION!
If the Low-Distortion Face Plate (LDFP) is removed, the Warranty is void.

Any modification to remove the LDFP leaves the sensor susceptible to damage. If
the LDFP is removed from the camera, special precautions (described next) must
be taken to avoid sensor damage.

Dust

If low-intensity spots or small circles are noticed in the camera video, as shown in
this example, then dust may be present.

Dust can cause distortion in the form of small circles if present on the LDFP filter
glass, or can cause low-intensity spots if present on the sensor array.

Observe the defects with a flashlight illuminating the camera. If the defect moves
when the flashlight angle is changed, then the dust is on the LDFP; otherwise, it
is caused by dust on the array.

To correct this situation, use clean air at low-pressure (or methanol and lens
tissue) to clean the LDFP filter glass. Use only low-pressure micro-filtered clean
air to blow dust off the sensor.
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Take all necessary precautions to insure that nothing makes any contact with the
sensor surface.
Fringes

If the LDFP filter glass is installed in the camera, then fringes can appear in the
video as shown here:

The fringe pattern is due to a second reflection off the sensor and the LDFP
superimposing back onto the original beam image.

CAUTION!
Use small, careful movements when rotating any devices to avoid laser back
reflection!

Laser Power Input

Depending on the LaserCam HR camera model, saturation occurs at various
power levels and wavelengths. See the User Manual for the specific camera to
read information about saturation levels and damage thresholds at various
wavelengths.
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A.5

Summary of Precautions

Review the objects in front of the laser and note which surfaces are a
possible hazard for back reflections. Change the objects to be less
reflective whenever possible. Adding Anti-Reflective (AR) coatings to
optics and more diffuse surfaces to mounts or beam shutters can
help.

If possible, add an angle to the object so that the reflection does not
enter the laser exit aperture.

Take precautions when moving objects that can create a back reflec-
tion in front of the laser.

Decrease the power from any possible back reflections by starting the
laser at lower output power—for example 10% output power—before
opening the laser shutter.

Using correct safety precautions, watch where the reflections from
objects are returning to make sure the reflections are not at or near
the laser exit aperture.

Take extra precautions when using a laser power meter— consider
how close the measurement is being taken to the laser and the angle
at which the beam can reflect off the sensor so that it doesn't reflect
back into the laser.

A laser that shows low output power, no output power, over-current,
or high noise, indicates a possibility that there is a back reflection into
the laser.

Add an optical isolator to those applications that have laser exit aper-
ture back reflections that cannot be corrected by angling the optics.
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Appendix B: Service and Support

B.1

This section provides information about:
° How to contact Product Support
. How to obtain service

° Product shipment instructions

Contact Product Support

Coherent provides telephone and web-based technical assistance as a
service to its customers and assumes no liability thereby for any injury or
damage that may occur contemporaneous with such services.

For general Technical Support, contact a local Coherent Service Repre-
sentative as described on the following page, or contact Coherent as fol-
lows:

. By phone: 1-(408)-764-4557 or 1-(800)-367-7890

° By e-mail: Product.Support@Coherent.com

d To view a list of contact names, telephone numbers, and addresses
worldwide, visit our website: www.Coherent.com

Under no circumstances do these support services affect the terms of any
warranty agreement between Coherent and the buyer. Operation of any
Coherent laser with any of its interlocks (or safety features) defeated is al-
ways at the operator's own risk.

Please be prepared to provide the following information:
° Model or part number of the unit

* Serial number of the unit

° A description of the problem

° Any corrective steps that may have attempted
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B.1.1

B.1.2

B.2

LSM Support in the USA and North America

If shipping products from within the United States or North America, con-
tact LMC Technical Support directly, as follows:

d By phone: North America (800) 343-4912 or (408) 767-4042

° By e-mail: LSM.service@coherent.com

Telephone coverage is available Monday through Friday (except during
U.S. holidays). Inquiries received outside normal office hours are tracked
by our automatic answering system and promptly returned the next busi-
ness day.

For additional information about sensor products, go to:

https://www.coherent.com/measurement-control

For additional support, go to:

https://www.coherent.com/support

International LMC Support

If located in Europe, contact LMC Technical Support directly, as follows:
d Germany: +49-6071-968-0

° Japan: +813-5635-8680

Obtain Service

To obtain service under this warranty, Customer must notify the Company
of the defect before the expiration of the warranty period and make suit-
able arrangements for the performance of service.

The Company shall, in its sole discretion, determine whether to perform
warranty service at the Customer's facility, at the Company's facility, or at
an authorized repair station.

If Customer is directed by the Company to ship the product to the Compa-
ny or a repair station,

Customer shall:

° Package the product (to protect from damage during shipping) as
instructed in ’Product Shipment Instructions’ (p. 227) next.
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Service and Support

Ship it to the address specified by the Company, with shipping
prepaid. back to Coherent in conjunction with recalibration and recer-
tification.

Coherent shall pay the cost of shipping the Product back to the
Customer in conjunction with product failures within the first twelve
(12) months of time of sale or during an extended 12-month warranty
period.

Product Shipment Instructions

Users must include a Returned Material Authorization number (RMA) as-
signed by the Company on the outside of all shipping packages and con-
tainers. Items returned without an RMA number are subject to return to
the sender. Detailed instructions to prepare a product for shipping are pro-
vided in the next section.

To prepare a product for shipping to Coherent:

1.

Contact Coherent Customer Service (see 'Contact Product Support’
in the next section) for a Return Material Authorization number.

Attach a tag to the product that includes the name and address of the
owner, the person to contact, the serial number, and the RMA number
received from Coherent Customer Service. Pack this tag inside the
box.

Wrap the product with polyethylene sheeting or equivalent material.

Using the original shipping and packaging materials, pack the
product.

Seal the shipping carton with shipping tape or an industrial stapler.

Add the RMA number received from Coherent Customer Service to
the shipping label on the outside of the box.
Ship the product to the following address:

Coherent, Inc.

Laser Measurement and Control, Attn: RMA #
27650 SW 95th Ave.

Wilsonville, OR 97070

USA
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Appendix C: Warranty

C.1

Coherent, Inc. warrants OBIS Laser Systems to the original purchaser
(the Buyer) only; that the laser system that is the subject of this sale,
(a) conforms to Coherent's published specifications, and (b) is free from
defects in materials and workmanship.

Laser systems are warranted to conform to Coherent's published specifi-
cations and to be free from defects in materials and workmanship as
specified in the sales or service contract. Replacement units shipped with-
in warranty carry the remainder warranty of the failed unit.

Responsibilities of the Buyer

The Buyer is responsible for providing the appropriate utilities and an op-
erating environment as outlined in the product literature. Damage to the
laser system caused by failure of Buyer's utilities or failure to maintain an
appropriate operating environment, is solely the responsibility of the Buyer
and is specifically excluded from any warranty, warranty extension, or ser-
vice agreement.

The Buyer is responsible for prompt notification to Coherent of any claims
made under warranty. In no event will Coherent be responsible for warran-
ty claims made later than seven (7) days after the expiration of warranty.

The foregoing warranty shall not apply to defects resulting from any of the
following conditions:

Limitations of Warranty

The foregoing warranty shall not apply to defects resulting from any of the
following conditions:

° Components and accessories manufactured by companies other than
Coherent, which have separate warranties

. Improper or inadequate maintenance by the Buyer
d Buyer-supplied interfacing

° Operation outside the environmental specifications of the product
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° Unauthorized modification or misuse
° Improper site preparation and maintenance

° Opening the housing

Coherent assumes no responsibility for customer-supplied material. The
obligations of Coherent are limited to repairing or replacing, without
charge, equipment that proves to be defective during the warranty period.
Replacement sub-assemblies may contain reconditioned parts. Repaired
or replaced parts are warranted for the duration of the original warranty
period only. The warranty on parts purchased after expiration of system
warranty is ninety (90) days. This warranty does not cover damage due to
misuse, negligence or accidents; or damage due to installations, repairs or
adjustments not authorized specifically by Coherent.

This warranty applies only to the original purchaser at the initial installation
point in the country of purchase, unless otherwise specified in the sales
contract. The warranty is transferable to another location or to another
customer only by special agreement, which will include additional inspec-
tion or installation at the new site. Coherent disclaims any responsibility to
provide product warranty, technical or service support to a customer that
acquires products from someone other than Coherent or an authorized
representative.

THIS WARRANTY IS EXCLUSIVE IN LIEU OF ALL OTHER WARRAN-
TIES, WHETHER WRITTEN, ORAL OR IMPLIED, AND DOES NOT
COVER INCIDENTAL OR CONSEQUENTIAL LOSS. COHERENT SPE-
CIFICALLY DISCLAIMS THE IMPLIED WARRANTIES OF MERCHANT-
ABILITY AND FITNESS FOR A PARTICULAR PURPOSE.
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Appendix D: Extended Warranty Program

Coherent, Corp. (the “Company”) offers original purchasers (the “Custom-
er”) purchasing laser power and energy meters and sensors products
(“Products”) an extended twelve (12) month Warranty program, which in-
cludes all parts and labor.

To qualify for this Warranty, a Customer must return the Product to the
Company for recalibration and recertification.

d The Company will re-certify the Product, provide software upgrades,
and perform any needed repairs, and recalibrate the Product, for a
fixed service fee (as established by the Company from time to time
and in effect at the time of service).

° If the product cannot be re-certified due to damage beyond repair,
parts obsolescence, or other reasons, the Customer may be informed
that an Extended Warranty program is not available for the Product.

If the Product fails and is returned to the Company within one year follow-
ing the date of recalibration and recertification service, the Company will,
at its option, repair or replace the Product or any component found to be
defective. If the Product must be replaced and the Product is no longer
available for sale, Coherent reserves the right to replace with an equiva-
lent or better Product. This Warranty applies only to the original purchaser
and is not transferable.
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Glossary

°C Degrees Centigrade or Celsius

°F Degrees Fahrenheit

Q Ohm(s)

n Micron(s)

um Micrometer(s) = 10" meters

urad Microradian(s) = 107® radians

usec Microsecond(s) = 10" seconds

1/e2 Beam diameter parameter = 0.13534
AC Alternating current

Address A unique one-byte identifier assigned to each device on the bus
Amp Ampere(s)

APC Angle physical contact

Application Protocol
A set of application defined commands and replies used to implement
a system of cooperative devices

Automatic Send Data Control
An optional hardware feature that is useful to control enable/disable of
transmit enable line of RS-485 transceiver

BNC Type of connector
Broadcast Message
Message sent by a master device and received by all connected slave

devices
BUSMGMT
Message is a bus management message.
CCB Coherent Connection Bus, a RS-485 communication bus
CDRH Center for Devices and Radiological Health
cm Centimeter(s)
Ccw Continuous wave
DC Direct current
DDL Direct diode laser

Destination Address
Address of the recipient device for a message

DHCP Dynamic Host Configuration Protocol. A protocol that provides a
means to dynamically allocate IP addresses to computers on a local
area network.

DLE Data link escape

EOM A two-byte sequence indicating the end of a message packet
ESD Electrostatic discharge

ETX End of message data

FC Fiber-connector

FP Fiber pigtail
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)
GUI

HeNe
Hz

IEC
IR
I/0

kg
kHz
kOhm

LCD
LED
LS version

LX version

m

mA
mAmp
Master

MHz
mm
mrad
ms
mV
MVP
mwW

NA
nm
Nm

Gram(s) or earth’s gravitational force (gravity)
Graphical user interface

Helium neon
Hertz or cycles per second (frequency) (= 1/pulse period)

International Electrotechnical Commission
Infrared (wavelength)
Input/output

Kilogram(s) = 10% grams
Kilohertz = 103 hertz
Kilohm(s) = 10 ohms

Liquid crystal display

Light emitting diode

OBIS Laser, based on optically pumped semiconductor laser (OPSL)
technology

OBIS Laser, based on direct diode laser (DDL) technology

Meter(s) (length)

Milliamp(s) = 10"3 Amperes

Milliampere(s)

Controlling device which manages bus direction, assigns device
addresses, and generally the source for all application protocol
command initiation

Megahertz = 10% hertz

Millimeter(s) = 10 meters

Milliradian(s) = 10 radians (angle)

Millisecond(s) = 10~ seconds

Millivolt(s)

Modulation and variable power

Milliwatt(s) = 10" Watts (power)

Numerical aperture
Nanometer(s) = 10™° meters (wavelength)
Newton meter (torque)

OBIS 1L Remote

OEM
OPSL
oz-in.
PIP
PPS

rms
RMA

A dedicated Coherent device that serves as a communication gateway
to a single laser and provides a CDRH-compliant Key Switch and
interlock capabilities.

Original equipment manufacturer

Optically-pumped semiconductor laser

Ounce inches

Port Identification Pin, a signal pin located on the cable connecting the
slave device to the CCB
Pulses per second

Root mean square (effective value of a sinusoidal wave)
Return material authorization
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SDR Shrunk delta ribbon. This connector type is used on the back panel of
the OBIS Laser for the full-feature 1/0 cable.

Slave Device which receives and interprets messages and responds as
required

SOM A two-byte sequence indicating the start of a message packet

Source Address

Address of the device transmitting a message
Standard Message
Message sent from the master device to a specific slave device

address
SRCCCB

Message originated from CCB stack.
SRCCONT

Message originated from master device (controller).
STX Start of message data

System Protocol
A set of predefined bus management commands and responses used
by CCB protocol stacks for set-up and management of the bus

TEC Thermoelectric cooler

TEM Transverse electromagnetic mode (cross-sectional laser beam mode)
TTL Transistor-transistor logic

UART Universal asynchronous receiver/transmitter

UFC Ultra-flat contact

uv Ultraviolet

\Y, Volt(s)

VAC Volts, alternating current

VDC Volts, direct current

w Watt(s) (power)

ST Version of OBIS Laser, based on optically pumped solid state laser

technology (DPSS)
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